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Audience

Preface

This manual describes the different options available for publishing reports with
Oracle Application Server Reports Services, as well as how to configure the OracleAS
Reports Services software for publishing reports.

This manual is intended for anyone who is interested in publishing reports with
OracleAS Reports Services. To configure OracleAS Reports Services, it is useful to
have a solid understanding of the following technologies:

= Your operating system

= Java

= Databases

= CORBA

n JSP files

= XML and DTD files

= Web server configuration
= HTTP

This manual will guide you through configuring components related to these
technologies.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at

http://www.oracle.com/accessibility/
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Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services

within the United States of America 24 hours a day, seven days a week. For TTY
support, call 800.446.2398.

Related Documentation

For more information about Oracle Reports, refer to the following resources:
»  Oracle Reports Tutorial
»  Oracle Reports Building Reports
»  Oracle Reports online Help, which you can access in any of the following ways:
s From Reports Builder:
— Choose Help > Help Contents.
— Click Help or press F1 in any dialog box.

— In the Property Inspector, click a property, then press F1 to display the
property's help topic.

= On the Oracle Technology Network (OTN) Oracle Reports 10g page
(http://www.oracle.com/technology/products/reports/index.h
tml):

- Under Resources, click Hosted Online Help to display the Web-based
version of the most recent Oracle Reports online Help.

- Under News, click Oracle Reports Online Help Update to replace your
Oracle Reports online Help in Reports Builder with the most recent update.
Instructions for replacing your help file are included in the readme . txt
in the download file.

Conventions

XXiv

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.



Convention Meaning

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

monospace italic Monospace italic type indicates variables or user-supplied names.

[1 Brackets enclose optional clauses from which you can choose one or
none.
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Part |

Preparing Your Environment

Part I contains overview information about the OracleAS Reports Services
environment and provides practical information about preparing that environment for
running reports. This includes starting and stopping OracleAS Reports Services,
configuring Reports-related OracleAS Reports Services components, font related
information in Oracle Reports, configuring destinations for OracleAS Reports Services,
configuring and using the JDBC PDS, setting up OracleAS Reports Services Security,
OracleAS Single Sign-On, and deploying reports in OracleAS Portal.

Part I includes the following chapters:

s Chapter 1, "Understanding the OracleAS Reports Services Architecture”
»  Chapter 2, "Starting and Stopping OracleAS Reports Services"

s Chapter 3, "Configuring OracleAS Reports Services"

s Chapter 4, "Managing Fonts in Oracle Reports"

s Chapter 5, "Printing on UNIX with Oracle Reports"

s Chapter 6, "Using PDF in Oracle Reports"

s Chapter 7, "Resolving Cross-Platform Porting Issues”

= Chapter 8, "Configuring Destinations for OracleAS Reports Services"

s Chapter 9, "Configuring and Using the JDBC PDS"

»  Chapter 10, "Securing OracleAS Reports Services"

s Chapter 11, "Configuring and Administering OracleAS Single Sign-On"
s Chapter 12, "Deploying Reports in OracleAS Portal"






1

Understanding the OracleAS Reports
Services Architecture

This chapter describes the architecture of relevant Oracle Reports components in
combination with its reports publishing component, OracleAS Reports Services. It also
provides an overview of Reports Runtime processing and outlines considerations
when setting up your Reports Server environment.

This chapter includes the following sections:

s Overview of OracleAS Reports Services

»  OracleAS Reports Services Components

»  OracleAS Reports Services Runtime Process

»  OracleAS Reports Services Communication Architecture

s Setting Up Your System

1.1 Overview of OracleAS Reports Services

OracleAS Reports Services is the reports publishing component of Oracle Application
Server. It is an enterprise reporting service for producing high quality production
reports that dynamically retrieve, format, and distribute any data, in any format,
anywhere. You can use OracleAS Reports Services to publish in both Web-based and
non-Web-based environments.

OracleAS Reports Services provides a scalable, flexible architecture for the distribution
and automated management of report generation engines on the same server and
across multiple servers. Additionally, it caches report output for reuse on similar
requests. It integrates into standard Web environments with JSPs, Java servlets, Web
Services, and CGI (maintained for backward compatibility). It enables you to run
reports on both local and remote application servers and to implement a multitiered
architecture for running your reports.

When used in conjunction with JSPs, Java servlets, Web Services, or CGI (maintained
for backward compatibility), OracleAS Reports Services enables you to run reports on
any platform from a Web browser using a standard URL syntax. For servlet
implementations, the in-process server is available for faster response and easier
administration. The in-process server cuts down on the communication expense
between processes and consequently shortens response times.

OracleAS Reports Services handles client requests to run reports by entering all
requests into a job queue. When one of the server's engines becomes available, the next
job in the queue is dispatched to run. As the number of jobs in the queue increases, the
server can start more engines until it reaches the maximum limit specified in your
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server configuration. Similarly, engines are shut down automatically after having been
idle for a period of time that you specify (see Chapter 3, "Configuring OracleAS
Reports Services").

OracleAS Reports Services keeps track of all jobs submitted to the server, including
jobs that are running, scheduled to run, finished, or failed. The showjobs command
(Web through rwservlet), the Web Services interface, the OracleAS Reports Services
pages in Oracle Enterprise Manager 10g, the Reports Queue Manager (Windows), and
the Reports Queue Viewer (UNIX) enable you to view information on when jobs are
scheduled, queued, started, finished, and failed, as well as the job output and the final
status of the report.

With OracleAS Reports Services, job information is persistent. This means that if the
Reports Server is shut down then restarted, all jobs are recovered,' not just scheduled
jobs.

When used in a Web environment, the OracleAS Reports Services architecture consists
of four tiers:

Note: The term tier refers to the logical location of the components
that comprise the OracleAS Reports Services architecture. Each of
the tiers, though, can reside on the same machine or on different
machines.

s The client tier (a Web browser)

»  The Web server tier

s The OracleAS Reports Services tier

»  The data tier, including databases and all other data sources

When used in a non-Web environment, there are three tiers (a Web server being
unnecessary):

»  The client tier (a small, proprietary application on each client machine)
= OracleAS Reports Services tier
»  The data tier, including databases and pluggable data sources

The way you set up these tiers can range from having all of them on one machine to
having each of them on a separate machine. Additionally, you can have multiple Web
servers on multiple machines as well as multiple application servers on multiple
machines. Refer to the Oracle Application Server Installation Guide for more information
on sample topologies.

If you choose to have your Web server on multiple machines, you can cluster and load
balance multiple Oracle Application Server instances for a highly available, fail-safe
environment. Refer to the Oracle Application Server Installation Guide for information on
load balancing. Refer to the Oracle Application Server Enterprise Deployment Guide and
Oracle Application Server High Availability Guide for information on enterprise
deployment architectures and high availability.

OracleAS Reports Services provides event-based reporting. This uses database events
to trigger the generation of a report. For example, you can define an event that signals
a change in revenue levels above or below a particular watermark. If the change occurs

1 Only synchronous jobs and jobs that are currently running are lost in this case.
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in the database (the event), a report is automatically generated. This feature is
discussed in detail in Chapter 17, "Using Event-Driven Publishing".

OracleAS Reports Services includes a distribution module that uses XML to define
unique configurations for the distribution of reports. Call the desired XML file from
the runtime command line or URL to generate one report, and let the server handle
diverse outputs and destinations. Processing time is significantly reduced and
configuration changes can all be handled within the XML file. This feature is discussed
in detail in Chapter 15, "Creating Advanced Distributions".

1.2 OracleAS Reports Services Components

Figure 1-1 OracleAS Reports Services Components

Figure 1-1 illustrates the components of a working OracleAS Reports Services
environment. This includes:

1. The Oracle HTTP Server, a Web server provided by Oracle Application Server. It
incorporates an OpenSSL module to provide support for Secure Sockets Layer
(SSL) and HTTP Secure Sockets Layer (HTTPS). It also provides a servlet engine to
support the running of Java Servlet applications.

2. The module mod_oc4j, used by the Oracle HTTP Server to redirect requests from
servlets and JSPs to Oracle Application Server Containers for J2EE (OC4J). OC4]
provides a complete J2EE environment that includes a JSP translator, a JSP servlet
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engine (OJSP), and an Enterprise JavaBeans (EJB) container. It provides a fast,
lightweight, highly scalable, easy-to-use, complete J2EE environment. It is written
entirely in Java and executes on the standard Java Development Kit (JDK) Virtual
Machine (JVM).

3. The Reports Servlet (rwservlet), a component of OracleAS Reports Services that
runs inside the Web server's servlet engine. The Reports Servlet translates and
delivers information between HTTP and Reports Server. It includes:

s The In-process Server, which reduces the maintenance and administration of
the Reports Server by providing a means for starting the server automatically,
whenever it receives the first request from the client through the Reports
Servlet (rwservlet) or a Reports JSP.

4. The Custom Tag Handler, which processes custom Oracle Reports tags included
in a JSP file. In a JSP file, Oracle Reports-related custom tags are identified by the
prefix rw:; other custom tags using other prefixes may also be present.

5. The Reports CGI (rwcgi), a component of the Web server that translates and
delivers information between either a Web server and the Reports Server, enabling
you to run a report dynamically from your Web browser.

Note: With Oracle Reports 10g, the Reports CGI (rwcgi) is
deprecated (maintained only for backward compatibility); instead, use
Reports JSPs, rwservlet (Reports Servlet), or Reports Web Services.

rwservlet is strongly recommended over rwcgi for performance
reasons. For each request, rwcgi starts a new process, initializing a
JVM and resulting in slow performance when running a large number
of report requests. On the other hand, rwservlet is deployed on an
OC4] instance and leverages servlet functionality, thereby providing
better performance over rwcgi.

6. The Reports Server (rwserver), which processes client requests, including
ushering them through its various services, such as authentication and
authorization checking, scheduling, caching, and distribution (including
distribution to custom—or pluggable—output destinations). The Reports Server
also spawns runtime engines for generating requested reports, fetches completed
reports from the Reports Server cache, and notifies the client that the job is ready.

7. The Reports Server Cache, which securely stores completed job outputs.

8. The Reports Engine, which includes components for running SQL-based and
pluggable data source-based reports. It fetches requested data from the data
source, formats the report, sends the output to cache, and notifies the Reports
Server that the job is complete.

9. The pluggable engines, which are custom engines that use Java APIs to pass jobs
to the Reports Server, as well as leverage the server's other features, such as
scheduling, distribution, notification, and caching. OracleAS Reports Services
provides an out-of-the-box pluggable engine called the URL engine. The URL
engine enables you to distribute content from any publicly available URL to
destinations such as e-mail, OracleAS Portal, and WebDAV.

Additionally, the Oracle Reports bridge provides functionality for discovering a
Reports Server across subnets. The Oracle Reports bridge acts as a gateway for packets
that are broadcast by Reports Server/Reports Client across subnets. The bridge
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mechanism is not shown in Figure 1-1; for more information, see Section 1.4.1.2,
"Server Discovery Across Subnets".

1.3 OracleAS Reports Services Runtime Process

The various components of OracleAS Reports Services contribute to the process of
running a report as follows:

1. The client requests a report by contacting a server through either a URL (Web) or a
non-Web, Oracle Reports-related command, such as rwclient.

The URL goes to JSP, rwservlet, or rwcgi, all associated with the Oracle
HTTP Server. The JSP and rwservlet requests go to mod_oc43j. (For jobs
that run as JSPs, mod_oc43j uses OJSP to translate the JSP into a servlet.) The
rwcgi requests go to a CGI component.

The URL may contain runtime parameters or a keyword that refers to a
runtime parameter configuration section within cgicmd. dat, or it may
contain both, though parameters explicitly named in the URL must not also be
present in the relevant keyword section of cgicmd. dat.

rwclient goes directly to the Reports Server.

The command line may contain runtime parameters. If you have a lot of
runtime parameters, you can create a batch file or shell script that contains the
rwclient command along with a string of parameters.

2. The rwservlet (or rwcgi, maintained only for backward compatibility)
component translates and delivers information between either a Web server or a
J2EE Container (for example, OC4J) and the Reports Server:

Server requests from Reports JSP or rwservlet can be run by the in-process
server or as a standalone Reports Server process (recommended), whichever
is specified in the servlet configuration file (ORACLE_
HOME\reports\conf\rwservlet.properties). An in-process server
requires less maintenance than a standalone Reports Server because, unlike
the standalone Reports Server, it starts automatically in response to requests
from the client. An in-process server cuts down on the communication
between processes. A standalone server, on other hand, provides better
control outside the rwservlet process with the ability to separate out server
process from the OC4J instance. For information about specifying an
in-process server and default naming, see Section 3.4.10, "Specifying an
In-process Server" and Section 3.4.11, "Identifying the In-process Server".

Server requests using rwcgi go to the standalone server.

3. The Reports Server processes the request:

If the request includes a TOLERANCE option, then the Reports Server checks its
cache to determine whether it already has output that satisfies the request. If it
finds acceptable output in its cache, then it immediately returns that output rather
than rerunning the report.
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Note: For any job request that you send to the Reports Server, you
can include a TOLERANCE option. TOLERANCE defines the oldest
output that the requester would consider acceptable. For example, if
the requester specified five minutes as the TOLERANCE, the Reports
Server would check its cache for the last duplicate report output that
had been generated within the last five minutes. An EXPTRATION
option defines the point in time when the report output should be
deleted from the cache (for example, EXPTRATION might equal a
specific date and time for when the output should expire). For more
information, see Section A.3.112, "TOLERANCE" and Section A.3.35,
"EXPIRATION".

If the request is the same as a currently running job, then the request will reuse the
output from the current job rather than rerunning the report.

If neither of these conditions is met, then:

a.

If Reports Servlet is SSO-enabled, it checks for authentication. A secure
Reports Server then authorizes the user using Oracle Internet Directory (OID).
If Reports Servlet is not SSO-enabled, a secure Reports Server authorizes and
authenticates the user.

If the report is scheduled, the Reports Server stores the request in the
scheduled job queue, and the report is run according to schedule. If the report
is not scheduled, it is queued in the current job queue for execution when a
Reports Engine becomes available.

Note: When you configure the Reports Server (in server._

name . conf), you can specify the maximum number of the Report
Engines it can use. If the Reports Server is under this maximum, then
it can send the job to an idle engine or start a new engine to handle the
request. Otherwise, the request must wait until one of the current
Oracle Reports Engines completes its current job.

At runtime, the Reports Server spawns a Reports Engine and sends the
request to that engine to be run.

The Reports Engine retrieves and formats the data.

The Reports Engine populates the Reports Server cache.

The Reports Engine notifies the Reports Server that the report is ready.

The Reports Server accesses the cache and sends the report to output according to
the runtime parameters specified in either the URL, the command line, or the
keyword section in the cgicmd. dat file (URL requests only).

Another way to create a report is through event-driven publishing. With event-driven
publishing, the client is the database (rather than the end user). Events are defined
through the Event-Driven Publishing API. The event invokes a database trigger, an
advanced queuing application, or a PL/SQL package that calls the Event-Driven
Publishing API to submit jobs to the Reports Server. Event-driven publishing is
discussed in detail in Chapter 17, "Using Event-Driven Publishing".

For information about running reports from Oracle Workflow, refer to Section 3.8,
"Configuring Oracle Reports to Communicate with Oracle Workflow", which points to
the Integrating Oracle Workflow with Oracle Reports white paper on OTN
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(http://www.oracle.com/technology/products/reports/features/work
flow) for complete information.

1.4 OracleAS Reports Services Communication Architecture

Oracle9i Reports and Oracle Reports 10g Release 1 (9.0.4) use Borland VisiBroker's
osagent executable to dynamically discover Reports Servers in the network.

Oracle Reports 10g Release 2 (10.1.2) replaces the use of Borland's VisiBroker with
Sun Microsystems' industry-standard Java Developer's Kit Object Request Broker (JDK
ORB), providing support for Reports Server requests from clients across subnets, and
using the broadcast mechanism for dynamic Reports Server discovery both within a
subnet and across subnets.

With Oracle Reports 10g Release 2 (10.1.2), you can use the built-in broadcast
mechanism, available out-of-the-box, for dynamic discovery of Reports Servers. You
can also choose to use the Common Object Service (COS) naming service orbd,
provided by Sun Microsystem's JDK ORB, for Reports Server discovery.

Note: It is recommended that you use the built-in broadcast
mechanism for dynamic discovery of Reports Servers. Use the
Common Object Service (COS) naming service for Reports Server
discovery only if the built-in broadcast mechanism is not suitable
for your environment, as in the following scenarios:

= You plan to install OracleAS Reports Services on a machine
that is not connected to a network.

= You want to avoid broadcast traffic on your network.

This section discusses the two methods of Reports Server discovery:
= Server Discovery Using the Broadcast Mechanism

= Server Discovery Using the COS Naming Service

Note: Oracle Reports 10g Release 2 (10.1.2) also introduces the
rwdiag executable to provide diagnosis for the JDK ORB
implementation. Using rwdiag, you can replace the functionality
of osfind available in the prior VisiBroker implementation,
providing information about which ORB applications are running
and options for logging ORB-related network traffic. For more
information on rwdiag, see Appendix E, "Reports Server and
Bridge Diagnostic Utility".

1.4.1 Server Discovery Using the Broadcast Mechanism

With the broadcast mechanism, Reports Server discovery can occur within a subnet or
across subnets:

= Server Discovery Within a Subnet

»  Server Discovery Across Subnets
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Note: The Oracle Reports 10g Release 2 (10.1.2) default broadcast
mechanism requires the host machine to be inside a network. If the
host machine is not in a network (that is, it is a standalone machine),
then the built-in broadcast mechanism does not work. As a result, you
cannot use OracleAS Reports Services. Specifically, Oracle Reports
clients cannot discover and communicate with Reports Server(s). Note
that the definition of a "network" does not include a Virtual Private
Network (VPN). That is, even if the host machine is connected to the
network through VPN, Oracle Reports clients cannot discover and
communicate with Reports Server(s).

Therefore, if your installation is on a standalone (non-networked) host
machine or you are connected to a network through VPN, refer to
Section 3.3, "Configuring the Reports Server Discovery Mechanism" to
turn off the broadcast mechanism, and turn on the naming service
instead.

1.4.1.1 Server Discovery Within a Subnet

Within a subnet, the client broadcasts a packet with the name of the Reports Server to
which it wants to connect. A Reports Server with that name will respond if it exists in
the network. The client then connects to the Reports Server to run the report request.

Figure 1-2 Server Discovery within a Subnet

host1.dom1.com

é ﬂ getServerRef
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Reports Client Reports Server
o runReport executeReport o
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Using the example of running a report request with server=rep_server, the
following numbered steps map to the numbers in Figure 1-2:

1. getServerRef

The Oracle Reports client (for example, rwclient, rwservlet, or rwrgm)
broadcasts a packet containing the name of the server to which it wants to
connect. In this case, the packet contains the name rep_server.

The server with name rep_server in the network responds back with its
Interoperable Object Reference (IOR).

The client converts the IOR to an object reference.

2. runReport
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»  The Oracle Reports client sends a request to the remote object reference to run
the report (IIOP call).

3. executeReport

= Reports Server executes the report and returns either report or status.

1.4.1.2 Server Discovery Across Subnets

Oracle Reports provides the bridge mechanism for connecting two or more
non-secured subnets. An Oracle Reports bridge running in one subnet will contact the
Oracle Reports bridge running in another subnet to obtain Reports Server references.

For configuration details, refer to Section 3.3.2, "Bridge Configuration Elements
(bridgeconf.dtd)".

Figure 1-3 Server Discovery Across Subnets
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Using the example of running a report request with server=rep_server, the
following numbered steps map to the numbers in Figure 1-3:

1. getServerRef

»  The Oracle Reports client (for example, rwclient, rwservlet, or rwrgm)
broadcasts a packet containing the name of the server to which it wants to
connect. In this case, the packet contains the name rep_server.

2. Dbridgel intercepts the packet and passes it to bridge?2.
3. registerServerRef

»  bridge2 broadcasts the packet in dom2, and rep_server in dom2 responds
back with the Interoperable Object Reference (IOR).

»  bridge2 passes the IOR back to bridgel, and bridgel passes it to the
client using the broadcast mechanism.

s The Oracle Reports client converts the IOR to an object reference.
4. runReport

»  The Oracle Reports client sends a request to the remote object reference to run
the report (IIOP call).

5. executeReport

= Reports Server executes the report and returns either report or status.
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Note: Numbers in blue color in Figure 1-3 are shown for the case
where the Oracle Reports client is in dom2 and Reports Server is in
doml.

1.4.2 Server Discovery Using the COS Naming Service

Alternatively, you can use the JDK-provided Common Object Service (COS) naming
service to access a Reports Server in the same subnet, as well as across a non-secured
subnet. To configure the naming service, refer to Section 3.3.1, "Network
Configuration Elements (rwnetworkconf.dtd)".

Note: It is recommended that you use the built-in broadcast
mechanism for dynamic discovery of Reports Servers. Use the
Common Object Service (COS) naming service for Reports Server
discovery only if the built-in broadcast mechanism is not suitable
for your environment, as in the following scenarios:

You plan to install OracleAS Reports Services on a machine
that is not connected to a network.

You want to avoid broadcast traffic on your network.

Figure 1-4 Server Discovery Using the COS Naming Service
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Using the example of running a report request with server=rep_server, the
following numbered steps map to the numbers in Figure 1-4:

1. registerServer

s  When rep_server is started, it registers itself with the naming service, which
must be up and running for the server to start. Now a request is run with
server=rep_server.

2. getServerRef

= The Oracle Reports client contacts the naming service and requests a reference
to server rep_server.

= The naming service returns the reference to server rep_server.

3. runReport
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s The Oracle Reports client sends a request to the remote object reference to run
the report (IIOP call).

4. executeReport

= Reports Server executes the report and returns either report or status.

Note: Numbers in blue color in Figure 1-4 are shown for the case
where the Oracle Reports client is in dom2 and Reports Server is in
doml.

1.5 Setting Up Your System

The way you set up OracleAS Reports Services can vary widely depending upon the
requirements of your system. Before you set up OracleAS Reports Services, you must
make some decisions based upon your requirements. By making these decisions
beforehand, you can greatly simplify the setup process.

The following subsections discuss some of the decisions involved in:
= Choosing the Types of Requests You Will Service

s Choosing Reports Servlet, JSP, Web Services, or CGI

s Choosing Single or Multiple-Machine Configurations

s Choosing a High Availability Environment

1.5.1 Choosing the Types of Requests You Will Service

OracleAS Reports Services can be configured to accept both Web and non-Web job
requests.

In the Web case, you can run reports by clicking or typing a URL in a Web browser.
Depending on the URL, the report output is then served back to you in your browser
or sent to a specified destination (for example, a printer). To enable users to launch
reports from a browser, you will use either the Reports Servlet, a JSP, or Reports CGI
components with your Web server. One or the other of these components must be
present on the Web server to enable communications between it and OracleAS Reports
Services and to enable the processing of report requests from Web clients.

Note: For more information, refer to Section 1.5.2, "Choosing Reports
Servlet, JSP, Web Services, or CGI'".

In non-Web cases, you can send job requests using the rwclient executable, installed
on each of your user's machines.

From the perspective of configuration, these are the key differences between enabling
Web and non-Web requests:

= Enabling Web requests requires that you choose between Reports Servlet, JSP, or
Reports CGI (maintained only for backward compatibility) for the server side, but
eliminates the need to install any client software beyond a standard Web browser.
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Note: With Oracle Reports 10g, the Reports CGI (rwcgi) is
deprecated (maintained only for backward compatibility); instead, use
Reports JSPs, rwservlet (Reports Servlet), or Reports Web Services.

rwservlet is strongly recommended over rwcgi for performance
reasons. For each request, rwcgi starts a new process, initializing a
JVM and resulting in slow performance when running a large number
of report requests. On the other hand, rwservlet is deployed on an
OC4] instance and leverages servlet functionality, thereby providing
better performance over rwcgi.

= Enabling non-Web requests requires that you install client software on each
machine that will be used to run requests. This introduces the need to administer
client software on each client machine.

The Web case is clearly the most cost effective because it reduces client maintenance
costs. But there might be cases where launching non-Web requests is a necessity.
OracleAS Reports Services supports the implementation of both Web and non-Web
requests in a single deployment environment.

1.5.2 Choosing Reports Servlet, JSP, Web Services, or CGI

To use OracleAS Reports Services in a Web environment, you must use a servlet, JSP,
or CGI implementation. We strongly recommend that you choose rwservlet
(Reports Servlet), Reports Web Services, or Reports JSP. The reason is that Reports CGI
internally starts a new process for each request. Each process initializes a JVM, which
results in a slow performance when running a large number of report requests.
Whereas, Reports Servlet is deployed on an OC4J instance and leverages the servlet
functionalities, thereby providing higher performance than Reports CGL

Between Reports Servlet and Reports JSP there are additional considerations. A
JSP-only implementation means that you can publish a layout that is optimized for
Web delivery (that is, the Oracle Reports Web Layout). The servlet enables you to
include paper layouts in your report publishing solution and fully leverage the
distribution features of OracleAS Reports Services.

Using Reports Servlet does not imply that you cannot also use JSP files because JSP
files can contain both Web and paper layouts. When you run a report stored in a JSP,
you specify the servlet in the URL and call the JSP with the command line option
report=myreport.jsp. In this case, report output is created based on the paper
layout.

For more information on running reports, see Chapter 13, "Running Report Requests".

1.5.3 Choosing Single or Multiple-Machine Configurations

You can place OracleAS Reports Services on the same machine as your Web server or
on a different machine. Both scenarios have pros and cons.

For example, while it's true that having OracleAS Reports Services and the Web server
on the same machine requires more of the machine's memory and disk space, it's also
true that such an implementation reduces network traffic. This is because requests
traveling between the Web server and the application server do not have to travel
across a network, only incoming requests must do so.

If you are using the in-process server (available only with Reports Servlet
implementations) you can further amplify the performance advantages of a single
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machine. The in-process server speeds up processing time by allowing for faster and
more efficient communication between OracleAS Reports Services components. We
recommend that you use the in-process server unless you will not use Reports Servlet
to deploy reports.

On the other hand, if you have a single machine configuration and that machine fails,
everything fails.

While there is a greater amount of network traffic when the Web server and the
application server are on different machines, you also benefit from the increase in
system resources, in the form of additional CPUs, more disk space, and more available
memory. Even in a multiple machine configuration, the in-process server will aid
performance by speeding communication between OracleAS Reports Services
components.

Another possibility is placing your Web server and your application server each on
multiple machines. This will require additional configuration, but it enables you to
implement load balancing on the Web server.

By using the environment switching feature it is possible to spawn Reports Engines
with different environment settings, including language, in the same Reports Server.
Refer to Section 3.2.2, "Dynamic Environment Switching" for more information on
Dynamic Environment Switching.

1.5.4 Choosing a High Availability Environment
This section discusses the following aspects in choosing a high availability
environment:

»  Maintaining High Availability in Oracle Application Server

s Maintaining Infrastructure Dependencies

1.5.4.1 Maintaining High Availability in Oracle Application Server

Oracle Application Server consists of many components that can be deployed in
distributed topologies. The underlying paradigm used to enable high availability for
Oracle Application Server is clustering, which unites various Oracle Application
Server components in certain permutations to offer scalable and unified functionality,
and redundancy should any of the individual components fail.

Note: Refer to the Oracle Application Server Enterprise Deployment
Guide and Oracle Application Server High Availability Guide for more
information on the various solutions and techniques to achieve high
availability in Oracle Application Server.

Before you continue, we recommend that you read the book Oracle Application Server
Concepts to gain an understanding of the different components in Oracle Application
Server. Implementing the solutions and techniques for high availability enables you to
achieve the following goals:

Redundancy

A highly available system requires its sub-systems to be redundant. All Oracle
Application Server components can be deployed redundantly using the procedures
and solutions described in the Oracle Application Server High Availability Guide.
Depending on the type of components, they can be deployed in an active-active
configuration or active-passive configuration.
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In an active-active configuration, multiple instances of a component service client
requests at the same time. If one instance fails, the requests being serviced by that
instance can be fulfilled by other active instances; the failure and failover of that
instance is transparent to clients. An active-active configuration can usually be
achieved by clustering instances of components together.

In an active-passive configuration, requests are usually serviced by one instance of a
component. Upon failure of that component, another instance is made active to
respond to the request workload.

Death Detection and Auto Restart

Software processes belonging to Oracle Application Server components, local or
distributed, are managed by a central process management system. This system is able
to detect the death of processes and restart them even if they are distributed over
multiple machines. The system allows customization of parameter values that define
process death and restart (such as number of heartbeats). The processes implementing
the process management system are themselves redundant as each has a shadow
process.

Clustering

Clustering components of a system together allows the components to be viewed
functionally as a single entity from the perspective of a client. A cluster increases the
scalability, availability, and manageability of the components.

Several types of clusters can exist with Oracle Application Server components.
Procedures to create and configure these clusters are comprehensively documented in
the Oracle Application Server High Availability Guide. The Oracle Application Server
Enterprise Deployment Guide also contains information about setting up a clustered
environment.

State Replication and Routing

For stateful client requests, Oracle Application Server can replicate client state in order
to enable stateful failover of requests in the event that processes servicing these
requests fail. For J2EE requests, replicating client state for J2EE applications can be
done declaratively or programmatically, depending on the mechanism being used. For
most other components, state-based routing using cookies is available.

Connection Failure Management

Clients often connect to services on the server and reuse these connections. When a
process implementing one of these services on the server is restarted, the connection
may need to be reestablished.

Oracle Application Server components ensure that if a reused connection fails, the
connection is retried before a failure condition is propagated to the rest of the system.
This allows clients to be transparent to any failures.

Backup and Recovery

Oracle Application Server provides facilities for backing up system state and using
this backup to recover from failures. In certain circumstances, a component or system
failure may not be repairable. The Oracle Application Server Backup and Recovery
Tool can be used to back up the system at certain intervals and restore a backup when
an unrepairable failure occurs.

For specific problems localized to the HTTP listener and J2EE container, a runtime
configuration management system allows these components to be check pointed
quickly and also allows for undo operations for configuration errors.
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Disaster Recovery

Natural and physical disasters can happen to areas where an Oracle Application
Server site hosting critical applications is physically located. A solution for recovering
from such disasters is documented in the Oracle Application Server High Availability
Guide. This solution is a site-to-site recovery solution that allows the backing up of the
state of an entire Oracle Application Server site and recovering it to another site that is
physically distant from the first.

1.5.4.2 Maintaining Infrastructure Dependencies

Oracle Application Server provides a number of high availability features to keep its
middle tier running even when particular servers or components fail. We strongly
recommend that you use the Oracle Application Server high availability.

Note: Refer to the Oracle Application Server High Availability Guide for
more information on the high availability features in Oracle
Application Server.

To take advantage of the Oracle Application Server high availability features,
OracleAS Reports Services takes the following actions when its infrastructure
dependencies fail:

= Retrying the OracleAS Portal database connection. If the connection from the
Reports Server to the OracleAS Portal database schema is dropped for some
reason, then the Reports Server tries to reestablish the connection before
generating an error. First, it retrieves the OracleAS Portal connection string from
the repository. With the OracleAS Portal connection string, the Reports Server can
attempt to reconnect. If a reconnection is successful, you need not restart the
Reports Server. OracleAS Reports Services also supports cold failover and RAC on
the infrastructure and disaster recovery on the middle tier.

= Retrying the Oracle Internet Directory connection. If the Oracle Internet
Directory connection becomes stale for some reason, the Reports Servlet and the
Reports Server try to reestablish the connection before generating errors. If a
reconnection is successful, you need not restart the Reports Server.
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Starting and Stopping OracleAS Reports

Services

This chapter provides information on starting and stopping OracleAS Reports
Services. It includes the following main sections:

Starting and Stopping the Reports Server

Starting and Stopping the Oracle Reports Bridge

Starting and Stopping the Naming Service

Verifying that the Oracle HTTP Server Is Running
Verifying that the Reports Servlet and Server Are Running

Note: The examples in this chapter use ORACLE_HOME to denote
where the Oracle Application Server is installed. This includes
OracleAS Reports Services.

2.1 Starting and Stopping the Reports Server

The best way to run the Reports Server is through the Oracle Process Manager and
Notification Server (OPMN). OPMN provides a centralized mechanism for
initializing, maintaining, and shutting down your Oracle HTTP Server, OC4]J
processes, and OracleAS Reports Services. For more information on configuring the
Reports Server through OPMN, see Section 3.7, "Configuring Reports Server with the
Oracle Process Manager and Notification Server and Oracle Enterprise Manager 10g".
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Important: You must start or stop a Reports Server registered with
Oracle Enterprise Manager 10g only through Oracle Enterprise
Manager 10g/OPMN. OPMN automatically restarts Reports Server if
it stops responding for some reason. On Windows, OPMN itself is
run as a Windows service.

Beginning with Oracle Reports 10g Release 2 (10.1.2), running Reports
Server as a Windows service is no longer supported (rwserver
-install server_name). As a result, the related command line
keywords INSTALL and UNINSTALL are also obsolete. If you start or
stop a Reports Server that is managed by OPMN running as a
Windows service or through the command line, you may face the
following issues:

= The Reports Server's status will not be reflected accurately in
Oracle Enterprise Manager 10g.

s Oracle Enterprise Manager 10g may display errors when starting
or stopping the Reports Server.

For more information about the obsolescence of running Reports
Server as a Windows service, see A Guide to Functional Changes Between
Oracle Reports 6i and 10g on the Oracle Technology Network (OTN).

2.1.1 Starting, Stopping, and Restarting Reports Servers from Oracle Enterprise
Manager 10g

When the standalone Reports Server is configured through OPMN, you can start, stop,
and restart it through Oracle Enterprise Manager 10g.

Note: The in-process server, available as part of 0C4J_BI_Forms,
is automatically configured in OPMN and thus registered with
Oracle Enterprise Manager 10g during installation of Oracle
Application Server. If you add any Reports Servers after
installing Oracle Application Server, you must register the new
server(s) in the Oracle Enterprise Manager 10g's targets.xml
file and the Oracle Process Manager and Notification Server's
opmn . xml file. Or, you can run addnewservertarget.bat to
register the new server(s). For more information, see Section 3.7,
"Configuring Reports Server with the Oracle Process Manager and
Notification Server and Oracle Enterprise Manager 10g".

To start, stop, or restart a Reports Server:
1. On the Reports Server's main page:

»  Click Start to start the server.

»  Click Stop to stop the server.

»  Click Restart to restart the server.

These buttons appear on a Reports Server's main page according to the server's
current state:

= When the server is down, the Start and Stop buttons display.
= When the server is up, the Restart and Stop buttons display.
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Note: Oracle Enterprise Manager lists all the Reports Server
dependencies on the Reports Server main page.

2.1.2 Starting, Stopping, and Restarting Reports Servers from the Oracle Process
Manager and Notification Server

You can use the following command lines to start, stop, and restart the Reports Server
if it was configured through the Oracle Process Manager and Notification Server:

ORACLE_HOME/opmn/bin/opmnctl startproc ias-component=reports_server_name
ORACLE_HOME/opmn/bin/opmnctl startproc process-type=reports_server_name
ORACLE_HOME/opmn/bin/opmnctl stopproc ias-component=reports_server_name
ORACLE_HOME/opmn/bin/opmnct]l restartproc ias-component=reports_server._name

The Reports Server name must match the name in the ias-component idin the
opmn . xml file.

You can also query the status of the Oracle Process Manager and Notification Server,
by using the following command:

ORACLE_HOME/opmn/bin/opmnctl status
For more information on configuring the Reports Server through the Oracle Process

Manager and Notification Server, see Section 3.7, "Configuring Reports Server with the
Oracle Process Manager and Notification Server and Oracle Enterprise Manager 10g".

2.1.3 Alternative Methods of Starting and Stopping the Reports Server

If you choose not to run your Reports Server through OPMN and maintain it through
Oracle Enterprise Manager 10g, you can use these older methods of running the
Reports Server:

»  Starting the In-process Server (Windows and UNIX)
= Starting the Reports Server from a Command Line (Windows and UNIX)
= Stopping the Reports Server

Important: Beginning with Oracle Reports 10g Release 2 (10.1.2),
running Reports Server as a Windows service is no longer supported,
as mentioned at the beginning of this section.

2.1.3.1 Starting the In-process Server (Windows and UNIX)

If you are using the Reports Server as an in-process server (the default configuration),
sending a run report request starts the in-process server; however, if you are sending a
request through a command line, the servlet must be invoked first using either the run
report URL or the Web command URL. When you have successfully started the
servlet, this also means you have successfully started the in-process server.

To directly start the in-process server from a URL, enter the following from your Web
browser:

http://your_machine name:your_port_num/reports/rwservlet/startserver
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2.1.3.2 Starting the Reports Server from a Command Line (Windows and UNIX)

You can also start the Reports Server as a standalone server on Windows using the
following command:

rwserver server=server_name

Add the BATCH command line keyword to start up the server without displaying
dialog boxes or messages.

rwserver server=server_name batch=yes

You can run this command on UNIX using the following syntax:

rwserver.sh server=server_name

Or:

rwserver.sh server=server_name batch=yes

Important: If DISPLAY is not set, you must start a Reports Server in
batch mode (batch=yes).

Refer to Section 3.10, "Removing DISPLAY and Printer Dependencies
on UNIX" for more information on the removal of DISPLAY and
printer dependencies on UNIX.

Refer to Section B.1.39, "REPORTS_DEFAULT_DISPLAY" for more
information on the REPORTS_ DEFAULT_DISPLAY environment
variable.

You can run this command from any directory as long as the shell script can be
reached in your PATH environment variable.

2.1.3.3 Stopping the Reports Server

There are several ways to stop the Reports Server on Windows and UNIX, as follows:

= If the Reports Server is running on Windows through the rwserver executable,
or on UNIX through a shell script, rwserver. sh, click Shutdown in the Reports
Server dialog box.

s If you are not running the Reports Server from the command line, launch Oracle
Enterprise Manager 10g, and navigate to the Reports Server you wish to shut
down, then click Stop on the selected Reports Server's home page. For more
information on Reports Server and Oracle Enterprise Manager 10g, see Chapter 19,
"Managing and Monitoring OracleAS Reports Services".

s If the Reports Server is running as an in-process server through the Reports
Servlet, issue the following URL:

http://your_host_name:port_number/reports/rwservlet/stopserver
» If the Reports Server is running from a command line on Windows or UNIX, use

any of the following commands, depending on how you want to shut down the
Reports Server.

Note: On UNIX, use rwserver. sh instead of rwserver.

To shut down the server normally (that is, finish pending jobs and then stop):
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rwserver server=gerver shutdown=normal authid=username/password

To shut down the server immediately (that is, stop without finishing pending
jobs):

rwserver server=server shutdown=immediate authid=username/password

To shut down the server without displaying any related messages:

rwserver server=server shutdown=normal authid=username/password batch=yes

The keywords used with the rwserver command are described in Appendix A,
"Command Line Keywords".

Note: authidis the Reports Server's administration user name
and password. For a secure Reports Server, this user must be a
member of the RW_ADMINISTER privilege group in the Oracle
Internet Directory. For a non-secure Reports Server, this user is
defined in the identifier element. The following bullet contains
more information on how to stop a non-secure Reports Server using
the command line.

When you stop or shut down a non-secure Reports Server from the command line
using either rwserver. sh or rwrgv. sh, you need to provide a valid authig,
which must match the value set in the identifier element in the server
configuration file. However, the identifier element is set during Reports
configuration while installing Oracle Application Server 10g and encrypted by the
Reports Server. You can reset the identifier element to any value. If you have
registered this Reports Server with Oracle Enterprise Manager 10¢ and OPMN,
you also need to change the corresponding properties in targets.xml for Oracle
Enterprise Manager 10g integration to work. Perform the following steps:

1. In the non-secure Reports Server's configuration file, server._name.conf,
modify the identifier element to specify the username/password and
set the encrypted attribute to no. For example:

<identifier confidential="yes" encrypted="no">scott/tiger</identifier>

2. Stop and restart the Reports Server manually for the changes made to the
server_name. conf file to take effect.

Note: You must restart the Reports Server for any configuration
changes to take effect.

The Reports Server will now encrypt the username/password value of the
identifier element. After the Reports Server reads the changes made in the
server_name. conf file, the following commands should execute
successfully (with scott/tiger as the username/password):

./rwserver.sh server=server name shutdown=normal authid=scott/tiger
./rwrqgv.sh server=server_name shutdown=normal authid=scott/tiger

3. For Oracle Enterprise Manager 10g integration, edit the targets.xml file (in
ORACLE_HOME/sysman/emd/) using any text editor, as follows:

—  Search for target with TYPE="oracle_repserv" and DISPLAY_
NAME="Reports Server: server_name".
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— In the entry, set the UserName property and the Password property to
the same user name and password as in the identifier element in the
server_name.conf file. Set the ENCRYPTED attribute to FALSE for these
two properties.

— Restart Oracle Enterprise Manager 10g¢ for the changes to take effect.

You should now be able to stop and shut down a non-secure Reports Server using
Oracle Enterprise Manager 10g.

Note: These steps are required only for a non-secure Reports Server
and not for secure Reports Servers.

2.2 Starting and Stopping the Oracle Reports Bridge

The Oracle Reports bridge is used to connect two subnets. It acts as a gateway between
Oracle Reports components running in different subnets.

Note: In Oracle Reports 10g Release 2 (10.1.2), the Oracle Reports
bridge is not integrated with Oracle Enterprise Manager 10g.
Therefore, you cannot see the Oracle Reports bridge status or start and
stop it from the Oracle Enterprise Manager 10g Application Server
Control.

2.2.1 Starting, Stopping, and Restarting the Oracle Reports Bridge from the Oracle
Process Manager and Notification Server

Before you can start the Oracle Reports bridge with Oracle Process Manager and
Notification (OPMN), you must add the bridge to OPMN, as shown in the following
example:

cd SORACLE_HOME/bin

setenv ORACLE_HOME youroraclehome
addNewReportsBridge.sh bridgename

cd $ORACLE_HOME/opmn/bin

opmnctl reload (If opmn is up and running)
opmnctl start (If opmn is not running)

To start the Oracle Reports bridge if it was configured through the Oracle Process
Manager and Notification (OPMN) Server, use either of the following commands:

ORACLE_HOME/opmn/bin/opmnct]l startproc ias-component=bridgename
ORACLE_HOME/opmn/bin/opmnctl startproc process-type=bridgename

To stop the Oracle Reports bridge, use the following command:

ORACLE_HOME/opmn/bin/opmnctl stopproc ias-component=bridgename

To restart the Oracle Reports bridge, use the following command:

ORACLE_HOME/opmn/bin/opmnct]l restartproc ias-component=bridgename

The Oracle Reports bridge name must match the name in the ias-component idin
the opmn . xm1 file.

You can also query the status of the Oracle Process Manager and Notification bridge,
using the following command:
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ORACLE_HOME/opmn/bin/opmnctl status

For more information on configuring the Oracle Reports bridge through the Oracle
Process Manager and Notification Server, see Section 3.7.1.4, "Oracle Reports Bridge
Specification".

2.2.2 Starting and Stopping the Oracle Reports Bridge from the Command Line

To start the Oracle Reports bridge from the command line, use the following
commands:

On Windows:

rwbridge.bat name=bridgename

On UNIX:

rwbridge.sh name=bridgename

For example, to start an Oracle Reports bridge named foo on Windows, use the
following command:

rwbridge.bat name=foo

See Also: For more information about the rwbridge executable:

= Section A.2.9, "rwbridge"

Oracle Reports creates a configuration file, repbrg_bridgename. conf when the
Oracle Reports bridge is started for the first time. This file is generated based on the
settings in the rwbridge. template file and is located in the ORACLE_
HOME/reports/conf directory. Edit the repbrg_bridgename. conf file to specify
remote Oracle Reports bridges to connect to other subnets.

Note: You must restart the Oracle Reports bridge for any
configuration changes to take effect.

To stop an Oracle Reports bridge, use the following command:
On Windows:

rwbridge.bat name=bridgename shutdown=normal authid=username/password

On UNIX:

rwbridge.sh name=bridgename shutdown=normal authid=username/password

For example, to stop an Oracle Reports bridge named foo on UNIX, use the following
command:

rwbridge.sh name=foo shutdown= normal authid=scott/tiger

In the configuration file, repbrg_bridgename.conf, modify the identifier
element to specify the username/password and set the encrypted attribute to no.

This is to indicate that the password is not encrypted. This password will be encrypted
once the Oracle Reports bridge is started.

For example:

<identifier confidential="yes" encrypted="no">scott/tiger</identifier>
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Usage Notes

» Ifthe identifier elementis commented, then it is possible to stop the Oracle
Reports bridge without specifying authid.

s Itis not possible to stop the Oracle Reports bridge remotely.

See Also: Section 3.3.2.3, "identifier"

2.3 Starting and Stopping the Naming Service

The Common Object Service (COS) naming service orbd, provided by Sun
Microsystem's JDK, can be used for Reports Server discovery instead of the default
broadcast mechanism. Refer to the JavalDL page on Sun Microsystem's Web site
(http://java.sun.com) for more details on the orbd executable .

To start the naming service, use the following commands:
On Windows:

namingservice.bat port_number

On UNIX:

namingservice.sh port_number

The naming service will start, using the specified port number. You need to configure
the Reports Server discovery mechanism accordingly to use the naming service. For

information on configuring the Reports Server discovery mechanism, see Section 3.3,
"Configuring the Reports Server Discovery Mechanism".

To stop the naming service, use the following command:
On Windows:

namingservice.bat port_number shutdown

On UNIX:

namingservice.sh port_number shutdown

2.4 Verifying that the Oracle HTTP Server Is Running

OracleAS Reports Services depends upon the Oracle HTTP Server component. Before
starting Reports Server through Oracle Enterprise Manager 10g or OPMN, you must
verify that your Oracle HTTP Server is running. For more information about
performing this task in Oracle Enterprise Manager 10g, refer to your Oracle Enterprise
Manager 10g documentation.

Alternatively, you can verify that the Oracle HTTP Server is running,in your browser,
by navigating to the following URL:

http://server_name.domain:port_number/

2.5 Verifying that the Reports Servlet and Server Are Running
To verify that the Reports Servlet is running, navigate to the following URL:

http://your_machine name.domain_name:your port_number/reports/rwservlet/help
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Note that the URL is case sensitive. If this URL executes successfully, you should get a
help page describing the rwservlet command line arguments.

To verify that the Reports Server is running, navigate to the following URL:

http://your_machine_name.domain_name:your_port_
number/reports/rwservlet/getserverinfo?server=server._name

The server=server_name argument is not required if you are using the default
Reports Server name (rep_machine_name) or the Reports Server specified in the
servlet configuration file, rwservlet.properties (ORACLE_
HOME\reports\conf\). If this URL executes successfully, you should see a listing of
the job queue for the specified Reports Server.

Note: You'll find more information about the servlet configuration
file in Section 3.4, "Configuring Reports Servlet".
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Configuring OracleAS Reports Services

When you install Oracle Application Server, OracleAS Reports Services is configured
automatically for you. There will likely be adjustments you wish to make to customize
your environment, but you will not be required to set up the entire environment, or
even most of it.

This chapter is included largely for reference, should you wish to introduce
customizations or have a better understanding of the default configuration. It lists
services-related configuration files and describes in detail the content of most of them.
It includes the following main sections:

= OracleAS Reports Services Configuration Files

= Configuring Reports Server

= Configuring the Reports Server Discovery Mechanism
= Configuring Reports Servlet

= Configuring the URL Engine

= Entering Proxy Information

= Configuring Reports Server with the Oracle Process Manager and Notification
Server and Oracle Enterprise Manager 10g

= Configuring Oracle Reports to Communicate with Oracle Workflow
= Optimizing the Deployment of Reports
= Removing DISPLAY and Printer Dependencies on UNIX

Note: The examples in this chapter use ORACLE_HOME to denote
where Oracle Application Server is installed. Oracle Application
Server includes OracleAS Reports Services.

Another aspect of configuration is the setting of environment variables. These are set
for you automatically during installation. For reference, environment variables are
discussed in Appendix B, "Environment Variables".

3.1 OracleAS Reports Services Configuration Files

This section identifies the configuration files associated with OracleAS Reports
Services. In most cases, you can leave these files untouched. Because they control
many aspects of your server environment, you could put that environment at risk if
you change a file in some unsupported way. Always keep a back-up of the current
version of any configuration file you plan to change.
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The configuration files associated with OracleAS Reports Services relate to Reports
Server (rwserver) and Reports Servlet (rwservlet). They are listed and described
in Table 3-1:

Note: The paths specified in Table 3-1 are the same for both
Windows and UNIX environments, though they are expressed here
using the Windows backslash convention (\).

Table 3—-1 OracleAS Reports Services Configuration Files

Component Configuration File

Reports Server ORACLE_HOME\reports\dtd\rwserverconf.dtd
ORACLE_HOME\reports\conf\server_name.conf

The rwserverconf . dtd file contains data type definitions for
server_name.conf and rwbuilder.conf elements and
attributes. See Section 3.2.1, "Reports Server Configuration Elements
(rwserverconf.dtd)".

Use the server_name. conf file to define initial values for the
Reports Server Cache, the Oracle Reports engine, and security; to
register valid destination types; to specify the information to be
logged; and to set other server-related values. This file is
automatically created when you start up the server. If you want to
rename your server and wish to keep custom configuration settings
you've entered into this file, you must first rename this file to the
new server name, then rename the server. Otherwise, the server will
create its own new default configuration file.

For more information, see Section 3.2, "Configuring Reports Server".

Reports Server ORACLE_HOME\reports\dtd\rwnetworkconf.dtd
(network ORACLE_HOME\reports\conf\rwnetwork.conf
configuration)

The rwnetworkconf . dtd contains data type definitions for
rwnetwork . conf elements and attributes. See Section 3.3.1,
"Network Configuration Elements (rwnetworkconf.dtd)".

Reports Server ORACLE_HOME\reports\dtd\bridgeconf.dtd

(Oracle Reports ORACLE_HOME\reports\conf\repbrg_bridgename.conf
brldge . The bridgecont . dtd file contains data type definitions for
configuration)

rwbridge_bridgename.conf elements and attributes. See
Section 3.3.2, "Bridge Configuration Elements (bridgeconf.dtd)".

Reports Builder ORACLE_HOME\reports\dtd\rwserverconf.dtd
Reports Runtime ORACLE_HOME\reports\conf\rwbuilder.conf

The rwserverconf . dtd file contains data type definitions for
server_name.conf and rwbuilder.conf elements and
attributes. See Section 3.2.1, "Reports Server Configuration Elements
(rwserverconf.dtd)".

Use rwbuilder. conf to configure the Reports Server that is
embedded in Reports Builder and Reports Runtime. All run requests
must go through Reports Server, meaning that Reports Builder
requires a server to run reports. Reports Builder automatically starts
a Reports Server to handle its requests. When you run a report from
Reports Builder, this file provides the configuration for the
in-process Reports Server instance that is invoked. Like the server._
name. conf file, this file relies on the rwserverconf . dtd file for
its data type definitions, though the following elements do not apply:
compatible, persistFile, and security.

Because this file shares most configuration elements found in
server_name.conf, you'll find the information you need for
configuring this file in Section 3.2, "Configuring Reports Server".
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Table 3-1 (Cont.) OracleAS Reports Services Configuration Files

Component Configuration File

Reports Servlet ORACLE_HOME\reports\conf\rwservlet.properties

The rwservlet.properties file includes parameters for
configuring the Reports Servlet (rwservlet). For more information
about this file, see Section 3.4, "Configuring Reports Servlet".

3.2 Configuring Reports Server

The Reports Server component of OracleAS Reports Services can be configured using
the XML files server_name.conf and rwbuilder.conf, located in the following
directory (Windows and UNIX):

ORACLE_HOME\reports\conf
Both files are supported by the rwserver. template file in the same directory, which
contains default server configuration values on both Windows and UNIX.

The server._name.conf file is the default server configuration file. The
rwbuilder.conf file configures the server instance used in-process by Reports
Builder.

The server._name.conf and rwbuilder. conf files are nearly identical. The only
difference between them is that rwbuilder . conf does not use the compatible,
persistFile, or security configuration elements, described later in this section.

Both of these files are created automatically, under the following circumstances:

» The server. _name.conf file is created the first time you start Reports Server. It is
based on the rwserver. template file.

s The rwbuilder. conf file is created the first time you run a report through
Reports Builder. It also is based on the rwserver . template file.

= After you rename the server, a new server_name. conf file is created the next
time you start the server. The new configuration file is based on the default values
present in the rwserver. template file. If you wish to retain the configuration
associated with the old server name, you must rename your server_name.cont
file to the new server name (new_server_name. conf), before starting the
renamed server.

= If you delete one of these files, the deleted file is re-created the next time you start
the server. The new file is based on the default values present in the
rwserver. template file.

To explain the syntax and values allowed in these files we'll look at the
rwservercont . dtd file, located in the following directory (on both Windows and
UNIX):

ORACLE_HOME\reports\dtd\rwserverconf.dtd

This section describes:
= Reports Server Configuration Elements (rwserverconf.dtd)
= Dynamic Environment Switching

= Connecting to OracleAS Portal
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3.2.1 Reports Server Configuration Elements (rwserverconf.dtd)

The following example of rwserverconf . dtd illustrates how it is used to configure
various aspects of the Reports Server.

<!l--
Copyright 2000, 2005 Oracle Corporation.
500 Oracle Parkway, Redwood Shores, CA 94065, U.S.A. All rights reserved.

This is the DTD defining the Reports Server Configuration file
(XML) format/syntax.
-—>

<!ELEMENT server (compatible?,
cache?,
engine+,
security*,
oidconnection?,
destination*,
networkConfig?,
job+,
notification*,
log?,
jobStatusRepository?,
trace?,
connection?,
ORBPorts?,
queue?,
persistFile?,
jobRecovery?,
identifier?,
environment*,
pluginParam*) >

<!IATTLIST server

version CDATA #IMPLIED>

<!ELEMENT cache (property*)>
<!-- class specifies full qualified java class name which implements
oracle.reports.cache.Cache interface -->
<!ATTLIST cache
class CDATA "oracle.reports.cache.RWCache">

<!ELEMENT engine (property*)>

<!-- class specifies full qualified java class name which starts engine -->

<!ATTLIST engine
id ID #REQUIRED
class CDATA #REQUIRED
classPath CDATA #IMPLIED
initEngine CDATA "l
maxEngine CDATA R
minEngine CDATA "
engLife CDATA "50"
maxIdle CDATA "30"
callbackTimeOut CDATA "60000"
jvmOptions CDATA #IMPLIED
engineResponseTimeOut CDATA "o
defaultEnvId CDATA #IMPLIED>

<!ELEMENT security (property*)>
<!-- class specifies full qualified java class name which implements
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oracle.reports.server.Security interface -->
<!ATTLIST security
id 1D #REQUIRED
class CDATA #REQUIRED>

<!ELEMENT oidconnection EMPTY>
<!ATTLIST oidconnection

init CDATA "10"
increment CDATA "10"
timeout CDATA ">

<!ELEMENT destination (property*)>
<!-- class specifies full qualified java class name which subclass
oracle.reports.server.Destination abstract class -->
<!ATTLIST destination
destype 1D #REQUIRED
class CDATA #REQUIRED>

<!ELEMENT networkConfig EMPTY>
<!ATTLIST networkConfig
file CDATA #REQUIRED>

<!ELEMENT job EMPTY>
<!ATTLIST job

jobType CDATA "report"
engineId IDREF #REQUIRED
securityId IDREF #IMPLIED>

<!ELEMENT notification (property*)>
<!ATTLIST notification
id CDATA "mailNotify"
class CDATA #REQUIRED>

<!ELEMENT log EMPTY>
<!ATTLIST log
option (allJobs | succeededJobs |failedJobs |noJob) "noJob">

<!ELEMENT jobStatusRepository (property*)>
<!-- class specifies full qualified java class name which implements
oracle.reports.server.JobRepository interface -->
<!ATTLIST jobStatusRepository
class CDATA "oracle.reports.server.JobRepositoryDB">

<!ELEMENT queue EMPTY>
<!ATTLIST queue
maxQueueSize CDATA "1000">

<!ELEMENT connection (orbClient*, cluster?)>
<!ATTLIST connection
maxConnect CDATA "20"
idleTimeOut CDATA "15">

<!ELEMENT ORBPorts EMPTY>
<!ATTLIST ORBPorts
value CDATA #REQUIRED>

<!ELEMENT orbClient EMPTY>

<!ATTLIST orbClient
id ID #REQUIRED
publicKeyFile CDATA #REQUIRED>
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<!ELEMENT cluster EMPTY>

<!ATTLIST cluster
publicKeyFile CDATA #REQUIRED
privateKeyFile CDATA #REQUIRED>

<!ELEMENT persistFile EMPTY>
<!ATTLIST persistFile
fileName CDATA #IMPLIED>

<!ELEMENT trace EMPTY>
<!ATTLIST trace
traceFile CDATA #IMPLIED
traceOpts (trace_prf|trace_brk|trace_app|trace_pls|trace_sql]|
trace_tms|trace_dst|trace_log|trace_err|trace_inf|
trace_dbg|trace_wrn|trace_sta|trace_exc|trace_all|none)

all"
traceMode (trace_replace\trace_append) "trace_replace"
traceModule (all|server|engine) "all">

<!ELEMENT compatible EMPTY>
<!ATTLIST compatible
version (61) 61>

<!ELEMENT jobRecovery EMPTY>
<!ATTLIST jobRecovery
auxDatFiles (yes|no) "no">

<!ELEMENT identifier (#PCDATA)>
<!ATTLIST identifier
confidential (yes|no) "yes"
encrypted (yes|no) "no">

<!ELEMENT environment (envVariable*)>
<!ATTLIST environment
id ID #REQUIRED>

<!ELEMENT envVariable EMPTY>

<!ATTLIST envVariable
name CDATA #REQUIRED
value CDATA #IMPLIED>

<!ELEMENT pluginParam (#PCDATA)>

<!ATTLIST pluginParam
name D #REQUIRED
type (text|file|url) “text">

<!ELEMENT property EMPTY>
<!ATTLIST property

name CDATA #REQUIRED
value CDATA #REQUIRED
confidential (yes|no) "no"
encrypted (yes|no) "no">

"trace_

The rwservercont . dtd file provides the following elements for configuring the

Reports Server:
= server

= compatible
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cache

engine

security
oidconnection
destination
networkConfig
job

notification

log
jobStatusRepository
trace
connection
ORBPorts
queue
persistFile
jobRecovery
identifier
pluginParam

environment

These elements along with their related attributes and sub-elements are discussed in

the following subsections.

Note that these are XML elements, and XML is case sensitive.

Additionally, when you add any of these elements to the server_name.conf or
rwbuilder.conf configuration file, you will save yourself potential error messages
from any XML editor if you use the order of the elements shown in the
rwserverconf.dtd. The configuration file will work regardless of the order, but it
will not work if you fail to follow the case specified in rwserverconf .dtd.

3.2.1.1 server

Example

<server>

One or more configuration specifications

</server>

Required/Optional
Required. You can have a maximum of one open and close tags in the server element

in a given configuration file.

Description
The server element opens and closes the content area of the server configuration file.
In terms of the file's hierarchy, all the other elements are subordinate to the server

element.
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3.2.1.2 compatible

Note: The compatible element is deprecated in Oracle Reports
10¢ Release 2 (10.1.2). When the compatible element is set,
Oracle Reports 6i client requests will still be forwarded to the
Reports Server in 10g Release 2 (10.1.2). However, this is not a
supported configuration, and Oracle will not fix bugs that result
from this configuration.

By default, Oracle Reports 10g Release 2 (10.1.2) enables
compatibility with Oracle Reports 10g Release 1 (9.0.4) clients, and
vice versa. See the Oracle Application Server Forms and Reports
Services Installation Guide for a matrix showing compatibility
between prior release clients and Oracle Reports 10g Release 2
(10.1.2).

Example

<compatible version="61"/>

Required/Optional

Optional. You can have a maximum of one compatible element in your server
configuration file.

Description

The compatible element is available for backward compatibility with Oracle Reports
6i clients (RWCLI60 .EXE, RWCGI60 .EXE, RWQMU60 . EXE, RWRQM60 . EXE,

RWRQV60 . EXE, 6i Forms). When compatible is set to 61, Reports Server will make
use of an executable file named rwproxy that listens for requests from a 6i client and
forwards them to a 10g server.

The compatible element attribute is described in Table 3-2.

Table 3-2 Attributes of the compatible element

Attribute Valid values Description

version 61 Setting version to 61 enables Oracle Reports 6i
clients to run under Oracle Reports. As noted above,
however, Oracle Reports 10g Release 2 (10.1.2) is not
backward compatible with Oracle Reports 6i , and
Oracle will not fix bugs that result from this
configuration.

If you use the compatible element, you must also have an entry for Reports Server
in the tnsnames . ora file as you would have had for the 6i version of Reports Server.
The installer configures the tnsnames . ora file for the default Reports Server; that is,
rep_machine_name.

Note: The tnsnames.ora file is located in the following
directory:

ORACLE_HOME/network/admin

For example:

testsvr.world = (ADDRESS=
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(PROTOCOL=tcp)

(HOST=testhost .mydomain.com)
(PORT=1950)
)

You can bypass this requirement by turning compatibility off. To turn compatibility
off, remove the compatible element from the Reports Server configuration file.

3.2.1.3 cache

Example

<cache class="oracle.reports.cache.RWCache">

<property name="cacheSize" value="50"/>

<property name="cacheDir" value="D:\orawin\reports\server\cache"/>
</cache>

Required/Optional

Optional. You can have a maximum of one cache element in your server
configuration file. If no cache element is specified, the default is used
(oracle.reports.cache.RWCache).

Description

The cache element is available for specifying the Java class that defines the server's
cache implementation. You can use the default cache Java class or develop your own
implementation through the OracleAS Reports Services Cache API.

Note: For more information on the cache AP], refer to the
Reports Software Development Kit (RSDK) on the Oracle
Technology Network (OTN): on the Oracle Reports 10g page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

The cache element attribute is described in Table 3-3.

Table 3-3 Attributes of the cache element

Attribute Valid values Description
class See the Description Default: oracle.reports.cache.RiWCache
column

A fully qualified Java class that implements the
oracle.reports.cache.Cache interface.

You can also enter from zero to multiple properties under the cache element.
Properties are name/value pairs recognized and understood by the implementation
class you register under cache. For example, if you use the default cache Java class
that is provided with OracleAS Reports Services, your configuration entry might look
like this:

<cache class="oracle.reports.cache.RWCache">

<property name="cacheSize" value="50"/>

<property name="cacheDir" value="D:\orawin\reports\server\cache"/>
</cache>
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In the preceding example, cacheSize is measured in megabytes, and cacheDir,
which points to the location of the cache, is specified for a Windows platform. On
UNIX, use UNIX standards, for example:

<property name="cacheDir" value="$SORACLE_HOME/reports/server/cache"/>

The default cache Java class also provides the following properties:

s maxCacheFileNumber is the maximum number of files allowed in the cache. For
example:

<property name="maxCacheFileNumber" value="250"/>

» ignoreParameters lists any report parameters you want to be ignored when
Reports Server constructs the cache key. (The cache key is used by Reports Server
to determine if an incoming job request matches existing output in the cache.)

<property name="ignoreParameters" value="paraml,param2"/>
3.2.1.4 engine

Example
<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="5" minEngine="1" engLife="50" maxIdle="15" callbackTimeOut="90000">
<property name="sourceDir" value="D:\orawin\reports\myReport"/>
<property name="tempDir" value="D:\orawin\reports\myTemp"/>
</engine>

Required/Optional

Required. You must have at least one engine element in your configuration file, and
you can have more than one.

Description

The engine element identifies the fully qualified Java class that starts an engine and
provides a number of attributes that set operational controls on the engine. You can
use the default engine provided with OracleAS Reports Services
(oracle.reports.engine.EngineImpl) or develop your own implementation
through the OracleAS Reports Services Engine API. As an example of a custom engine,
you may have developed an engine to execute an operating system command should
an event occur in your database.

Note: For more information on the engine API, refer to the
Reports Software Development Kit (RSDK) on the Oracle
Technology Network (OTN): on the Oracle Reports 10g page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

The engine element attributes are described in Table 3—4.

3-10 Oracle Application Server Reports Services Publishing Reports to the Web



Configuring Reports Server

Table 3—-4 Attributes of the engine element

Attribute Valid values Description

id string A keyword, unique within a given configuration
XML file that identifies a particular engine
element. This can be a text string or a number, for
example:

id="rwEng"

class See the Default:
Description oracle.reports.engine.EngineImpl

column A fully qualified Java class that implements two

interfaces: oracle.reports.engine.Engine
and
oracle.reports.engine.EngineInterfac
e.

classPath string The directory path to the Java class specified in
the class attribute. To specify the directory, use
the conventions required by the server platform,
for example:

Windows:

classPath="%ORACLE_
HOME%$\myEngine.jar"

UNIX:

classPath="$ORACLE_
HOME/myEngine.jar"

initEngine number Default: 1

The number of engines you want Reports Server
to start at initialization.

maxEngine number Default: 1

The maximum number of this type of engine that
can run on the server.

minEngine number Default: 0

The minimum number of this type of engine that
is maintained by the server.

engLife number Default: 50

The number of jobs the engine can run before the
engine is terminated, and, if necessary, a new
engine is started. This feature is available to
thwart memory leaks.

maxIdle number Default: 30

The number of minutes of allowable idle time
before the engine is shut down However, the
current number of engines should be higher than
minEngine.

For example, if minEngine is 0, maxIdle is 30,
and one engine has been running but unused for
30 minutes, that engine will shut down. If, under
the same conditions, minEngine is 1, the active
engine will not shut down, even if it has been idle
for 30 minutes.
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Table 3—-4 (Cont.) Attributes of the engine element

Attribute

Valid values Description

callbackTimeOut

defaultEnvId

engineResponseTime
Out

jvmOptions

number

string

number

string

Default: 90000

The number of milliseconds of allowable waiting
time between when the server launches an engine
and the engine calls the server back.

If the machine that hosts the server is very fast,
you can reduce this number for faster
performance.

(Optional attribute) The default environment
within which Reports Server starts an engine.
The attribute takes an id associated with an
environment element in the server configuration
file.

If you specify defaultEnvId, Reports Server
starts an engine with the environment variables
specified in the referenced environment element
plus whatever environment variables that
Reports Server is running under.

If you do not specify defaul tEnvId, Reports
Server spawns engines with the environment
settings in force at startup time.

For more information, refer to Section 3.2.2,
"Dynamic Environment Switching".

Default: null (no timeout)

The maximum amount of time (in minutes) for an
engine to update the status of the job while
running a report in your environment. If it takes
longer than this amount of time to update the job
status for some reason (for example, due to the
engine hanging or a long blocking SQL query),
Reports Server terminates the job.

The Java Virtual Machine (JVM) options to be
used by Reports Server when it starts an engine
in the JVM. For example, you can use this
attribute to specify the starting heap size and
maximum heap size for the JVM, additional
classpath entries, and so on.

If this attribute is not specified, the engine
running in the server environment uses the JVM
options specified by the value of the REPORTS_
JVM_OPTIONS environment variable. For more
information, see Section B.1.46, "REPORTS_JVM_
OPTIONS".
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Table 3—-4 (Cont.) Attributes of the engine element

Attribute Valid values Description

keepConnection YES |NO Default: YES

The keepConnection property is used by the
default runtime engine implementation; that is,
oracle.reports.engine.EngineImpl.

YES The default runtime engine retains the
existing database connection information.

NO The default runtime engine discards the
existing database connection information and
reconnects with the userid specified for the job.

The keepConnection property does not affect
reports deployed using either rwbuilder or
rwrun.

This property will be migrated if a server.
name . conf file used in previous versions (for
example, 9.0.2.x) runs in the current environment.

Properties

You can also optionally enter multiple properties under the engine element. The only
requirement is that they be name/value pairs recognized by the Java class that
implements the Oracle Reports engine.

sourcedir and tempDir properties: If you use the default engine Java class that is
provided with OracleAS Reports Services, your engine configuration entry might
look like this:

<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="5" minEngine="1" engLife="50" maxIdle="15" callbackTimeOut="90000">
<property name="sourceDir" value="D:\orawin\reports\myReport"/>
<property name="tempDir" value="D:\orawin\reports\myTemp"/>
</engine>

In this example, sourceDir and tempDir are set up for a Windows environment
(UNIX would be sourceDir="0RACLE_HOME/reports/myReport" and
tempDir="ORACLE_HOME/reports/myTemp"):

s The sourceDir property identifies the default directory you will use for report
definition files. It overrides path information specified in the REPORTS_PATH
environment variable.

s The tempDir property identifies the name and location of the temporary
directory OracleAS Reports Services will use for its temporary files. If this value is
unspecified for a default engine, OracleAS Reports Services will use the temporary
directory specified in the REPORTS_TMP environment variable. If REPORTS_TMP
is also not specified, OracleAS Reports Services will use your operating system's
default temporary directory.

The classPath attribute is not specified because this configuration uses the default
engine class.

diagnosis property: Oracle Reports 10g Release 2 (10.1.2) introduces the diagnosis
property for engine logging. Including this property in your engine configuration
element enables you to diagnose whether or not a specific function in a report run
completed successfully. The diagnostic log provides information on important
checkpoints or tasks in the engine during a report run. This information is useful in
cases where the engine stops responding, resulting in "hanging" jobs.
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To turn on the engine diagnosis option, your engine configuration element might
look like this:

<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="2"
maxEngine="8" minEngine="1" engLife="1" maxIdle="3" callbackTimeOut="90000">
<property name="diagnosis" value="yes">
</engine>

When the diagnosis property is set to yes, the engine creates separate diagnostic
files from the Reports Server and engine trace files. Diagnostic files are in the same
location as the trace files (see Section 20.1.2, "Report Trace"). Every rwEng engine
creates two diagnostic files per instance (that is, per engine lifetime). For example:

rwEng-0-c-2004-08-31_05-24-54.dig
rwEng-0-j-2004-08-31_05-24-54.dig

Each diagnostic log is a new file, with the timestamp included in the file name.
Diagnostic files are not appended to or replaced for different instances of the same
engine.

The engine diagnosis option provides more detailed information than report tracing,
which is typically used to debug the execution of a report to provide information such
as the file currently formatting, or report trigger currently running.

3.2.1.5 security

Example

<security id="rwSec" class="oracle.reports.server.RWSecurity">
<!--property name="securityUserid"
value="portal_db_username/portal_password@portal_db_connection"
confidential="yes" encrypted="no"/-->
<property name="oidEntity" value="oidentity_name"/>
</security>

Note: In releases prior to Oracle Reports 10g Release 1 (9.0.4), the
security element was specified differently. In Oracle Reports 10g
Release 1 (9.0.4) and 10g Release 2 (10.1.2), the old property
specification, securityUserid, is still provided but commented
out. You only need to use securityUserid if you want to connect
to an OracleAS Portal instance other than the default instance,
which is installed with the Oracle Application Server infrastructure.

Required/Optional

Optional. If you do not enter a security element in the configuration file, Reports
Server is not secure. You can have from zero to multiple security elements in your
configuration file.

Description

The security element identifies the fully qualified Java class that controls server
access. You can use the default security class provided with OracleAS Reports
Services, which relies on security features available through OracleAS Portal (included
with Oracle Application Server), or develop your own implementation through the
Reports Server Security APL
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Note: For more information on the security API, refer to the
Reports Software Development Kit (RSDK) on the Oracle
Technology Network (OTN): on the Oracle Reports 10g page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

The security element attributes are described in Table 3-5.

Table 3-5 Attributes of the security element

Attribute Valid values Description

id string A keyword, unique within a given
configuration XML file that identifies a
particular security element. This can be a text
string or a number, for example:

id="rwSec"

class See the Description Default:
column oracle.reports.server.RWSecurity

A fully qualified Java class that implements
Reports Server Security Java interface
(oracle.reports.server.Security). The
default relies on security features available
through OracleAS Portal (included with Oracle
Application Server).

You can associate multiple properties with the security element. The only
requirement is that they be name/value pairs recognized by the Java class that
implements Reports Server security. For example, if you use the default security Java
class that is provided with OracleAS Reports Services, your security configuration
entry might look like the example provided above.

The value of oidEntity is set by the Installer upon installation. Reports Server uses
this entity to connect to the Oracle Internet Directory. Components of the Oracle
Application Server can all connect to the Oracle Internet Directory, but each
component may have different privileges in the directory. Hence, each component
needs to identify itself through its own entity name to the Oracle Internet Directory
when it connects. The OracleAS Reports Services entity is of the following format:

reportsApp_hostname_GUID

For example:

reportsApp_testhost.mydomain.com_ BBEFDCDAC2343600E0340800020C7BBCC

The commented out property, securityUserid, illustrates the old method of
specifying security. securityUserid provides the connection information to enable
the Reports Server access to OracleAS Portal security features. The property attributes
confidential and encrypted are available for encrypting the information within
the property. Once the confidential="yes" and encrypted="no" attributes are
entered, the property value will be encrypted automatically by Reports Server after
you restart the server. When you next open the configuration file, the password
information will be scrambled, and encrypted will be set to yes. If you forget the
password you entered in the configuration file, you can delete the property and
reenter it with new values, making sure to set encrypted to no.
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Note: For securityUserid database connection strings, both
the thin (testhost .mydomain.com:1521:iasdb) and Oracle
Call Interface (scott/tiger@ordb) JDBC formats are supported.

3.2.1.6 oidconnection

Example

<oidconnection init="10" increment="10" timeout="600"/>

Required/Optional

Optional. If you do not enter an oidconnection element in the configuration file,
default values are init="10", increment="10", and timeout="0" (which
specifies no timeout).

Description

The oidconnection element identifies OID connection pooling parameters for
Reports Server.

The oidconnection element attributes are described in Table 3-6.

Table 3—-6 Attributes of the oidconnection element

Attribute Valid values Description

init number Initial number of OID connections to be created
when Reports Server is initialized.

increment number Number of connections to be incremented when
all connections are used up.

timeout number Time in seconds for which a connection can be
idle before it is closed.

Note: Setting much lower or high values for these attributes can
have a performance impact on OracleAS Reports Services.

3.2.1.7 destination

Example

<destination destype="oraclePortal" class="oracle.reports.server.DesOraclePortal">
<property name="portalUserid"
value="portal_db username/portal_password@portal_db_connection"
confidential="yes" encrypted="no"/>
</destination>

Required/Optional

Optional. If you do not enter a destination element in the server configuration file,
the provided destination classes will be used (printer, e-mail, file, cache, and OracleAS
Portal—which is an exception in that it requires an entry in the server configuration
file so that you may specify the userid and password the server will use to log in to the
portal). You can have from zero to multiple destination elements in your server
configuration file.
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Description

Use the destination element to register destination types with the server. There is
no need to register default destinations. You may need to configure the OracleAS
Portal, FTP, or WebDAYV destinations, as follows:

= OracleAS Portal: The entry for this destination is created by default in the server
configuration file, but it is commented out. To start using this destination, you
must uncomment the destination entry, and also provide appropriate property
values (for example, the value for the portalUserid property).

s FIP and WebDAV: The entries for these destinations are created by default in the
server configuration file, and are not commented out. Thus, they are configured
and available by default. If you need to send the output to an FIP or WebDAV
server that requires a proxy, you will need to edit the proxyinfo.xml file
available in the default location (ORACLE_HOME\reports\conf), then
uncomment the proxy property in the destination element and specify the
complete path to the proxyinfo.xml file as the value. For example:

<destination destype="ftp"
class="oracle.reports.plugin.destination.ftp.DesFTP">
<property name="proxy"
value="D:\\oracle\\reports\\conf\\proxyinfo.xml" />
</destination>

You must register any new destination types you create through the OracleAS Reports
Services Destinations APIL

Note: For more information on the destination API, refer to
the Reports Software Development Kit (RSDK) on the Oracle
Technology Network (OTN): on the Oracle Reports 10g page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

Configuring destinations is discussed in detail in Chapter 8,
"Configuring Destinations for OracleAS Reports Services".

The destination element attributes are described in Table 3-7.

Table 3-7 Attributes of the destination element

Attribute Valid values Description

destype string Identifies the destination type, for example:

destype="printer"

class See the Description A fully qualified Java class that is a subclass of
column Reports Server Destination Java class
(oracle.reports.server.Destination).
Allowable values include:

oracle.reports.server.DesMail
oracle.reports.server.DesFile
oracle.reports.server.DesPrinter

oracle.reports.server.DesOraclePort
al
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You also have the option of entering multiple properties under the destination
element. The only requirement is that they be name/value pairs recognized by the
Java class that is a subclass of the Reports Server Destination Java class. For example:

<destination destype="oraclePortal" class="oracle.reports.server.DesOraclePortal">
<property name="portalUserid"
value="portal_db username/portal_password@portal_db_connection"
confidential="yes" encrypted="no"/>
</destination>

In this example, the property provides connect information to enable Reports Server to
access OracleAS Portal. The confidential and encrypted attributes are included
to automatically invoke encryption on the portalUserid value the next time Reports
Server is started.

Note: For portalUserid database connection strings, both the
thin (testhost.mydomain.com: 1521 :iasdb) and Oracle Call
Interface (scott/tiger@ordb) JDBC formats are supported.

Should your destination implementation require additional information, specify the
information in the pluginParam element.

3.2.1.8 networkConfig

Example
<networkConfig file="net3.conf"></networkConfig>

where:

net3.conf is a custom Reports network configuration file that is located in the
ORACLE_HOME/reports/conf directory. Oracle Reports will use the Reports Server
discovery mechanism specified in this file.

Required/Optional

Optional. By default, Oracle Reports uses the rwnetwork. conf file in the ORACLE_
HOME\reports\conf directory to decide the Reports Server discovery mechanism.
Uncomment this element to specify a custom network configuration file.

Note: If you change the network configuration file for Reports
Server, then any client that connects to that server must use the same
configuration settings.

Description

This element specifies the network configuration file that will be used for Reports
Server discovery. For more information, refer to Section 3.3, "Configuring the Reports
Server Discovery Mechanism'".

If naming service is enabled, then the Reports Server will register itself to the naming
service. Oracle Reports clients will then contact the naming service to get the Reports
Server reference. The namingService element attribute is described in

Section 3.3.1.3, "namingService".
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Table 3-8 Attributes of the namingService element

Attribute Valid values Description

file Network The network configuration file should exist in
configuration file the ORACLE_HOME\reports\conf directory.
name.

3.2.1.9 job

Example

<job jobType="report" engineld="rwEng" securityId="rwSec"/>

Required/Optional
Required. You must have at least one job element and can have more than one.

Description

The job element works in collaboration with the engine and security elements. Use
job to identify a job type and specify which engine and which security
implementation should be used with that type of job. For example, you may have
developed an engine to execute an operating system command should an event occur
in your database. Using OracleAS Reports Services's event-driven publishing API, you
identify the event as a specific job type. When the event occurs, the job type
information is sent to Reports Server, which looks up the job type under the job
element in its configuration file, and follows the direction provided in the element's
attributes to the engine (and, if applicable, security implementation) specified for that
type of job.

The job element attributes are described in Table 3-9.

Table 3-9 Attributes of the job element

Attribute Valid values Description

jobType string Default: report

Describes the type of job to be processed by the
server. You can enter any type of job, as long as
Reports Server has an engine to process it.

engineId ID reference References the ID entered for the engine that will
process this job type. Available IDs are specified
under the engine element in the server
configuration file using the id attribute. The id is
a unique keyword (that you devise) within a given
configuration XML file that identifies a particular
engine.

securityId ID reference References the ID entered for the security
mechanism that will be applied to this job type.
Available IDs are specified under the security
element in the server configuration file.

3.2.1.10 notification

Example
<notification id="tellMe02" class="oracle.reports.server.MailNotify"/>
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Required/Optional

Optional. If you do not enter a notification element in the configuration file, the
notification function is disabled. You can have from zero to multiple notification
elements in your configuration file.

Description

Use the notification element to specify a Java class that defines the type of
notification that should be sent when a job succeeds or fails. You can use the default
notification class, which provides for notification through e-mail, or design your own
with the Oracle Reports Notification APIL.

Note: For more information on the notification API, refer to
the Reports Software Development Kit (RSDK) on the Oracle
Technology Network (OTN): on the Oracle Reports 10g page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

The notification element attributes are described in Table 3-10.

Table 3—-10 Attributes of the notification element

Attribute Valid values Description

id string Default: mailNotify

A keyword, unique within a given configuration
XML file, that identifies a particular
notification element. This can be a text string
or a number, for example:

id="tellMeO1"

class See the Default:
Description oracle.reports.server.MailNotify
column

A fully qualified Java class that implements the
Reports Server Notification Java class
oracle.reports.server.Notification.

If you use the default email notification implementation, use the pluginParam element
to specify the outgoing SMTP mail server to be used to send the mail. Use the runtime
commands notifysuccess and notifyfailure to specify the email address
where notification should be sent (for more information, see Appendix A,
"Command Line Keywords"). For example, you can include these commands in your
runtime URL:

notifysuccess=recipient's e-mail address&notifyfailure=recipient's e-mail address
With the default e-mail implementation, you can specify only one address for each

type of notification. You can specify one or both types of notification. You
can send notification each to the same address or each to a different addresses.

A notification element in the server configuration file might look like this:

<notification id="mailNotify" class="oracle.reports.server.MailNotify">
<property name="succNoteFile" value="succnote.txt"/>

<property name=failNoteFile value="failnote.txt"/>

<notification/>
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Some mail servers may validate the sender's domain name. If the notification fails
because of this domain name validation, then you must add the following property as
part of the notification element:

<property name="sender" value="valid email address"/>
With the default notification implementation, it's not necessary to specify a path to the
success or failure text files, provided they're in the default location: ORACLE_

HOME\reports\templates. Otherwise, enter the directory path along with the
filenames according to the requirements of the platform that hosts the server.

3.2.1.11 log

Example
<log option="allJobs"/>

Required/Optional

Optional. You can have a maximum of one 1og element in your server configuration
file.

Description

The 1og element is available for backward compatibility. It invokes the generation and
population of a reports log file. The log file is automatically generated and stored in
the following path (the path is the same for Windows and UNIX):

ORACLE_HOME\reports\server_name\rwserver.log
The 1og element attribute is described in Table 3-11.

Table 3—11 Attributes of the log element

Attribute Valid values Description

option allJobs Default: noJob

succeededJobs  Describes the type of jobs that need to be logged.
This is in addition to the default server activities
that are logged. Choose from the following
noJob options:

= allJobs: Alljobs will be logged

failedJobs

= succeededJobs: Only jobs that ran
successfully will be logged

s failedJobs: Only jobs that failed will be
logged

= noJdob: No jobs will be logged

3.2.1.12 jobStatusRepository

Example

<jobStatusRepository class="oracle.reports.server.JobRepositoryDB">

<property name="repositoryConn" value="scott/tiger@orcl"
confidential="yes" encrypted="no"/>

</jobStatusRepository>
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Required/Optional

Optional. You can have a maximum of one jobStatusRepository element in your
server configuration file.

Description

The jobStatusRepository element specifies the Java class that implements a job
status repository. It provides an additional means (over the persistFile element) of
storing job status information.

The persistFileis a binary file and, therefore, cannot be used to publish job status
information within your application. The jobStatusRepository provides a means
of including status information in your application by providing additional ways of
storing it.

The default class, oracle.reports.server.JobRepositoryDB, stores
information in a database. Use the Oracle Reports APIs to create your own
implementation of the Reports Server Job Repository interface
(oracle.reports.server.JobRepository) that stores information wherever
you wish.

The jobStatusRepository element attribute is described in Table 3-12.

Table 3-12  Attributes of the jobStatusRepository element

Attribute Valid values Description

class See the Default:
Description oracle.reports.server.JobRepositoryDB
column

A fully qualified Java class that implements the
Reports Server Job Repository Java class
(oracle.reports.server.JobRepository).

The jobStatusRepository element allows for zero or multiple properties for
passing options into the repository. The only requirement is that the class you specify
in the server configuration file must recognize the name/value pairs you introduce.

The jobStatusRepository element might look like this in your server
configuration file:

<jobStatusRepository class="oracle.reports.server.JobRepositoryDB">

<property name="repositoryConn" value="scott/tiger@ORCL"
confidential="yes" encrypted="no"/>

</jobStatusRepository>

In this example, the value for the repositoryConn property is the login for access to
the database that stores the repository. The confidential and encrypted attributes
are used to invoke encryption on the login information once Reports Server is
restarted.

Note: For repositoryConn database connection strings, both
the thin (testhost .mydomain.com:1521:iasdb) and Oracle
Call Interface (scott/tiger@ordb) JDBC formats are supported.

3.2.1.13 trace

Example

<trace traceFile="neptune.trc" traceOpts="trace_prf|trace_dbg|trace_wrn"
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traceMode="trace_append" traceModule="server"/>

Required/Optional

Optional. You can have a maximum of one trace element in your server
configuration file.

Description

Use the trace element to create a file for tracing your report's execution and to
specify the objects and activities you want to trace. The trace element controls
tracing only for the server and the engine.

Note: For information about the various ways to trace report
execution, see Section 20.1.2, "Report Trace".

Reports Server uses the rwlpr executable for submitting a print job. For rwlpr
logging for Windows, when you enable tracing for Reports Server using either
traceModule=all or traceModule=server, a printing diagnostic log (server_
name-rwlpr-jobid.log)is created in the log directory (ORACLE_
HOME\reports\logs\server_name\) for destype=printer. This log file will
contain information regarding the messages that can be used to diagnose any printing
issues, such as spooler problems.

By default, trace files are generated in ORACLE_HOME\reports\logs. Ifjob tracing
is specified, trace files are generated in ORACLE_HOME\reports\logs\server_
name\ job_1id.

The trace element attributes are described in Table 3-13.

Table 3-13 Attributes of the trace element

Attribute Valid values Description

traceFile * trc Default: server name.trc

The filename of the trace file. If no path is specified,
the trace file will be in the following directory on
both Windows and UNIX:

ORACLE_HOME/reports/logs/
If job tracing is specified, the trace file will be in:

ORACLE_HOME/reports/logs/server_
name/job_id

traceOpts see Table 3-14 Default: trace_all

This attribute defines the activities that will be traced.
You can have one or more traceOpts values. For
example:

<traceOpts="trace_prf | trace_brk">

Separate values with a vertical bar (). Valid values
are listed and described in Table 3-14.

traceMode trace_replace Default: trace_replace

trace_append Defines whether new trace information will either
overwrite the existing trace file (trace_replace),
or be added to the end of the trace, leaving existing
trace information intact (trace_append).
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Table 3-13 (Cont.) Attributes of the trace element

Attribute Valid values Description
traceModule  all By default, tracing tracks both server and engine
events. Tracing engine events can cause performance
server i
problems in some cases. Use traceModule to track
engine only server events (server), only engine events

(engine), or both (a1l). For example:

<trace traceOpts="trace_all"
traceModule="server"/>

If traceModule is not specified, the both server and
engine traces are turned on.

(Windows only) When you enable tracing for Reports
Server, a printing diagnostic log (server_
name-rwlpr-jobid.log) is created in the log
directory (ORACLE._
HOME\reports\logs\server_name) for
destype=printer. This log file will contain
information regarding the messages that can be used
to diagnose any printing issues, such as spooler
problems.

The traceOpts element attributes are described in Table 3-14.

Table 3—14 Valid values for the traceOpts attribute

Value

Description

trace_prf
trace_brk
trace_app
trace_pls
trace_sqgl
trace_tms

trace_dst

trace_log

trace_err

trace_inf

trace_dbg
trace_wrn

trace_sta

trace_all

trace_exc

Logs server and engine profile

Lists debug breakpoints

Logs information on all report objects

Logs information on all PL/SQL objects

Logs information on all SQL

Enters a timestamp for each entry in the trace file

Lists distribution lists

Use this value to determine which report section was sent to
which destination.

Duplicates log information in your trace file

If you have specified a 1og element in your server
configuration file, in addition to using the trace element, this
value will cause information that is sent to the log file to also
be sent to the trace file.

Lists server error messages

This is a catch-all option that dumps any information not
covered by the other options into the trace file

Logs debug information
Lists server warning messages

Provides server and engine state information, such as initialize,
ready, run, and shut-down

Logs all possible server and engine information in the trace file

Lists all exceptions
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Table 3—-14 (Cont.) Valid values for the traceOpts attribute

Value Description

none Disables tracing, and generates only log files (not trace files) in
the directory specified by traceFile.

When you specify multiple trace elements, separate them with vertical bars. For
example:

traceOpts="trace_prf|trace_dbg|trace_wrn"
3.2.1.14 connection

Example

<connection maxConnect="50" idleTimeOut="20">
<orbClient id="RWClient" publicKeyFile="clientpub.key"/>
</connection>

Required/Optional

Optional. If you do not specify a connection element in your server configuration
file, default values will be used (see Table 3-15). You can have a maximum of one
connection element in your server configuration file.

Description

The connection element defines the rules of engagement between the server and the
clients connected to it.

The connection element attributes are described in Table 3-15.

Table 3—-15 Attributes of the connection element

Attribute Valid values Description

maxConnect Number Default: 20

The maximum number of requests that the server can
service simultaneously. Requests in excess of the
maxConnect value return a Java exception.

idleTimeOut Number Default: 15

Allowable amount of time in minutes the connection
can be idle.

In addition to its attributes, connection has a sub-element: orbClient.

Note: In Oracle Reports 10g Release 2 (10.1.2), Reports Server
clustering is deprecated (see A Guide to Functional Changes Between
Oracle Reports 6i and 10g for more details), and the cluster
sub-element is not valid. See also Section 3.4.19, "Migrating
OracleAS Forms Services Applications that Include a Reports
Server Cluster Name".

For information about Application Server-level techniques for high
availability, refer to Section 1.5.4, "Choosing a High Availability
Environment".
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Use orbClient to provide the name of the public key file that the client will use to
connect to Reports Server. Reports Server uses the public key to verify the signature
sent by the client when it tries to connect to Reports Server. Reports Server only
accepts clients whose signature can be verified through this public key. You can have
from zero to multiple orbClient sub-elements in your server configuration file.

The orbClient sub-element attributes are described in Table 3-16.

Table 3-16 Attributes of the orbClient sub-element

Attribute Valid values Description

id string Default: RWClient
Identifies the Reports Client to be served by the
public and private key.

publicKeyFile filename.key  Default:clientpub.key

Identifies the public key file that the client will use
to connect to Reports Server. Reports Server uses
the public key to verify the signature sent by the
client when it tries to connect to Reports Server.
Reports Server only accepts clients whose signature
can be verified through this public key. The default

file is stored in the rwrun. jar file.

OracleAS Reports Services provides default client public and private key files,
clientpub.key and clientpri.key. These key files are in place for all
components of OracleAS Reports Services You can regenerate public and private key
files to replace the default key pair. To do this, at the command prompt use the
following command:

On Windows:

rwgenkey.bat path_and client_public_key file name path _and_client_private key
file_name

On UNIX:
rwgenkey.sh path_and client_public_key file _name path_and_client_private_key file

name

If you regenerate these keys, you can specify the public key file locations with the
publicKeyFile attribute, and replace the private key file in ORACLE_
HOME\jlib\zrclient.jar. To do this, you must unjar the file, place the
regenerated private key into it, and rejar the file.

3.2.1.15 ORBPorts

Example

To specify a port range:
<ORBPorts value="17000-17010"/>
To specify specific ports:

<ORBPorts value="17000,17010,17020,17030,17040"/>

Required/Optional

Optional. By default, CORBA objects use any available port for communication. Since
Reports Server uses CORBA for communication, it will use any available free port for
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communication. If you want Reports Server to use predefined ports instead of random
ports, you must include the ORBPorts element in the server configuration file.

Description

The ORBPorts element specifies either a range of ports or specific ports for CORBA
communication. When ORBPorts is specified, Reports Server will choose one of the
ports from the list specified for ORB internal communication. One port is needed for
Reports Server and one for each engine.

Note: The ORBPorts element is used to assign specific ports to
Reports Server and engines for running report and other requests.
Do not confuse these ports with those you see in Oracle Enterprise
Manager 10g through the Ports link, which are ports reserved for
Reports Server discovery mechanism and the Oracle Reports bridge
component, as set in rwnetwork.conf and rwbridge_
bridgename.conf, respectively (see Section 3.3.1, "Network
Configuration Elements (rwnetworkconf.dtd)" and Section 3.3.2,
"Bridge Configuration Elements (bridgeconf.dtd)").

You cannot specify port numbers for individual engines. Each engine picks up the next
port number in the list. Suppose you have the maxengine attribute of the engine
element set to 5 for rwEng, and URLEnNg is also enabled, then you must specify a
minimum of 7 ports in the ORBPorts element (1 for Reports Server + 5 for rwEng + 1
for rwURLEnNQ).

The ORBPorts element attributes are described in Table 3-17.

Table 3-17 Attributes of the ORBPorts element

Attribute Valid values Description

value Range of values The port range that can be used for Reports Server and
or engine communication through CORBA.

Numbers
separated by

commas

Note: The ORBPorts element should be defined only if you have
enabled TCP port filtering on your server where Reports Server is
running. If port filtering is enabled, you can open few ports for
Reports Server, then use ORBPorts to specify them in the server
configuration file for Reports Server/engine communication. If any
of the ports are not available, Reports Server or engines may fail to
start and an error displays.

3.2.1.16 queue

Example

<queue maxQueueSize="1000"/>
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Required/Optional

Optional. You can have a maximum of one queue element in your server
configuration file. If you have no queue element, the default, 1000, will remain in
effect.

Description

Use the queue element to specify the maximum number of jobs that can be held in
each of the reports queues. OracleAS Reports Services has three queue components:
= aqueue of scheduled jobs

= aqueue of jobs in progress

= aqueue of completed jobs

The queue element provides the allowable value for each of these components.

This element is applicable only to the completed job queue. Thus, if the number of jobs
exceeds the specified maximum value, that completed job queue will automatically
purge its oldest jobs. The scheduled job queue and the in-progress job queue remain
unaffected.By default reports server queue size is 1000 jobs.

If you increase the queue size to more than 3000, and use Reports Queue Manager
(rwram. exe) to monitor the queue, Queue Manager may fail. When a queue size of
3000 or greater is required, use Oracle Enterprise Manager 10g or Reports Servlet
(rwservlet) to manage and monitor the Reports Server jobs queue.

Note: For more information, see the Reports Queue Manager online
Help.

The queue element attribute is described in Table 3-18.

Table 3—18 Attribute of the queue element

Attribute Valid values Description

maxQueueSize Number Default: 1000

The maximum number of jobs that can be held in a
given reports job queue.

3.2.1.17 persistFile

Example

<persistFile fileName="neptune.dat"/>

Required/Optional

Optional. If you do not specify a file, the server will create one of its own with the
default name server name.dat. You can have a maximum of one persistFile
element.

Description

The persistFile element identifies the file that records all job status. It is used by
Reports Server to restore the server to the status it held before shutdown.

It is named persistFile because the file remains intact, or persists, even when the
server is brought down and restarted.
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The server persistent file is created automatically the first time you start the server or
the first time you start the server after the current server persistent file has been
deleted or renamed. If you want to rename this file but continue using it, enter the new
name in the server configuration file before you actually rename the file, then restart
the server.

The persistFile element attribute is described in Table 3-19.

Table 3—19 Attribute of the persistFile element

Attribute Valid values Description

fileName string Default: server_name.dat

The name and, optionally, the path of the server
persistent file. You can leave the path off if the file is
kept in its default directory:

ORACLE_HOME\reports\server\
The path is the same for Windows or UNIX.

3.2.1.18 jobRecovery

Example

<jobRecovery auxDatFiles="yes"/>

Required/Optional

Optional. If you want to enable the job recovery mechanism, add the jobRecovery
element to the server configuration file. By default, the job recovery mechanism is
disabled.

Description

The jobRecovery element includes the attribute auxDatFiles. When
auxDatFiles=yes, Oracle Reports enables a more resilient job recovery mechanism
for maximal retrieval of jobs in case the original . dat file is corrupt due to some
reason. When auxDatFiles=yes, Reports Server creates two auxiliary files in
addition to server_name.dat (the main .dat file):

» datfilename_offset.dat contains the auxilliary information of jobs in the
main . dat file, which helps in retrieving of jobs from the main . dat file.

» datfilename_sc.dat contains all scheduled jobs information (in addition to the
information stored in main . dat file).

If the job recovery mechanism is enabled, Reports Server on startup reads the main
.dat file with the help of the datfilename_offset.dat file using the auxilliary
information stored in it. If it finds that the main . dat file is corrupt and it cannot
retrieve all the jobs information, it starts reading the datfilename_sc.dat file and
recovers the scheduled jobs for this file. Thus, datfilename_sc.dat serves as a
backup file, which results in maximum possibility of recovery of scheduled jobs in
case of corruption of the main . dat file.

If Reports Server fails to find the datfilename_offset.dat file (for example, when
the jobRecovery element is enabled for first time) when the job recovery mechanism
is enabled, it reads the jobs from the main . dat file and creates the other two auxiliary
files from scratch.

The server_name.dat, datfilename_offset.dat,and datfilename_sc.dat
files form a unique triplet, and the auxiliary files are valid only the job recovery
mechanism is enabled. If the auxiliary files are found when the job recovery
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mechanism is disabled, Reports Server deletes these files from the file system to
maintain the integrity between these files. For this reason, you must always handle
these three files together (for example, if you are copying a file from one machine to
another, you must copy these three files together).

The jobRecovery element attribute is described in Table 3-20.

Table 3-20 Attribute of the jobRecovery element

Attribute Valid values Description
auxDatFiles ves Default: no
no See Description, above.

3.2.1.19 identifier

Example

<identifier confidential="yes"
encrypted="yes">fpoiVNFvnlkjRPortn+sneU88=NnN</identifier>

Required/Optional

Optional. You can have a maximum of one identifier element in your server
configuration file.

Description

The identifier element is automatically written to the configuration file by the
Reports Configuration Assistant when you first install Oracle Reports. The Reports
Configuration Assistant sets the values in the form
SERVERACCESSKEY/12312312313, where: SERVERACESSKEY is the user name and
the random generated number (12312312313) is the password. This user name and
password is then encrypted and written to rwserver. template and targets.xml
during the time of configuring OracleAS Reports Services. Any Reports Server started
after the installation will have this identifier information stored in its configuration
file.

For a non-secured Reports Server, the values of the identifier element is used
when:

= Connecting to a Reports Server through the Reports Queue Manager.
s Shutting down a Reports Server through the command line.

In either of these cases, you must provide the authid in the command line that
matches the values specified in the identifier element. To provide a specific
password (as the password is a pseudo random number), you must do the following:

1. Edit the server configuration file, server_name.conf.

2. Replace the encrypted username/password values generated with custom
values.

3. Setencrypted=no.

Note: Set confidential=no only if you do not want the
username/password to be encrypted.

For example:
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<identifier confidential="yes" encrypted="no">username/password</identifier>

4, Restart Reports Server. Reports Server sets encrypted=yes when it restarts.

5. Edit the targets.xml file and specify the same username and password values
that were included in the server name.conf file.

You should restart Reports Server, immediately, after making this change. Reports
Server automatically encrypts the user name and password and resets encrypted to
yes. The values should now read as follows:

<identifier confidential="yes"
encrypted="yes">fpoiVNFvnlkjRPortn+sneU88=NnN</identifier>

For a secure Reports Server, the authentication is done by the security infrastructure,
that is by using the Oracle Internet Directory repository. Thus, you cannot pass the
values in the identifier element to shut down a Reports Server or launch Reports
Queue Manager through the console window.

Note: This user name and password is also used for accessing
rwservlet Web commands, such as getjobid,
getserverinfo, showjobs, and showenv when
DIAGNOSTIC=NO in the rwservlet.properties file. When
DIAGNOSTIC=NO, Web commands are disabled for everyone except
those administrators who have this user name and password.

For more information on Reports Queue Manager, see the Reports Queue Manager
online Help. For more information on rwservlet.properties, refer to Section 3.4,
"Configuring Reports Servlet".

3.2.1.20 pluginParam

Example

<pluginParam name="mailServer">smtp0l.mycorp.com</pluginParam>

Required/Optional
Optional. You can have as many pluginParam elements as you require.

Description

The pluginParam element provides a means of specifying plug-ins that can be used
by several built-in destinations such as e-mail, JDBC pluggable data source (PDS), Text
PDS, and so on. It is not used by the FTP and WebDAYV built-in destinations, and is not
available to custom pluggable destinations, such as fax.

You can specify any plug-in parameter and name it in any way as long as it is
supported or required by the built-in destination.

The pluginParam element attributes are described in Table 3-21.

Table 3-21 Attributes of the pluginParam element

Attribute Valid values Description

name string The name of the plug-in parameter.
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Table 3-21 (Cont.) Attributes of the pluginParam element

Attribute Valid values Description
type text Default: text
file Describes the type of plug-in being specified.
url For text, specify the string that is required to identify

the named plug-in parameter, for example, the name
of a mail server. Text means the content of the
pluginParam element is text, so the
getPluginParam() method will return the exact
content specified in the element.

For £ile, specify the directory path and filename of
the plug-in parameter file. Use the standards for
specifying directory paths appropriate to Reports
Server's host machine (either Windows or UNIX).
File means that the content of the pluginParam
element is a filename, and the getPluginParam()
method will return the content read from the file
specified.

For url, specify the full, absolute URL required by
the plug-in parameter, for example, the full URL to an
FIP site. url means the content of the pluginParam
element is a URL, and the getPluginParam /()
method will return the content read from that URL.
The URL you use must reside on the same side of the
firewall as OracleAS Reports Services.

Note that when you have a default type (text), itis
not necessary to specify it in the pluginParam string.
The example that heads this section doesn't specify a
type because the plug-in parameter, a mail server
name, is the default type, text.

3.2.1.21 environment

Example
<environment id="JP">
<envVariable name="NLS_LANG" value="Japanese_Japan.JA16SJIS"/>
<envVariable name="NLS_CURRENCY" value="¥"/>
<envVariable name="DISPLAY" value="MyServer.MyCompany.com:0.0"/>
</environment>

Required/Optional
Optional. You can have as many environment elements as you require.

Description

The environment element defines the characteristics (that is, environment variables)
that you want to use to establish a particular runtime environment. You may include
as many environment elements as you need (for example, one for each
language/territory you need to support). Inside an environment element, you can add
as many envVariable elements as required.

By referencing the environment element's id, you invoke its settings. You can
reference an environment element id from:

s The defaultEnvId attribute of the engine element in the Reports Server
configuration file, to apply the corresponding environment settings to that engine
when it starts up. For more information, refer to Section 3.2.1.4, "engine".
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s The command line keyword, ENVID, of your report's job request, which makes the
environment settings only effective for that particular report job request.

The environment element attribute is described in Table 3-22.

Table 3-22 Attribute of the environment element

Attribute Valid values Description

id string The name of the environment.

The environment element has one sub-element, envVariable. Each envvariableis
specified as a name—value pair. They can be either standard environment variables or
user-defined environment variables.

The envVariable element attributes are described in Table 3-23.

Table 3-23 Attributes of the envVariable element

Attribute Valid values Description

name string The name of the environment you wish to use (for
example, NLS_LANG).

value string The value you want to assign to the environment
variable identified with the name attribute.

3.2.2 Dynamic Environment Switching

Dynamic environment switching enables you to dynamically change the environment
after Reports Server is started, or for a specific job request. This means that one
instance of Reports Server can serve reports with any arbitrary environment settings,
such as language, currency, and display settings.

To enable dynamic environment switching, you first need to add an environment
element to your Reports Server configuration file to establish a particular runtime
environment. Once you have an environment element established, you can switch to
its settings in either of the following ways:

s Set the value of the defaul tEnvId attribute of the engine element in the
Reports Server configuration file to the 1d of the environment element, to apply
the environment settings to that engine when it starts up. For more information,
refer to Section 3.2.1.4, "engine".

= Set the value of the ENVID command line keyword to the id of the environment
element, to make the environment settings effective for the current report job
request. For more information, refer to Section A.3.34, "ENVID".

3.2.2.1 Examples

The following examples illustrate the use of dynamic environment switching.

Example 1

Suppose that you need to run reports in Japanese from your Reports Server. An
environment conducive to running reports in Japanese would include:

m NLS_LANG = Japanese_Japan.JAl16SJIS
s The currency unit (NLS_CURRENCY) would be set to Yen (¥), the currency of Japan.

»  If Reports Server is running on UNIX, then DISPLAY would also need to be set.
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To begin, you would have to add an environment element to your Reports Server
configuration file that looks something like the following:

<environment id="JP">
<envVariable name="NLS_LANG" value="Japanese_Japan.JA16SJIS"/>
<envVariable name="NLS_CURRENCY" value="¥"/>
<envVariable name="DISPLAY" value="MyServer.MyCompany.com:0.0"/>
</environment>

Once the environment element is in place, you could request a report with Japanese
output in either of the following ways:

»  Use the defaultEnvId attribute of the engine element in the Reports Server
configuration file as follows:

<engine id="rwEng" initEngine="1" minEngine="0" maxEngine="10" engLife="50"
maxIdle="30" defaultEnvId="JP"/>

The value JP identifies the environment element in the Reports Server
configuration file. The initial engines will be spawned with the environment
settings specified in this environment element.

= Set the ENVID command line keyword, as follows:

http://yourWebServer:port/reports/rwservlet?SERVER=yourreportsserver
&REPORT=Japanese.rdf&USERID=username/passwd@db&DESFORMAT=htmlcss
&DESTYPE=cache&ENVID=JP

When the URL is submitted to Reports Server, it detects the optional ENVID
keyword and matches the specified id (in this case, JP) to the corresponding id of
the environment element in its configuration file. If Reports Server already has
an engine running with these characteristics, it will reuse the existing engine to
process the job. If not, then it spawns an engine using the current environment
plus the three environment variables specified in the JP environment element. If
spawning a new engine would cause Reports Server to exceed its maxEngines
setting, Reports Server shuts down an engine before starting a new one. An engine
may be shut down even though it has not exceeded its engLi fe setting. Once
Reports Server has an engine with the correct environment running, the job is
processed by that engine and the output is routed to the specified DESTYPE.

If you do not pass ENVID with the job, Reports Server processes the request using
an engine started with the defaultEnvId environment. If defaultEnvIdis not
specified for the engine element in your Reports Server configuration file, then
the engine will inherit the settings with which the Reports Server instance was
started.

Example 2

The following example illustrates how to use this environment switching feature to
run an Arabic report on the same Reports Server that was used to run the Japanese
report in Example 1.

Add another environment element to the Reports Server configuration file as shown
below:

<environment id="AR">

<envVariable name="NLS_LANG" value="Arabic_United Arab Emirates.AR8IS08859P6"/>
<envVariable name="NLS_CALENDAR" value="Arabic Hijrah "/>

</environment>
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The Arabic report has to be submitted to Reports Server with the following command
line:

http://yourWebServer:port/reports/rwservlet?SERVER=yourreportsserver
&REPORT=arabic.rdf&USERID=username/passwd@db&DESFORMAT=htmlcss
&DESTYPE=cache&ENVID=AR

Since the job is submitted with ENVID=AR, Reports Server finds or starts an engine
with the environment specified by element AR in the Reports Server configuration file.
The job is processed by the new engine and the output is distributed to the specified
destination.

Example 3

The following example illustrates how the environment switching feature could be
used in conjunction with a JSP report; that is, without Reports Servlet (rwservlet).

Suppose that you have the following environment elements in the Reports Server
configuration file:

<environment id="UK">
<envVariable name="NLS_LANG" value="AMERICAN_UNITED KINGDOM.WE8ISO8859P1"/>
</environment>

<environment id="US">
<envVariable name="NLS_LANG" value="AMERICAN AMERICA.WE8ISO8859P1"/>
</environment>

If your JSP report uses a format mask such as the following, it means the currency,
grouping, and decimal symbols can change according to the environment:
<rw:field id="sal" src="sal" formatMask="L999G999D999"/>

To run the report using the UK symbols for currency, grouping, and decimal, you
would use the following URL:

http://myserver:port/test/myjsp?USERID=scott/tiger@orcl&ENVID=UK

Note: You could place ENVID=UK into a key in the cgicmd. dat file.

3.2.2.2 Usage Notes

= Although this feature is ideal for handling reports of various languages, its
application can be much broader. You could use it in any situation where a report
requires a particular environment to execute correctly.

= Reports Server will start one or more engines per environment id as and when it
gets requests for specific environments. The total number of engines, however,
cannot exceed the maxEngine specified for that engine type. It is recommended
that you set maxEngine to a value greater or equal to the number of environment
elements specified in the Reports Server configuration file.

s defaultEnvId can also be applied to pluggable engines other than rwEng.
Reports Server will spawn the pluggable engine with the specified environment
id.

= For engines used by the in-process Reports Server, the order of precedence for
environment variables from highest to lowest is as follows:

s reports.sh (UNIX only)
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Note: If you have modified your current reports. sh file, you
should save it and, after installing Oracle Reports, merge your
modifications into the version of reports. sh installed with the
latest version. The latest reports. sh contains some required
changes.

= environment element in the Reports Server configuration file

s Inthe ORACLE _HOME/j2ee/0C4J_BI_Forms/config/oc4j.properties
file: the oracle. home property defines the ORACLE_HOME setting and
oracle.path defines the PATH setting.

s In ORACLE_HOME/opmn/conf/opmn.xml, the <environment> element
under <oc4j instanceName="0C4J_BI_Forms" gid="0C4J_BI_
Forms">

»  The system settings and registry (Windows only)

= For engines used by the standalone server, the order of precedence for
environment variables from highest to lowest is as follows:

s reports.sh (UNIX only)

Note: If you have modified your current reports. sh file, you
should save it and, after installing Oracle Reports, merge your
modifications into the version of reports. sh installed with the
latest version. The latest reports. sh contains some required
changes.

» environment element in the Reports Server configuration file
s The environment set in the console where you start rwserver. sh
s The system settings and registry (Windows only)

s If the same environment variable that is set in ENVID is also set in reports.sh
(ORACLE_HOME/bin/), Reports Server obtains the environment variable value
from reports. sh and not from ENVID.

For example, say you want to set the REPORTS_PATH environment variable to a
different engine by using the environment switching feature. However, the
reports. sh file also has the same REPORTS_ PATH environment variable set.
Reports Server will now use only REPORTS_PATH set by reports. sh and not the
REPORTS_PATH set in ENVID when you pass any request.

To work around this issue, you must:

1. Open reports. sh and comment the environment variable value. For
example, comment the REPORTS_PATH value set in the reports. sh file.

2. Openthe server_name.conf file.

3. Copy the environment variable value in the reports. sh file to the server._
name . conf file. For example:

<environment id="default">
<envVariable name=REPORTS_PATH value="$SORACLE_
HOME/reports/templates: SORACLE_
HOME/reports/samples/demo: SORACLE_HOME/reports/integ: SORACLE_
HOME/reports/printers"/>
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</environment>

<environment id="testenv">

<envVariable name="REPORTS_PATH"
value="/private/file_path:$SORACLE_HOME/reports/templates:SORACLE_
HOME/reports/samples/demo: SORACLE_HOME/reports/integ: SORACLE_HOME/
reports/printers"/>

</environment>

4. Add the defaultEnvId value to the appropriate tag in the server._
name. conf file.For example, add the defaultEnvId attribute to the engine
element so that the engine starts with the default REPORTS_PATH.

<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50"
maxIdle="30"callbackTimeOut="90000"

defaultEnvId="default">

5. Now run the report.

3.2.3 Connecting to OracleAS Portal

By default, Reports Server can only use portal users to connect to OracleAS Portal. It
cannot use an ordinary userid, such as scott/tiger, unless you first assign
appropriate privileges to its schema.

To assign the appropriate privileges to a schema other than the portal schema, you
need to run the following script from SQL*Plus as an OracleAS Portal user:

ORACLE_HOME/portal/admin/plsql/wor/rwgrant.sqgl

Once the script is loaded, it prompts you to enter the connection string for the new
schema (for example, repapp/repapp@orcl). The script then assigns the
appropriate privileges to this new schema. You will then be able to specify this
connection string in the Reports Server configuration file to connect to OracleAS
Portal.

3.3 Configuring the Reports Server Discovery Mechanism

Oracle Reports 10g Release 2 (10.1.2) replaces the use of Borland's VisiBroker with Sun
Microsystems' industry-standard Java Developer's Kit Object Request Broker (JDK
ORB), providing support for Reports Server requests from clients across subnets, and
using the broadcast mechanism for dynamic Reports Server discovery both within a
subnet and across subnets.

Note: Oracle Reports 10g Release 2 (10.1.2) also introduces the
rwdiag executable to provide diagnosis for the JDK ORB
implementation. Using rwdiag, you can replace the functionality
of osfind available in the prior VisiBroker implementation,
providing information about which ORB applications are running
and options for logging ORB-related network traffic. For more
information on rwdiag, see Appendix E, "Reports Server and
Bridge Diagnostic Utility".

The JDK ORB implementation enables you to select either of the following methods to
discover a Reports Server in the network:
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»  The Oracle Reports built-in broadcast mechanism (see Section 1.4.1, "Server
Discovery Using the Broadcast Mechanism").

s The Common Object Service (COS) naming service (see Section 1.4.2, "Server
Discovery Using the COS Naming Service").

Note: The Oracle Reports default broadcast mechanism requires the
host machine to be inside a network. If the host machine is not in a
network (that is, it is a standalone machine), then the built-in
broadcast mechanism does not work. As a result, you cannot use
OracleAS Reports Services. Specifically, Oracle Reports clients cannot
discover and communicate with Reports Server(s). Note that the
definition of a "network" does not include a Virtual Private Network
(VPN). That is, even if the host machine is connected to the network
through VPN, Oracle Reports clients cannot discover and
communicate with Reports Server(s).

Therefore, if your installation is on a standalone (non-networked) host
machine or you are connected to a network through VPN, use the
information in this section to turn off the broadcast mechanism, and
turn on the naming service instead.

This section describes the configuration elements required for discovering a Reports
Server:

= Network Configuration Elements (rwnetworkconf.dtd) (for either method)

= Bridge Configuration Elements (bridgeconf.dtd) (for broadcast mechanism across
subnets)

3.3.1 Network Configuration Elements (rwnetworkconf.dtd)

The rwnetworkconf .dtd is a DTD file that contains the data type definitions for the
various network configuration file (rwunetwork. conf) elements and attributes when
using either the built-in broadcast mechanism or the COS naming service method for
Reports Server discovery. This file is located in the following directory:

ORACLE_HOME\reports\dtd

Data type definitions list all the elements allowed in an associated XML file, the
attributes associated with those elements, and the default values for those attributes.

<l--
Copyright 2005 Oracle Corp.
500 Oracle Parkway, Redwood Shores, CA 94065, U.S.A. All rights reserved.

This is the DTD defining the Reports network configuration file
(XML) format/syntax.
-=>

<!ELEMENT discoveryService ( multicast namingService )>
<!ATTLIST discoveryService
version CDATA "10.1.2">

<!ELEMENT multicast EMPTY >
<!ATTLIST multicast

channel CDATA #REQUIRED
port CDATA #REQUIRED
timeout CDATA "1000"
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retry CDATA

<!ELEMENT namingService EMPTY >
<!ATTLIST namingService

name CDATA
host CDATA
port CDATA

"3y

#REQUIRED
#REQUIRED
#REQUIRED>

The rwnetworkcont . dtd file provides the following elements for configuring the
discovery mechanism for Reports Server:

m  discoveryService
= multicast

= namingService
3.3.1.1 discoveryService

Required/Optional

Required. You can have a maximum of one open tag and one close tag in the
discoveryService element in a given configuration file.

Description

The discoveryService element opens and closes the content area of the network
configuration file. In terms of the file's hierarchy, all the other elements are
subordinate to the discoveryService element.

3.3.1.2 multicast

Example

<multicast channel="228.5.6.7" port="one of the port in alotted AS ports"

timeout="1000" retry="3"/>

Required/Optional

Conditional. The namingService and multicast elements are mutually exclusive.

Description

The multicast element contains the necessary information required to be able to
identify where the Reports Server is running.

The multicast element attributes are described in Table 3-24.

Table 3-24 Attributes of the multicast element

Attributes Valid Values

Description

channel  Broadcast channel
port Broadcast port
timeout  Time (in milliseconds) it

should wait for
response. The optimum
value for this setting is
1000.

The broadcast channel
used by the Reports
Server.

The broadcast port used
by the Reports Server.

The Reports Client will
wait for the specified
timeout period for a
response from the Reports
Server.
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Table 3-24 (Cont.) Attributes of the multicast element

Attributes Valid Values Description

retry Retry count The Reports Client will
retry for the specified
number of times, if there
is no response from the
Reports Server after the
timeout period.

Note: It is strongly recommended that you do not change the default
channel and port unless it is absolutely necessary. The default port
value for rwnetwork. conf is assigned when you install Oracle
Application Server.

If you need to customize rwnetwork. conf, you must specify a valid
port range reserved for the Reports Server (14021 to 14030). If you are
using the Oracle Reports bridge for discovering Reports Servers across
subnets, you should set the timeout and retry values carefully for the
bridge to function correctly. Refer to Table 3-24 for setting the timeout
value. For more details, see Section 20.3, "Using rwdiag for Bridge
and Network Timeout Settings".

3.3.1.3 namingService

Example
<namingService name="Cos" host="mymachine.mydomain.com" port="14021"/>

Required/Optional
Conditional. The namingService and multicast elements are mutually exclusive.

Description

The namingService element contains the necessary information required to be able
to identify the host name and the port where the COS naming service is running. For
more information, see Section 1.4.2, "Server Discovery Using the COS Naming
Service".

The namingService element attributes are described in Table 3-25.

Table 3-25 Attributes of the namingService element

Attributes Valid Values = Description

name Cos The descriptive
name of the
naming service.

host Host name/IP  The host name
of the machine
where the
naming service
is running.

port Port number The port number
of the machine
where the
naming service
is running.
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3.3.2 Bridge Configuration Elements (bridgeconf.dtd)

The bridgeconf.dtdis a DTD file that contains the data type definitions for the
various bridge configuration file (repbrg_bridgename.conf) elements and
attributes when using the built-in broadcast mechanism for Reports Server discovery
across subnets.

The Oracle Reports bridge acts as a gateway for packets that are broadcast by Reports
Server and Reports Client across subnets. For example, in a sample setup, Oracle
Reports components are installed on different subnets: Reports Servlet is in subnet A
and Reports Server is in subnet B. To achieve this configuration, the Oracle Reports
bridge has to be started on each subnet. Bridge configuration will include the host and
port settings. The Oracle Reports bridge in subnet A will contact the Oracle Reports
bridge in subnet B through reliable TCP to retrieve the server information on subnet B,
and vice versa. For more information, see Section 1.4.1.2, "Server Discovery Across
Subnets".

To invoke the Oracle Reports bridge, refer also to Section 2.2, "Starting and Stopping
the Oracle Reports Bridge".

<!l--
Copyright 2005 Oracle Corp.
500 Oracle Parkway, Redwood Shores, CA 94065, U.S.A. All rights reserved.
This is the DTD defining the Reports Bridge Version 10g Configuration file
(XML) format/syntax.
-——>
<!ELEMENT bridge (networkConfig?,
identifier?,
trace?,
remoteBridges? ) >
<!ATTLIST bridge

version CDATA #REQUIRED
port CDATA #REQUIRED
timeout CDATA #REQUIRED>

<!ELEMENT networkConfig EMPTY>
<!ATTLIST networkConfig
file CDATA #REQUIRED>

<!ELEMENT identifier (#PCDATA)>
<!ATTLIST identifier
confidential (yes|no) "yes"
encrypted (yes\no) "no" >

<!ELEMENT remoteBridges (remoteBridge*)>

<!ELEMENT remoteBridge EMPTY>
<!ATTLIST remoteBridge
host CDATA #REQUIRED
port CDATA #REQUIRED>
<!ELEMENT trace EMPTY>
<!ATTLIST trace

traceFile CDATA #IMPLIED
traceOpts (trace_err|trace_inf|
trace_dbg| trace_all) "trace_all"
traceMode (trace_replace\trace_append) "trace_replace">

The bridgeconf . dtd file provides the following elements for configuring the
bridge, used to discover the server across subnets:

= bridge
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= networkConfig
= identifier

= remoteBridges
= remoteBridge

m frace

3.3.2.1 bridge

Example
<bridge version="10.1.2" port="specify Port in reserved range" timeout="12000">
<!--networkConfig file="rwnetwork.conf" ></networkConfig-->
<!--identifier encrypted="no"
confidential="yes">%USERNAMES%/$PASSWORD%</identifier-->
<!--trace traceOpts="trace_all"></trace-->
<!-- Specify one or more remote bridges inside remoteBridges element -->
<!--remoteBridges>
<remoteBridge host="%HOST%" port="$PORT%"></remoteBridge>
</remoteBridges-->
</bridge

Required/Optional

Required. You can have a maximum of one open tag and one close tag in the bridge
element in a given configuration file.

Description

The bridge element opens and closes the content area of the bridge configuration file.
In terms of the file's hierarchy, all the other elements are subordinate to the bridge
element.

The bridge element attributes are described in Table 3-26.

Table 3-26 Attributes of the bridge element

Attributes Valid Values Description
version 10.1.2 The bridge version.
port The allotted The port on which
range for the bridge will listen.
Oracle Reports
bridge
component;
that is, 14011 to
14020.
timeout 1000 Value in milliseconds

(ms). The bridge will
wait for this period
for a response from a
remote bridge.

3-42 Oracle Application Server Reports Services Publishing Reports to the Web



Configuring the Reports Server Discovery Mechanism

Note: The default port value for the bridge configuration file is
assigned when you install Oracle Application Server. The rwbridge
template file contains this default port, which is used to generate the
configuration file for the bridge. The configuration file name for the
bridge named mybridge is repbrg_mybridge.conf.

If you need to customize the port number for the bridge, you must
specifiy a valid port range reserved for the Oracle Reports bridge
(14011 to 14020).

3.3.2.2 networkConfig

For information on the networkConfig element, refer to Section 3.2.1.8,
"networkConfig".

3.3.2.3 identifier

Example

<identifier confidential="yes"
encrypted="yes">fpoiVNFvnlkjRPortn+sneU88=NnN</identifier>

Required / Optional

Optional. If this element is commented, then the Oracle Reports bridge will not
perform a security check when the bridge shutdown command is issued.

Description

The identifier element ensures that the Oracle Reports bridge performs a security
check before shutting down.

To set the value of the identifier element:
1. Uncomment the identifier element in the bridge configuration file.

2. Set the value to the adminstrator username/password, set the attribute
encrypted=no, and set confidential=yes so that the username/password
will be encrypted when the Oracle Reports bridge is restarted.

For example:

<identifier encrypted="no" confidential="yes">scott/tiger</identifier>

3. Start the bridge.

Once this element is set, only the administrator will be able to shut down the bridge by
specifying the username/password in the command line.

See Also: Section 2.2.2, "Starting and Stopping the Oracle Reports
Bridge from the Command Line"

3.3.2.4 remoteBridges
Example
<remoteBridges>

value. ..
</remoteBridges>
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Required/Optional

Optional. If this entry is not specified, then this bridge will not contact any remote
bridge to get a Reports Server reference. However, remote bridges can contact this
bridge to get the references of Reports Servers running in this subnet.

Description

The remoteBridges element can contain zero or more remoteBridge elements.

3.3.2.5 remoteBridge

Example

<remoteBridge host='myhost.mydomain.com' port='14022'></remoteBridge>

Required/Optional

Optional. You can have one or more remoteBridge elements in your bridge

configuration file.

Description

The remoteBridge element specifies the host and port on which remote bridges are

running.

Figure 3—1 Oracle Reports Bridge Configuration (Two-Way)
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repbrg_bridgel .conf
<bridge version="10.01.2" port="14011"
timeout="2000">
<remoteBridges>
<remoteBridge host="host2.dom2|com"
PoOrt="14012"></remoteBridge>

repbrg_bridge2.conf
<bridge version="10.01.2" port="14012"
timeout="2000">
<remoteBridges>
<remoteBridge host="hostl.doml|com"
POrt="14011"></remoteBridge>

</remofeBridges>

</remoteBridges>

</bridge>

</bridge>

If you specify the optional remoteBridge element(s) in the repbrg_
bridgename.conf, then the bridge will act as a two-way bridge. That is, the bridge
can get server references from remote bridges.
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Figure 3—2 Oracle Reports Bridge Configuration (One-Way)
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repbrg_bridgel.conf
<bridge version="10.01.2" port="14011"
timeout="2000">
<remoteBridgess>
<remoteBridge host="host2.dom2.com"
port="14012"></renctebridge>

repbrg_bridgeZ.conf
<bridge version="10.01.2" port="14012"
timecut="2000">

<remoteBridges>

</remoteBridges>
</bridge>

</remofeBridges>
</bridge>

If you do not specify the optional remoteBridge element(s) in the repbrg_
bridgename.conf, then the bridge will act as a one-way bridge. That is, the bridge
can only serve remote bridges. It cannot connect to remote bridges to get the server
reference.

The remoteBridge element attributes are described in Table 3-27.

Table 3-27 Attributes of the remoteBridge element

Attributes Valid Values = Description
host Host name/IP  The host name
address of the  or the IP address
remote bridge. of the machine
where the
remote bridge is
running.
port Port number of The portnumber
the remote of the remote
bridge. bridge element.
3.3.2.6 trace

For information on the trace element, refer to Section 3.2.1.13, "trace".

3.4 Configuring Reports Servlet

You can configure Reports Servlet (rwservlet) in the servlet configuration file,
rwservlet.properties, located in the following path on both Windows and UNIX:

ORACLE_HOME\reports\conf\rwservlet.properties

Use rwservlet.properties for:

= Specifying the Location of the Key Map File
= Reloading the Key Map File

» Hiding Web Command Output
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= Selecting Login Dialog Boxes

s Setting Up Trace Options for Reports Servlet and JSPs

= Specifying the rwservlet Character Encoding to Decode Reports Parameters

s Disallowing HTML Code Specified in the URL from Being Executed in a Browser
= Specifying the Pool Size for Concurrent Connections to rwservlet

s Customizing the Appearance of Server Error Messages

= Specifying an In-process Server

= Identifying the In-process Server

= Pointing to Dynamically Generated Images

= Setting Expiration for Database and System Authentication Cookies

= Setting an Encryption Key for the Database and System Authentication Cookies
= Adding Formatting to Diagnostic and Debugging Output

s Defining the rwservlet Help File

= Specifying the Use of OracleAS Single Sign-On

= Specifying the Network Configuration File

= Migrating OracleAS Forms Services Applications that Include a Reports Server
Cluster Name

You can also use an alternate configuration file to configure Reports Servlet if you
specify the alternate file name as described in:

»  Specifying an Alternate Reports Servlet Configuration File
The entries in the configuration file are not case-sensitive.

For Windows, note that rwservlet.properties uses double backslashes (\\)
instead of single backslashes to specify a directory path. The first slash "escapes" the
second, which would otherwise have another meaning in this file. For example, in a
Windows-based rwservlet.properties file, the path:

d:\orawin\reports\conf\filename.ext

becomes:

d:\\orawin\\reports\\conf\\filename.ext

For UNIX, use that platform's standard for specifying directory paths, for example:

orawin/reports/conf/filename.ext

Table 3-28 provides an alphabetic list of the parameters you can define in the Reports
Servlet configuration file, along with a reference to the section in which each
parameter is described.

Table 3-28 Reports Serviet Configuration parameters

Parameter See

ALLOWHTMLTAGS  Section 3.4.7, "Disallowing HTML Code Specified
in the URL from Being Executed in a Browser"

CONNECTION_ Section 3.4.8, "Specifying the Pool Size for
POOLSIZE Concurrent Connections to rwservlet"
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Table 3-28 (Cont.) Reports Serviet Configuration parameters

Parameter See

COOKIEEXPIRE  Section 3.4.13, "Setting Expiration for Database
and System Authentication Cookies"

DBAUTH Section 3.4.4, "Selecting Login Dialog Boxes"

DEFAULTCHARSET Section 3.4.6, "Specifying the rwservlet Character
Encoding to Decode Reports Parameters”

DIAGBODYTAGS Section 3.4.15, "Adding Formatting to Diagnostic
and Debugging Output”

DIAGHEADTAGS Section 3.4.15, "Adding Formatting to Diagnostic
and Debugging Output”

DIAGNOSTIC Section 3.4.3, "Hiding Web Command Output"

ENCRYPTIONKEY Section 3.4.14, "Setting an Encryption Key for the
Database and System Authentication Cookies"

ERRORTEMPLATE  Section 3.4.9, "Customizing the Appearance of
Server Error Messages"

HELP Section 3.4.16, "Defining the rwservlet Help File"

IMAGE_URL Section 3.4.12, "Pointing to Dynamically Generated
Images"

KEYMAPFILE Section 3.4.1, "Specifying the Location of the Key

RELOAD_KEYMAP

REPORTS_

NETWORK_CONFIG

REPORTS_
SERVERMAP

SERVER
SERVER_IN_
PROCESS

SINGLESIGNON

SYSAUTH

TRACEFILE

TRACEMODE

TRACEOPTS

Map File"
Section 3.4.2, "Reloading the Key Map File"

Section 3.4.18, "Specifying the Network
Configuration File"

Section 3.4.19, "Migrating OracleAS Forms
Services Applications that Include a Reports
Server Cluster Name"

Section 3.4.11, "Identifying the In-process Server"

Section 3.4.10, "Specifying an In-process Server"

Section 3.4.17, "Specifying the Use of OracleAS
Single Sign-On"

Section 3.4.4, "Selecting Login Dialog Boxes"

Section 3.4.5, "Setting Up Trace Options for
Reports Servlet and JSPs"

Section 3.4.5, "Setting Up Trace Options for
Reports Servlet and JSPs"

Section 3.4.5, "Setting Up Trace Options for
Reports Servlet and JSPs"

3.4.1 Specifying the Location of the Key Map File

Your report runtime command line may include information you do not want to
expose to your users. Additionally, it may be comprised of a long string of options that
is difficult to remember or makes for an ungainly URL.

You have the option of entering a report's command line options in a key map file
(cgicmd.dat), then limiting the exposed runtime command to the name of the
particular key section in this file that holds the required options.
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The key map file is discussed in Chapter 13, "Running Report Requests". Use
rwservlet.properties to list the location of this file.

For example:

KEYMAPFILE=d: \\orawin\\reports\\conf\\cgicmd.dat

This example uses the default filename and location. An entry for the location and
filename of the key map file doesn't appear, by default, in rwservlet.properties
because the servlet already knows what to look for and where to look for it. If you use
a file with a different name or different location, you must include a KEYMAPFILE
parameter in rwservlet.properties that includes the directory path and filename.

3.4.2 Reloading the Key Map File

Use the RELOAD_KEYMAP parameter to specify whether the key map file
(cgicmd.dat) should be reloaded each time rwservlet receives a request.

For example:

RELOAD_KEYMAP=YES

This is useful if you frequently make changes to the map file and want the process of
loading your changes to be automatic. Runtime performance will be affected according
to how long it takes to reload the file.

Typically, this parameter is set to NO in a production environment and YES in a testing
environment.

3.4.3 Hiding Web Command Output

You may want to provide an authentication mechanism for an unsecured Reports
Server so that only an administrator (based on the authid) can run a Web command,
like showenv, showjobs, and so on. By setting DIAGNOSTIC=NO in the
rwservlet.properties file, you can provide just such an authentication
mechanism. This authentication information is also used for administrative tasks, for
example, stopping the Reports Server from the command line.

Note: Setting DIAGNOSTIC=NO only works for non-secured
Reports Server. For secure Reports Server users, Reports Server
verifies the user's privileges based on the entries in Oracle Internet
Directory.

To disable Web command display for an unsecured Reports Server
1. Start a Reports Server.
2. Set DIAGNOSTIC=NO in the rwservlet .properties file.

3. Access the Reports Server from rwservlet by using any of the Web commands;
for example, getserverinfo. You must pass an authid here.

For example:

http://yourwebserver:portnum/reports/rwservlet/getserverinfo?server=aks+authid=
scott/tiger
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Note: The Reports Server will save this authid in the following
directory: ORACLE_HOME/reports/conf/server name.conf
file under the <identifier> element. The <identifier>
element is set in the Reports Server configuration file by the first
Web command call if it is not defined in the server configuration
file and the values are automatically encrypted when the Reports
Server is started. The format to preset the <identifier> element
in the Reports Server configuration file is:

<identifier confidential="yes"
encrypted="no">username/password</identifier>

The clear text of username and password will be encrypted by
Reports Server once it starts up, and the encrypted attribute is
changed to yes to indicate the content is encrypted.

For more information on the <identifier> element, see
Section 3.2.1.19, "identifier".

Now, any access to the Reports Server for using the Web commands will have to
pass the same authid. If the authid is not passed, then you will get the
following error:

REP-52262: Diagnostic output is disabled.

To modify the administrator user name or password:
1. Open the Reports Server configuration file (server_name.conf).
2, Modify the <identifier> element:

<identifier encrypted="no"confidential="yes">

admin_name/admin_password</identifier>

Tip: You can specify the administrator username/password in
the <identifier> element in the rwserver. template file. This
ensures that you can pass the same authid for any Reports Server
that you start up.

3.4.4 Selecting Login Dialog Boxes

The servlet configuration file offers a number of parameters dealing with templates for
userid /password dialog boxes that should open when a user logs in to a database or
runs a secure report. Generally, these parameters point to various templates to be used
for setting up your login screens. You can customize these templates with your
company logo, linked buttons, or any other HTML you care to use.

The DBAUTH and SYSAUTH parameters are for specifying the location and filename of
the HTML templates to be used for individual login screens. By default, the file names
are rwdbauth.htmand rwsysauth.htm, respectively.

For example, the following entry points to the template for the database login screen:

DBAUTH=rwdbauth.htm

SYSAUTH points to a login screen for a secure report. For example:

SYSAUTH=rwsysauth.htm
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It isn't necessary to enter the path to a template when it is stored in the default
template directory:

ORACLE_HOME\reports\templates

3.4.5 Setting Up Trace Options for Reports Servlet and JSPs

Tracing in OracleAS Reports Services provides for logging of many different types of
runtime information on various OracleAS Reports Services components, as described
in Section 20.1.2, "Report Trace".

To track and log runtime information on Reports Servlet (rwservlet) and JSPs, use
the TRACEOPTS parameter in rwservlet.properties. You can enter from zero to
multiple trace options. Separate each option with a vertical bar.

For example:

TRACEOPTS=trace_prf |trace_pls|trace_dbg

All available trace options are listed and described in Table 3-14.

Additionally, you can use the TRACEFILE and TRACEMODE parameters. Use
TRACEFILE to specify the filename of the trace file. For example:

TRACEFILE=myrwservlet.trc

The default name is rwservlet. trc. If no path is specified, the trace file will be in
the following directory on both Windows and UNIX:

ORACLE_HOME\reports\logs\machine_name

In the rwservlet.properties configuration file, use a separate line for each
option. For example:

TRACEOPTS=TRACE_ALL
TRACEFILE=rwservlet.trc
TRACEMODE=TRACE_REPLACE

Use TRACEMODE to define whether new trace information will either overwrite the
existing trace file (trace_replace), or be added to the end of the trace, leaving
existing trace information intact (trace_append). TRACEMODE replaces or appends to
the tracing information that has accumulated since the startup of the Oracle
Application Server Containers for J2EE container that contains rwservlet. For
example:

TRACEMODE=trace_append

The default for TRACEMODE is trace_replace.

3.4.6 Specifying the rwservlet Character Encoding to Decode Reports Parameters

You can specify non-ASCII escaped characters in the request URL or non-ASCII
characters in the Parameter Form input. You must specify the character encoding in
the rwservlet.properties file before you can apply it. This is to ensure that
rwservlet uses the required encoding when decoding the parameter name and
value.

You can set the value of DEFAULTCHARSET in the rwservlet .properties file to
either:

s The database's NLS_CHARACTERSET (for example, JA16EUC).
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»  The IANA-defined character set (for example, EUC-JP).

Example
DEFAULTCHARSET=JA16EUC

Note: To use non-ASCII characters in user parameter names and
values when using the Event-Driven Publishing API, you must
ensure that the DEFAULTCHARSET specified in the
rwservlet.properties file matches the value of the
DEFAULTCHARSET parameter in your parameter list. For more
information, see Section 17.1.3, "Including non-ASCII Characters in
Parameter Names and Values".

3.4.7 Disallowing HTML Code Specified in the URL from Being Executed in a Browser

Any HTML code included as part of the report request URL might lead to a security
compromise as it causes certain browsers to execute any script or code in the URL.
Thus, HTML code is not allowed as part of the URL command.

To disallow HTML code as part of the URL command, use the ALLOWHTMLTAGS
property in rwservlet.properties. This property is set to NO by default,
disallowing any HTML code to be entered in the URL when running a report.

Valid Values
s YES Allows HTML code in the URL.

Note: Setting ALLOWHTMLTAGS=YES allows malicious HTML code
to be executed by certain browsers.

=  NO Disallows any HTML code in the URL.

Default
NO

3.4.8 Specifying the Pool Size for Concurrent Connections to rwservlet

You may want to define the number of users who can connect and submit job requests
simultaneously to rwservlet. To do so, you must set the value of the CONNECTION_
POOLSIZE property in the rwservlet.properties file.

Default Value
500

Minimum Value
0 (not recommended)

Set the value of CONNECTION_POOLSIZE keeping in mind the number of active users
expected to make concurrent job requests. For example, set this value to 250 if you
expect around 100 concurrent active users.
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Note: The value set (for example, 100) is the number of active users
simultaneously making job requests and not the number of users
connected to the system without submitting requests.

3.4.9 Customizing the Appearance of Server Error Messages

OracleAS Reports Services provides a template for server error messages. These
messages are generated automatically, according to cause. The template provides the
visual setting within which the error message is displayed.

You may wish to customize the appearance of error messages, for example with your
company logo, or with an icon you plan to associate with errors. You may wish to add
buttons that link your users to a help system, your company home page, or back to the
last browser window. You can do this by providing your own HTML framework for
automatically generated error messages.

The ERRORTEMPLATE property in rwservlet .properties specifies the name and
location of your error message template.

By default, the entry is:

ERRORTEMPLATE=rwerror.htm

It is not necessary to enter the path to the error message template when it is stored in
the default template directory:

ORACLE_HOME\reports\templates

The character set of the error message template (rwerror .htm)is iso-8859-1 to

ensure consistency across all platforms. In earlier releases, it was windows-1252,
which is a character set specific to the Windows platform.

3.4.10 Specifying an In-process Server

If you choose to run Reports Server within the same process as Reports Servlet
(rwservlet), you specify the following in rwservlet.properties:

SERVER_IN_PROCESS=YES

Specify SERVER_IN_PROCESS=NO if you do not want Reports Server to run within
the same process as Reports Servlet.

Note: The pros and cons of running an in-process server are
explored in Chapter 1, "Understanding the OracleAS Reports
Services Architecture".

For the in-process server specification when configuring Reports Server through
OPMN, see Section 3.7.1.3, "In-process Reports Server Specification".

For troubleshooting printing and font issues when using the in-process server, see
Section D.1.11, "Printing and Font Errors When Using In-process Server".

3.4.11 Identifying the In-process Server

Reports Servlet (rwservlet) uses the SERVER parameter value as the name of the
in-process server. If a Reports Server name is not specified, for example, in the runtime
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URL, rwservlet starts the in-process server (if not started already) with the name
specified by the SERVER parameter, and submits the job to it.

In AS installations, the Oracle Reports configuration tool sets the value the SERVER
parameter in the rwservlet.properties file as follows:

SERVER=rep_hostname_oraclehomename

You can change the in-process server name by setting the SERVER parameter to a
different name in the rwservlet .properties file:

SERVER=server_name

If the SERVER parameter in rwservlet.properties is not set, the default
in-process server name in both AS and DS installations is: rep_hostname.

When SERVER_IN_PROCESS=NO, rwservlet will try to bind to an external server
with the name specified by the SERVER parameter.

3.4.12 Pointing to Dynamically Generated Images

Optionally, you can use the IMAGE_URL parameter to specify where the reports'
dynamically generated images can be accessed.

For example:

IMAGE_URL=http://server_or_web_server_name.domain_name:port/reports/rwservlet

This parameter is in place for JSPs that do not run through Reports Servlet. It ensures
that dynamically generated images, such as charts, will be viewable only by the person
who runs the report. JSPs, and other report types, that run through Reports Servlet
have this protection automatically.

3.4.13 Setting Expiration for Database and System Authentication Cookies

Use the COOKIEEXPIRE parameter to set the lifetime (in minutes) of the database and
system authentication cookie. For example:

COOKIEEXPIRE=20

The default is 30.

Cookies save encrypted user names and passwords on the client-side when users first
authenticate themselves. When the server receives a cookie from the client, the server
compares the time saved in the cookie with the current system time. If the time is
longer than the number of minutes defined in COOKIEEXPIRE, the server rejects the
cookie and returns to the client the authentication form along with an error message.
Users must re-authenticate to run the report.

3.4.14 Setting an Encryption Key for the Database and System Authentication Cookies

Use ENCRYPTIONKEY to specify the encryption key to be used to encrypt the user
name and password of the database and system authentication cookies. The
encryption key can be any character string. For example:

ENCRYPTIONKEY=egbdf
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3.4.15 Adding Formatting to Diagnostic and Debugging Output

The DIAGBODYTAGS and DIAGHEADTAGS parameters are available for including
additional HTML encoding in the <body> and <head> tags in the output files
associated with diagnostic and debugging output.

DIAGBODYTAGS defines the entire <body> tag; while DIAGHEADTAGS defines tags to
appear between the open and close <head> and </head> tags.

You can use these to include formatting options to make diagnostic and debugging
output easier to read. For example:

DIAGBODYTAGS=<BODY>additional HTML encoding</BODY>

DIAGHEADTAGS=<HEAD>additional HTML encoding</HEAD>

3.4.16 Defining the rwservlet Help File

A HELP keyword is available with the rwservlet command for bringing up a
servlet-related help topic. The help file is invoked when you specify the following
URL:

http://your_web_server/your_servlet_path/rwservlet/help

Note: For more about the HELP keyword, see Section A.3.42,
"HELP".

We provide a default help file for the servlet, ORACLE_
HOME\reports\templates\help.htm, which will be displayed if you leave this
parameter undefined. You may want to supply a help file of your own. To do this,
specify the name and location URL of your servlet help file with the HELPURL
parameter in rwservlet.properties. For example:

HELPURL=http://your_web_server/your_help file path/helpfile.htm

3.4.17 Specifying the Use of OracleAS Single Sign-On

If you plan to take advantage of OracleAS Reports Services' Single Sign-On capability,
you must ensure the SINGLESIGNON parameter is set to YES in
rwservlet.properties. SINGLESIGNON=YES by default upon installation.

For more information, refer to Section 11.3.1, "Enabling and Disabling OracleAS Single
Sign-On".

3.4.18 Specifying the Network Configuration File

By default, Reports Servlet uses the rwnetwork. conf file to decide on the discovery
mechanism it will use. If you want to use a custom network configuration file, set the
REPORTS_NETWORK_CONFIG property in rwservlet.properties toavalid
network configuration file name in the ORACLE_HOME/reports/conf directory. For
example:

REPORTS_NETWORK_CONFIG=net3.conf
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3.4.19 Migrating OracleAS Forms Services Applications that Include a Reports Server
Cluster Name

In Oracle Reports 10g Release 2 (10.1.2), Reports Server clustering is deprecated. An
OracleAS Forms Services application from prior releases that includes a Reports Server
cluster name will fail to bind to the Reports Server cluster it references.

To resolve this issue, Oracle Reports 10g Release 2 (10.1.2) introduces REPORTS_
SERVERMAP, which enables you to map a cluster name to a Reports Server name. This
avoids the necessity to change the cluster name in all OracleAS Forms Services
applications.

An OracleAS Forms Services application can call Oracle Reports in the following ways:

s Using RUN_REPORT_OBJECT. If the call specifies a Reports Server cluster name
instead of a Reports Server name, the REPORTS_SERVERMAP environment
variable must be set in the OracleAS Forms Services default . env file. For more
information, see the Oracle Application Server Forms Services Deployment Guide.

» Using WEB. SHOW_DOCUMENT. In this case, the request is submitted to rwservlet.
If the call specifies a Reports Server cluster name instead of a Reports Server name,
the REPORTS_SERVERMAP parameter must be set in the
rwservlet.properties file. For example:

REPORTS_SERVERMAP=cluster: repserver

where

clusteris the Reports Server cluster name that was present in prior releases
(Oracle Reports 9i and 10g Release 1 (9.0.4)).

repserver is the Reports Server name in the Oracle Reports 10g Release 2
(10.1.2).

When REPORTS_SERVERMAP is set in rwservlet.properties, any request to
cluster in the OracleAS Forms Services application is redirected to repserver.

3.4.20 Specifying an Alternate Reports Servlet Configuration File

By default, Reports Servlet uses the rwservlet.properties file as the
configuration file. If you are running multiple OC4]J instances with reports installed on
the same Oracle Application Server and wish to use different configuration files, you
can do so by adding the following start parameter to opmn . xm1:

-DServletPropFile =your servlet_properties_file

For example:
<process-type 1d="0C4J_BI_Forms" module-id="0C4J">
<category id="start-parameters">
<data id="java-options" value="-server -Djava.security.policy
=/private/oracle/FRHome_1/j2ee/0C4J_BI_Forms/config/java2.policy
-Djava.awt.headless=true -Xmx512M" -DServletPropFile=servlet.prop/>

<data id="oc4j-options" value="-properties -userThreads "/>
</category>

Alternatively, you can edit the web . xm1 file for Oracle Reports and add the
initparam to pass the servlet.properties file name.

For example:

<servlet>
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<servlet-name>Reports servlet - /reports/rwservlet</servlet-name>
<servlet-class>oracle.reports.rwclient.RWClient</servlet-class>
<load-on-startup>1</load-on-startup>
<init-param>
<param-name>ServletPropFile</param-name>
<param-value>myservlet.prop</param-value>
</init-param>
</servlet>

3.5 Configuring the URL Engine

Reports Server includes a URL engine that can take the contents of any URL and
distribute them. The URL engine enables you to leverage the powerful scheduling and
distribution capabilities of Reports Server to distribute content from any publicly
available URL to various destinations such as e-mail, OracleAS Portal, and WebDAV.
Since Reports Server's destinations are pluggable, you can also add your own custom
destinations for the URL content.

Furthermore, if you use the URL engine in conjunction with Reports Server's
event-based APls, database events can trigger the content distribution. For example,
suppose you have created a JSP report for high fidelity Web publishing of data stored
in a table containing employee expense data. You could then use the URL engine and
the event-based API to e-mail that JSP whenever the expense application stores new or
updated employee expense data in the table.

If the URL engine is not activated, you can activate it by doing the following:

1. Add an engine element for the URL engine to the server configuration file. For
example, your engine element might be as follows:

<engine id="rwURLEng"
class="oracle.reports.engine.URLEngineImpl"
initEngine="1"
maxEngine="1"
minEngine="0"
engLife="50"
maxIdle="30"
callbackTimeOut="60000"
/>

2. Add ajob element that associates the appropriate job types with the URL engine to
the server configuration file. For example, your job element might be as follows:

<job jobType="rwurl" engineId="rwURLEng"/>

3. Stop and restart Reports Server.

Note: When you restart your Reports Server with these new
elements, you should see the number of engines increase
accordingly in the Reports Server status message box. In the
preceding example, the number of engines would increase by one
(the value of initEngine) when you restart Reports Server.

To learn about sending requests to the URL engine, refer to Chapter 13, "Running
Report Requests".
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3.6 Entering Proxy Information

Some features of OracleAS Reports Services support retrieving or sending information
through a firewall. For example, the URL engine, the XML data source, the Text data
source, and the mail destination features all retrieve or send information through the
firewall. For these features to function properly, Reports Server requires certain proxy
information. In the interests of simplicity, you store the necessary proxy information in
a single location and point to it from the Reports Server configuration file. To
configure your Reports Server with proxy information, you do the following:

1. Add the pluginParam element to the server configuration file and have it point to
the proxy information file (for example, proxyinfo.xml). For example, your
pluginParam element might be as follows:

<pluginParam name="proxy" type="file">proxyinfo.xml</pluginParam>

Note: You can optionally specify a path for the proxy information
file. By default, this file is located in ORACLE_
HOME/reports/conft.

2. Update the proxy information file with the necessary proxy values for your
configuration. For example, proxyinfo.xml might contain the following:

<proxyInfo>
<proxyServers>
<proxyServer name="xyz.abc.com" port="80" protocol="http"/>
<proxyServer name="www-proxyl.xyz.abc.com" port="80" protocol="ftp"/>
<proxyServer name="www-prox2l.xyz.abc.com" port="80" protocol="https"/>
</proxyServers>
<bypassProxy>
<domain>*.abc.com</domain>
</bypassProxy>
</proxyInfo>

Note: Refer to the default proxy information file, ORACLE_
HOME/reports/conf/proxyinfo.xml, for additional
information.

3.7 Configuring Reports Server with the Oracle Process Manager and
Notification Server and Oracle Enterprise Manager 10g

The best way to start, shut down, monitor, and manage Reports Server is through the
Oracle Process Manager and Notification Server (OPMN) and Oracle Enterprise
Manager 10g. OPMN provides a centralized mechanism for initializing, maintaining,
and shutting down your Oracle Application Server components, including Reports
Server. Oracle Enterprise Manager 10g, included with Oracle Application Server,
provides managing and monitoring services to OracleAS Reports Services. You can
conveniently monitor your Reports Servers through Oracle Enterprise Manager 10g
and, if the process fails for any reason, OPMN restarts Reports Server for you
automatically.

During installation of Oracle Application Server, Reports Servers are automatically
configured in OPMN and registered with Oracle Enterprise Manager 10g. If you add
any Reports Servers after installing Oracle Application Server, you should register the
new server(s) in two places:
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s The Oracle Process Manager and Notification Server's opmn . xm1 file.
s The Oracle Enterprise Manager 10g's targets.xml file.

To register a new Reports Server in both opmn . xml and targets.xml, run the
following command line:

On UNIX:

ORACLE_HOME/bin/addNewServerTarget.sh reports_server_name

On Windows:

ORACLE_HOME\bin\addNewServerTarget.bat reports_server_name

Note: After running this command line, reload the OPMN
configuration file for the change to take effect (for example,
opmnctl reload).

3.7.1 opmn.xml

Components are configured with OPMN in the opmn . xm1 file located in ORACLE_
HOME/opmn/conf. To configure Reports Server through OPMN, you need the
following in opmn . xm1:

s Process Module
= Standalone Reports Server Specification
s In-process Reports Server Specification

= Oracle Reports Bridge Specification

See Also: For a detailed description of OPMN configuration and
the contents of opmn . xm1:

»  Oracle Application Server Administrator’s Guide

3.7.1.1 Process Module

The module tag is included by default in opmn.xml and tells OPMN to load a
particular module. In the case of Reports Server, the OracleAS Reports Services
module must be loaded. This module is loaded with the following information, by
default, in opmn . xm1:

<module path="/private/oraclehome/opmn/lib/libopmnreports">
<module-id id="ReportsServices"/>
</module>

3.7.1.2 Standalone Reports Server Specification

In the case of the standalone Reports Server, the Reports Server is running in its own
component. Therefore, you must specify a separate component for Reports Server. For
example:

<ias-component id="<RSName>" status="enabled" id-matching="false">
<process-type id="ReportsServer" module-id="ReportsServices">
<process-set id="<RSName>" restart-on-death="true" numprocs="1">
<environment>
<variable id="PATH" value="your_shell_path"/>
</environment>
<module-data>
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<category id="general-parameters">
<data id="batch" value="yes"/>
</category>
<category id="restart-parameters">
<data id="reverseping-timeout" value="120"/>
</category>
</module-data>
<dependencies>
<0ID infrastructure="true"/>
<database infrastructure-key="portal"/>
<managed-process ias-component="0C4J" process-type="0C4J_BI_Forms"
process-set="default_island" autostart="true"/>
<managed-process ilas-component="HTTP_Server"
process-type="HTTP_Server" process-set="HTTP_Server"
autostart="true"/>
<managed-process ias-component="WebCache" process type="WebCache"
process_set="WebCache" autostart="true"/>
</dependencies>
<start timeout="600" retry="2"/>
<stop timeout="120"/>
<restart timeout="600"/>
<ping timeout="30" interval="30"/>
</process-set>
</process-type>
</ias-component>

Note: The timeout values in the preceding example are all in
number of seconds.

The key segments of this specification for Oracle Reports are described below.
<ias-component id="<RSName>" ...>

This tag specifies the name of Reports Server. It must match the Reports Server
internal name from targets.xml.

See Also: Chapter 19, "Managing and Monitoring OracleAS
Reports Services" for more information on targets.xml.

<process-type id="ReportsServer" module-id="ReportsServices">

This tag defines the process for the named Reports Server and associates it with the
OracleAS Reports Services process module.

<process-set id="<RSName>" restart-on-death="true" numprocs="1">

This tag defines the process characteristics for the named Reports Server. It indicates
whether Reports Server should be restarted when it fails. It also specifies the number

of Reports Servers started for this process set, which has to be 1 because the
process-set id identifies a single Reports Server name.

<variable id="PATH" value="your_shell_path"/>
The first tag specifies the value for the PATH environment variable for the process. This

variable must be set for the start script to find uname. This environment element is not
needed on the Microsoft Windows platform.

<category id="general-parameters">
<data id="batch" value="yes"/>
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</category>

This group of tags gathers together all of the data (parameters) common to the process.
In this particular example, it provides a way to specify that the BATCH parameter be
sent to Reports Server. batch=yes | no is an option to the start and stop commands of
Reports Server. If it is not configured, this option is not passed in to Reports Server.

<category id="restart-parameters">
<data id="reverseping-timeout" value="120"/>
</category>

This group of tags indicates the restart parameters category, which defines parameters
to be used in detecting whether the process has failed and needs to be restarted. If a
notification is not received within the specified reverseping-timeout period, then
the process is considered failed and will be restarted.

<dependencies>

This tag delimits the list of components upon which Reports Server depends. For
example, Reports Server typically depends upon, among other things, the Oracle
HTTP Server and Oracle Application Server Containers for J2EE.

OPMN uses dependencies to determine whether to start a process. Like
module-data and environment blocks, dependencies blocks can be defined for
multiple elements within opmn . xm1. OPMN creates an aggregate dependency list at
the process set level that contains all of the dependencies defined at or above it. If
duplicate dependencies are defined at different levels, then duplicate checks on that
dependency are made before starting a process.

OPMN has two primary types of dependencies: external and internal. External
dependencies are resources not managed by OPMN (the database, Oracle Internet
Directory, and OracleAS Single Sign-On). For external resources, an external program
performs the check on the resource. Internal dependencies are OPMN-managed
processes, which may include processes managed by a remote OPMN instance.
Internal dependencies are indicated in the list by the managed-process tag.

OPMN maintains a cache of dependency states that contains the last known state of
each dependency and the time it was last checked. A single cache entry exists for each
dependency with identical attributes, even if that dependency is specified in multiple
locations (that is, for different process sets). A cache timeout parameter for each
dependency allows users to specify how long to use its state in the cache. Likewise, a
general timeout parameter for each dependency determines how long OPMN should
wait for a status update before aborting the dependency check and the process start.

Dependencies are checked in the order in which you declare them. The traversal of this
list of dependencies concludes either when the full sequence of checks completes
successfully (the resource is available) or when one of the checks fails (the resource is
not available or the check timed out).

The following example tags illustrate a typical list of dependencies for Reports Server:

<0ID infrastructure="true"/>

<database infrastructure-key="portal"/>

<managed-process ias-component="0C4J" process-type="0C4J_BI_Forms"
process-set="default_island" autostart="true"/>

<managed-process ilas-component="HTTP_Server"
process-type="HTTP_Server" process-set="HTTP_Server"
autostart="true"/>

<managed-process ias-component="WebCache"
process-type="WebCache" process-set="WebCache"
autostart="true"/>
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The 01D tag indicates that Reports Server uses the default Oracle Internet Directory
instance for this Oracle Application Server installation.

The database tag points to the OracleAS Portal instance used by Reports Server.

The first managed-process tag specifies the Oracle Application Server Containers
for J2EE instance used by Reports Server. The second managed-process tag
indicates the Oracle HTTP Server instance.

See Also: For more information on opmn . xm1 and its contents:

»  Oracle Application Server Administrator’s Guide

3.7.1.3 In-process Reports Server Specification

In the case of the in-process server, Reports Server is running inside the OC4]J
component. If you are using the in-process server, then within the OC4J component
you must specify the Reports Server data. For example:

<ias-component id="0C4J">
<process-type id="0C4J_BI_Forms">
<module-data>
<category id="urlping-parameters">
<data id="/reports/rwservlet/pingserver?start=auto" value="200"/>
</category>
</module-data>
<process-set .../>
</process-type>
</ias-component>

The key segments of this specification are:
= category specification:

<category id="urlping-parameters">

where

urlping-parameters is a category that identifies all of the URLs to be pinged
by the OC4J] module. The protocol used for pinging is AJPv1.3.

= data specification:

<data id="/reports/rwservlet/pingserver?start=auto" value="200"/>

where

/reports/rwservlet/pingserver?start=auto is the URL to be pinged by
the OC4] module. In the context of the in-process server, pinging this URL allows
OPMN to determine whether the Reports Server application is responsive. If it is
unresponsive, OPMN restarts the corresponding OC4]J process.
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Note: The pingserver command to Reports Servlet attempts to
start the in-process server. If Reports Server setup is not correct, it
fails to start the engine. This causes Reports Server to go into
deadlock and not send success status back to OPMN. OPMN
interprets this as a failure of the 0C4J_BI_FORMS instance and
attempts to restart this instance. To recover from this condition,
verify the Reports Server setup to make sure it is able to spawn
engines properly. For additional information, see Section 3.9,
"Optimizing the Deployment of Reports".

value="200" specifies a valid HTTP code (200) that is expected in response to
the ping request. If the response HTTP code matches the value configured here,
OPMN considers the application healthy and responsive. Otherwise, OPMN
restarts the OC4J process.

3.7.1.4 Oracle Reports Bridge Specification

The Oracle Reports bridge runs within its own component. Therefore, you must
specify a separate ias-component for the Oracle Reports bridge to control the bridge
through OPMN.

The following are examples for a minimum bridge configuration as well as a full
bridge configuration.

Example 3-1 Minimum Configuration for Oracle Reports Bridge

<ias-component id="your bridge name" status="enabled" id-matching="false"
xmlns="http://www.oracle.com/ias-instance">
<process-type id="ReportsBridge" module-id="ReportsBridgeServices">
<process-set id="your_ bridge_name" restart-on-death="true" numprocs="1">
<environment>
<variable id="PATH" value="your_oracle_home_directory/jdk/jre/bin"
append="true" />
<variable id="PATH" value="your shell_path" append="true"/>
<variable id="CLASSPATH" value="your oracle_home directory
/jlib/zrclient.jar" append="true"/>
<variable id="CLASSPATH" value="your oracle_home directory
/reports/jlib/rwrun.jar" append="true"/>
</environment>
</process-set>
</process-type>
</ias-component>

Example 3-2 Full Configuration for Oracle Reports Bridge

<ias-component id="your_ bridge name" status="enabled" id-matching="false">
<process-type id="ReportsBridge"module-id="ReportsBridgeServices">
<process-set id="your_ bridge_name" restart-on-death="true" numprocs="1">
<environment>
<variable id="PATH" value="your shell_path" append="true"/>
<variable id="CLASSPATH" value="your_oracle_home directory
/jlib/zrclient.jar" append="true"/>
<variable id="CLASSPATH" value="your oracle_home directory
/reports/jlib/rwrun.jar" append="true"/>
</environment>
<module-data>
<category id="restart-parameters">
<data id="reverseping-timeout" value="120"/>
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</category>
<category id="start-parameters">
<data id="jvm-options" value="="-Xmsl28mb -Xmx256mb"/>
<data id="bridge-options" value="start_options_if_any"/>
</category>

<category id="stop-parameters">
<data id="jvm-options" value="-Xmsl28mb -Xmx256mb"/>
<data id="bridge-options" value="stop_options_if_any"/>
</category>
</module-data>
<start timeout="120" retry="3"/>
<stop timeout="120"/>
<restart timeout="120" retry="0"/>
</process-set>
</process-type>
</ias-component>

3.8 Configuring Oracle Reports to Communicate with Oracle Workflow

Oracle Workflow delivers a complete business process management system that
supports business process definition, business process automation, and business
process integration. The Oracle Workflow engine is part of the Oracle database. For
more information, refer to the Oracle Workflow 10g page on the Oracle Technology
Network (OTN) at
http://www.oracle.com/technology/products/ias/workflow/index.htm
1.

By integrating Oracle Workflow with Oracle Reports, you can include Oracle Reports
execution as one of the activities in your business process. For example, as soon as a
manager approves an expense report, Oracle Workflow generates a report.
Additionally, the report notifies the Oracle Workflow engine when the report
execution is complete, triggering the next activity in the business process.

For complete information about integrating Oracle Workflow with Oracle Reports,
refer to the Integrating Oracle Workflow with Oracle Reports white paper on OTN
(http://www.oracle.com/technology/products/reports/features/work
flow). This white paper explains how to install and configure Oracle Workflow and
Oracle Reports to communicate with each other, and also provides the steps to include
report-specific functions in your business process. Specifically, it covers installing and
configuring Oracle Reports and Oracle Workflow, defining an Oracle Workflow
process for running a report, running a report from the Oracle Workflow process, and
troubleshooting assistance.

3.9 Optimizing the Deployment of Reports

Before you deploy a report on a machine that is either slow or is running on a load,
you may want to configure the following:

= Ping timeout (OPMN-side): Ping timeout is the measure that OPMN uses to
determine the time that it must wait for a callback from an in-process Reports
Server (in 0OC4J_BI_FORMS) before considering it as a timeout.

The default timeout period is 150. This period is calculated from: ping timeout,
ping interval, and number of retries. The default values for these are:

ping timeout = 30 seconds
ping interval = 20 seconds
number of retries - 3
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Note: The number of retries isapplicable only when OPMN
successfully connects to OC4] and receives regular ONS notifications
from the process.

Based on these values, there will be three ping attempts with a timeout of 30
seconds each at 20 second intervals. The first ping is done after the specified ping
interval. Thus, from the time the OC4] is started by OPMN, approximately 150
(20 + 3*30 + 2*20) seconds will elapse before the process is considered
unresponsive and restarted. However, if after OPMN connects to OC4J but OC4J is
too slow in sending regular ONS notifications, then the 30 second timeout applies.

You can configure the ping timeout by adding a ping entry with sufficient timeout
configured to the machine's load in following element in opmn . xm1:

<ias-component id="0C4J">
<process-type 1d="0C4J_BI_Forms" module-id="0C4J">
<restart timeout="720" retry="2" />

<ping timeout="110" interval="30" />

You can also switch off the URL ping by removing or commenting out the
following element in opmn . xm1:

<category id="urlping-parameters">
<data id="/reports/rwservlet/pingserver?start=auto" value="200" />
</category>

Then, restart 0C4J_BI_Forms.

m  Report Server start or restart timeout (OPMN . xm1): Start or restart timeout is the
measure that OPMN uses to determine the time that it must wait for Reports
Server process type to start or restart (process-type id="ReportsServer" in
opmn . xm1) before considering it as a timeout.

The default timeout period is 600. The default values for these are:

<start timeout="600" retry="2"/>

<restart timeout="600"/>

When running on a loaded machine, an attempt to start all Reports Servers by
OPMN may result in a start timeout for some Reports Servers as some of them
were not able to finish the start up activities completely. Note that Reports Server
also starts the number of engines specified in the initengine property of the
engine element in the server_name.config file. Starting up these engine
processes might take some time in loaded machines. In parallel to finetuning the
Reports Server process start or restart property, you must also finetune the
callbackTimeout property in server_name.config, as explained in the next
bullet item.

»  Callback timeout (Reports Server-side): Callback timeout is the measure that
Reports Server uses to determine the time that it must wait for a response from the
engine before timing out. You can specify this value in the server._
name . config file. This time out period is in milliseconds.

For example:

<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30" callbackTimeOut="90000">
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Note: Increase the callback timeout when the machine is very slow.

3.10 Removing DISPLAY and Printer Dependencies on UNIX

Prior to Oracle Reports 10g Release 1 (9.0.4) on UNIX, you had to set the DISPLAY
environment variable in order for Reports Server to use the windowing system display
surface for creating images and getting pixel resolution. This dependency is removed
with Oracle Reports 10g.

Additionally, earlier releases required a valid printer on UNIX for fonts. When no
valid printer was available, OracleAS Reports Services used the screen fonts, which
again required setting the DISPLAY environment variable. Now, OracleAS Reports
Services includes a default screen printer surface, ScreenPrinter, that emulates a screen
or printer for fonts in the absence of an available printer. As a result, OracleAS Reports
Services no longer requires a printer on UNIX.

By default, the environment variable REPORTS_DEFAULT_DISPLAY is set to YES,
which specifies that OracleAS Reports Services should:

= remove the dependency on the DISPLAY environment variable (UNIX only)

= use ScreenPrinter for surface resolution for images and font information (UNIX
only)

= enable the Advanced Imaging Support (all platforms)
If you wish to revert to the dependency on the DISPLAY environment variable as in
prior releases, you can set REPORTS_DEFAULT_DISPLAY=NO.

See Also: Section B.1.39, "REPORTS_DEFAULT_DISPLAY"

3.10.1 ScreenPrinter

The PostScript printer driver screenprinter . ppd provides surface resolution for
images and specifies font information. This driver is the first entry in
uiscreenprint. txt. The file locations (UNIX only) are:

uiscreenprint.txt : ORACLE_HOME/guicommon/tk/admin
screenprinter.ppd : ORACLE_HOME/guicommon/tk/admin/PPD

ScreenPrinter is used for:
»  Surface resolution when REPORTS_DEFAULT DISPLAY=YES.
= Removal of the printer dependency.

If, when generating report output, there is no valid printer queue available (not found
from TK_PRINTER, ORACLE_PRINTER, PRINTER, or uiprint.txt), the surface
based on screenprinter.ppd will be created and used to get font information. You
can modify the Fonts section of screenprinter.ppd to include new fonts, and
modify the DefaultResolution field to change the resolution
(DefaultResolution is 96).

Note: If you do add new fonts, ensure that the new AFM metrics
files are placed in the AFM directory.

The font look up algorithm on UNIX is:

if a valid printer available then
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look up font information from the printer
else
create a screenPrinter surface
look up font information from ScreenPrinter
if ScreenPrinter creation fails then
REP-1800 : Formatter Error if REPORTS_DEFAULT DISPLAY is set
else
use Screen Fonts

Note: In certain multibyte languages like Chinese, you may want
to use screen fonts. However, this would necessitate setting the
DISPLAY variable for running the report.

To revert to DISPLAY and use screen fonts (old font look up
algorithm):

s Set REPORTS_DEFAULT_DISPLAY=NO

= Remove the screenprinter.ppd entry in the
uiscreenprint. txt file.

See Also:
s Chapter 4, "Managing Fonts in Oracle Reports"
s Chapter 5, "Printing on UNIX with Oracle Reports"

3.10.2 Advanced Imaging Support

The quality of images contributes considerably to the overall appearance of a report,
particularly for a Web report. You may prefer different image formats in your report
output depending on the needs of your project. For example, an aeronautical firm
might prefer the higher quality of JPEG or PNG images in their Web reports instead of
GIF images. On the other hand, if you are building a Web portal, you might prefer GIF
images because of their smaller size and faster download. Similarly, you may wish to
import images of these various formats into your report.

Depending on the format of your output, you may choose from a variety of formats for
your images.

Table 3-29 Image Format Options by Output Type

Report Output Available Image Format Choices
HTML, HTMLCSS PNG, JPEG, JPG, GIF

PDF PNG, JPEG, JPG, GIF

RTF PNG, JPEG, JPG, BMP

Note: As you choose your image format, you should take into
account the quality and size considerations. Typically, the higher
the quality of the image format, the greater the size. For example,
PNG and JPEG are higher quality than GIF, but they may also
require more storage space.

To enable advanced imaging, you must set the REPORTS_DEFAULT_DISPLAY
environment variable to YES. The REPORTS_OUTPUTIMAGEFORMAT environment
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variable lets you choose the default image type. Users can override the default choice
for images with the OUTPUTIMAGEFORMAT command line keyword. For example:

rwclient server=my_rep_server report=images.rdf destype=file desformat=html
desname=images.html userid=scott/tiger outputimageformat=PNG

Enabling advanced imaging also enables you to import images of these same formats
into your report.

Usage Notes

UNIX only: Enabling advanced imaging means that you can no longer use the old
Computer Graphics Metafile (CGM) and Oracle Graphics Data (OGD) formats in
HTML or HTMLCSS output. If you require these formats for input sources, you
should set REPORTS_DEFAULT_DISPLAY=NO. This limitation does not apply on
the Windows platform.

Running a report with JPEG images (REPORTS_OUTPUTIMAGEFORMAT=JPEG) to
RTF output causes an increase in the RTF file size that is not directly proportionate
to the image size. This occurs because the binary image stream is first converted to
HEX characters and then written to RTF. This conversion increases the file size.
This is consistent with the RTF specification and is expected behavior. However,
an RTF file with JPEG images is of a smaller size when compared to an RTF file
with BMP images.

See Also:

= Section A.3.63, "OUTPUTIMAGEFORMAT"

= Section B.1.39, "REPORTS_DEFAULT_DISPLAY"

= Section B.1.51, "REPORTS_OUTPUTIMAGEFORMAT"
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Managing Fonts in Oracle Reports

This chapter provides information about fonts in Oracle Reports. In particular, it
covers the following sections:

= Using Fonts

= Adding Fonts

= Font Configuration Files

= Font Aliasing

= Troubleshooting Font Issues

= Font Types

4.1 Using Fonts
In Oracle Reports, fonts come into play:
= In Reports Builder, at build time
= In the report's output, at runtime

= In the user interface of Reports Builder

4.1.1 Fonts in Reports Builder

Reports Builder provides a list of fonts that are available on the system in the font
picker box.

Figure 4-1 Font list in Reports Builder

i’?_[‘ Courier New [wWestern) vl 11 0 v;

On Windows, the font list is derived from the fonts that are installed on the system
along with the fonts available on the current default printer. A small printer icon
before the font name identifies printer fonts. True Type fonts are associated with a TTF
icon.

On UNIX, the font list is derived by querying the X-server display on which the
application is running for the available fonts. The command is similar to the UNIX
xlsfonts command, which lists all of the available fonts for the X-server display.
From this font list, Reports Builder generates a list of usable fonts with the valid style,
weight, width, size, and encoding characteristics to match the character set. The
character set is driven by the NL.S_LANG environment variable. Reports Builder
includes only those fonts with an encoding of is08859-1, unless specified differently
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in the toolkit resource file, Tk2Moti £ * fontMapCs. For more information on
Tk2Motif*fontMapCs, refer to Section 4.3, "Font Configuration Files".

4.1.2 Fonts in Report Output

During report formatting, fonts associated with the layout objects are first checked
against the font alias file, uifont .ali, (refer to Section 4.3, "Font Configuration
Files"). If an entry in the font alias file is found, the mapped font is used instead of the
original one. The mapped font is then searched for in the list of fonts available on the
system or printer. If a particular font is not found, Oracle Reports will look for the
nearest matching font under the same character set which can be used instead.

4.1.2.1 Font lookup

On Windows, the font lookup mechanism is simple due to the availability of printer
drivers, which have the capability of uploading fonts from the system as needed. Any
output from Oracle Reports running on Windows will contain fonts from either one of
the following:

s The system
s The printer

For this reason, Oracle Reports considers both the printer and the system fonts when
looking for the available fonts.

On UNIX, the fonts available for generating output are either one of the following:

= the fonts available on the printer, specifically the fonts defined in the PPD or TFM
files

= if no printer is specified, the fonts available in ScreenPrinter,
screenprinter.ppd.

See Also:
= Section 4.3, "Font Configuration Files"

s Section 3.10.1, "ScreenPrinter"

4.1.2.1.1 Font lookup algorithm Figure 4-2 illustrates the process of determining the
available fonts for generating report output.
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Figure 4-2 Font lookup flow
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The following steps describe how Oracle Reports generates a list of the available fonts
for generating output (for example, for the screen, printer, or file):

Oracle Reports looks in the printer configuration file uiprint . txt for all the
printers that are listed for the application. If no printers are defined or available,
Oracle Reports uses ScreenPrinter.

See Also:
= Section 4.3, "Font Configuration Files"

s Section 3.10.1, "ScreenPrinter"

Get their type, version and printer definition file.
Check for the existence of these printers in the system.

If the printers are present, the printer definition files are loaded and the
information in these files is read along with the information related to the fonts
available for the printer. If these printers are not found, then Oracle Reports uses
ScreenPrinter.

The AFM files, which are named the same as the font names given in the PPD files,
are searched.

If found, Oracle Reports then reads this file for all the valid keywords, checks for
their correctness and, in case of any discrepancy, default values are used for those
keywords.

If the AFM file is not found, Oracle Reports marks the font as unusable.
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Note: Similarly for PCL printers, the HP printer definition file
(glue file) is loaded and all the fonts defined in the file are also
loaded. While looking for a font, Oracle Reports searches for an
entry in the HPD file with the font name and accordingly takes the
font if the TFM file for this font is also found. Otherwise, Oracle
Reports matches this font to the closest available one.

Once the list of available fonts is generated, the mapped font is searched for in this list
of fonts and, again, the AFM files are read for the purpose of calculating the text size
and weight.

Substituting fonts

If a particular font is needed but not found in the PPD file or if an AFM file is not
found, Oracle Reports will look for the nearest matching font according to its matching
rules. For example, suppose a report is originally designed with a Simplified Chinese
font SimSun and in the uifont.ali file no mapping for this font is found. Oracle
Reports will look for the font SimSun in the list of available fonts generated by the
Font lookup algorithm. If this font name is not in that list, Oracle Reports tries to look
for the closest matching font from the list of fonts given in the printer definition file.

For the SimSun font, the character set is 850. If it cannot find any matching font for this
character set, Oracle Reports searches for a font that has a character set for the
environment in which the application is running. After a set of fonts with a similar
character set is found, Oracle Reports picks the closest match to the requested font
based on the font weight, style, and so on. If more than one font has the same
parameters, Oracle Reports picks the first one and uses it instead of the original font.

Font matching rules

When attempting to match a font, Oracle Reports will try to find the closest match
according to the following criteria for fonts with the same character set:

fontface > fontsize > fontstyle > fontweight > fontwidth

If Oracle Reports can't match the font face, it will try to match the font size; if it can't
match the size, it will try to match the font style; and so on.

If a font matches the font size but nothing else and another font matches the style,
weight, and width but not the font size, then Oracle Reports will pick the font with the
same font size.

It should be noted that irrespective of any font in the output file, the final printed
output will depend solely on the fonts installed in the printer.

Example: Suppose that a report has layout objects associated with one of two fonts,
Helvetica font of size 8, style Plain, and weight Medium, and Courier font. If the user
is running this report on a PostScript-1 printer and generating HTML output, the fonts
are chosen as follows:

1. While formatting, Oracle Reports checks uifont.ali for any mappings of either
specified font. Suppose that uifont.ali contains this entry in the
[Printer:PostScriptl] section:

Helvetica.8.Plain.Medium.. = "Mkai-Medium"..

Oracle Reports will now search for the Mkai-Medium font instead of the Helvetica
font.
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2. Oracle Reports looks for the mapped font in the printer definition (PPD) file.
Suppose that the PPD file contains the following entry in the *Font Information
section:

"*Font Mkai-Medium: Standard " (001.004)" Standard ROM"

3. Oracle Reports now checks for the associated AFM file (named Mkai-Medium) in
the AFM directory. If an AFM file with this name is not found, it will look for
another font that has size 8, style Plain, and weight Medium under the same
character set as the original font.

Because a report may have to run in many different environments, Oracle Reports
always tries to approximate a font for the original font when the original is
unavailable. This algorithm is not entirely foolproof. When you create a report, you
must be aware of the fonts defined and you should always consider whether those
same fonts will be available on the platform where users will run the report. If the font
that you have defined is not available in the runtime environment, Oracle Reports
substitutes another font that is available on the machine. This process can lead to
unexpected and undesirable results, such as strange characters in the report output
(for example, Wingding characters) and incorrect formatting of objects.

If you are encountering these kinds of problems, you should use font aliasing to
control the font substitutions made by Oracle Reports. Refer to Section 4.4, "Font
Aliasing".

Oracle Reports follows the above described mechanisms for all output file generation
except PDF, which has the PDF font sub setting/embedding capabilities.

See Also: Chapter 6, "Using PDF in Oracle Reports" for more
information on the PDF features and enhancements in OracleAS
Reports Services.

For more information on PDF in general, consult the Adobe PDF
documentation.

For printing, Oracle Reports generates output based upon the printer driver, in case of
Windows, or the printer, in the case of UNIX. On Windows, the output generation is
handled by the printer driver. The fonts in this case can either be from the system or
from the printer. For fonts which are not available on the printer, the printer will get
the fonts from the system through Windows APIs.

4.1.3 Fonts in the User Interface

Text in the user interface of Reports Builder, like the window title, menu items,
message boxes, and data model object names, use fonts taken from the system
resource files for the current language. These system resource files are supplied with
Oracle Reports installation. In Oracle Reports, you can map these fonts in the
[rwbuilder] section of uifont.ali. If found, the mapped font is used instead of the
original font. Otherwise, Oracle Reports uses the original font.

On UNIX, these fonts are defined in Tk2Motif.rgb under Tk2Motif*fontList. If
the font is not defined, then the default font (fixed for default character set) is used
instead. The default system font need not be the one defined in Tk2Motif . rgb. If the
defined font does not match the character set on which the application is running,
some other available font will be used following the font lookup algorithm discussed
in the previous section.

On Windows, in order to maintain the look and feel of the windows, Oracle Reports
makes extensive use of the system font, which is obtained from the Windows system
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parameters. For non-Unicode environments, the font is obtained from the icon objects.
You can change it by modifying the fonts through Display Property > Appearance.
Select Icon from the drop down box and select the desired font name and size. For
Japanese Unicode systems, the font is MS Gothic. For Korean, it's MS Sans Serif. For
simplified, traditional, and Hong Kong it's Arial. For other languages, it's Lucida Sans
Unicode.

You can also change the Windows tool tip font by changing the icon font as described
above. This change is not completely reflected across Reports Builder because some
tool tip fonts are taken from the resource file.

In Oracle Reports, fonts for the Web Source view are selected by making an entry in
the alias file under the [rwbuilder] section. The entry required for this change
should only be aliased to the character set and not to any specific font. For example, if
you want to use Arial Unicode MS when NLS_LANG is set to UTFES, then you should
create an entry like this one:

....UTF8 = "Arial Unicode MS"....

Refer to Section 4.4, "Font Aliasing” for more information.

The supported styles are: Plain, Italic, Oblique, Underline, Outline, Shadow, Inverted,
Overstrike, and Blink.

The supported weights are: Ultralight, Extralight, Light, Demilight, Medium,
Demibold, Bold, Extrabold, and Ultrabold.

You should not use fonts with a weight of Regular because this weight is not
supported and may cause Reports Builder to display undesirable results.

4.2 Adding Fonts

In Oracle Reports, fonts can be added for use:
= Atbuild time (in Reports Builder)
= Atruntime (in the output)

s In the user interface

4.2.1 Adding Fonts to Reports Builder

To build a report in a certain font, the font must be available in Reports Builder from
the font picker when you are designing the report. In order for the fonts to appear in
the font picker, the fonts should be added to the system or the display on which
Reports Builder is running. Please review your operating system documentation for
adding fonts before attempting this procedure.

To add Type1 fonts on UNIX:
1. Get the font-related files from the vendor. These include the PFB, PFA, and the
AFM files.

2. Convert the PFB binary file to PFA ASCII font using one of the available
convertors. Typically, you can get such converters as shareware, for example,
tlascii.

3. Copy the PFA files to the directory where the fonts need to be installed following
the instructions for our platform.

4. Verify the installation of the fonts by entering the x1sfonts -u command. This
command lists all the fonts that are available for that system.
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If you are using a UNIX emulator like reflection X, the fonts installed on the
system may not appear in the x1sfonts command. The reason for this behavior
is that it is taking fonts from the font path or the font server, which is configured
for this emulator. If using a font server, ensure that, after installing the font, you
add the font directory to the font server configuration file and restart the font
server. In the emulator, specify the font path to this font server wherever the fonts
are installed. If you are still not able to see the fonts in x1sfonts, ensure that the
new font directory is the first element of the catalogue in the configuration file.

Figure 4-3 xIsfonts sample output

Wwindow Edit Options Help

|=ad0be—cour1 er—bold—o—normal —0—0-0-0-m—0—1 s08559—1
—adobe—courier—bold—o—normal —0—-0-75—7 5—m—0—1 s08859—1
—adobe—courier-mediumr-normal —§-80-7 3—75-m—30—i 088991
—adobe—helvetica—hold—i—normal —0-0-0-0—p—0—i 5088591
—adobe—helvetica—hold-o—normal —14—140-75-75-p—82—1508853-1
—adobe—helvetica—hold—o—normal —18—180-75—75—p—104—hp—r omand
—adobe=he1vyetica—medivm=i=-no rmal=—0=0=-0—0-p=0-i s0§853—1
—adobe—helvetica—nedium—o-no rmal—0-0-75-75—p-0-1502859-1
—adobe—helvetica—nedium—r-no rira1—8-80-75-75—p—4E—1 5088591

—adobe—ite avant garde gothic—hook—o—normal—10-100-?5—75-p—59-1508859—1
—adobe—1t< avant garde gothic—demi—r—normal—34-240—100-1 00—p—1 82— s08859—1
—adobe—itc avant garde gothic—demi—r—normal—e—80-75-75—p-51-1508859—1
—adobe—it< Tubalin graph—book—o—normal—10-100—75—73—p—E0-1508855—1
—adobe—it< Tubalin graph—book—r—normal—12-120—75-75—p—70-1508855—1
—adobe—it< Tubalin graph—demi—o—normal—10-100—75-73—p—E2-1508855—1
—adobe—new century schoolbook—hbol d—i—-normal—24-240—75-75-p—148—hp—romans
—adobe—new century schoolbook—bol d—1-normal—24-240—75-75-p—145—1 5088531
—adobe—symbol-medi ur—r—normal—24-240-75-75—p—142—adobe—-fontspecific
—adobe=symbol=medi um=r=norma]—8=80-73=75—-p=51—adobe-fontspeci fic

5. Start Reports Builder on the display that points to the font server on which these
fonts are installed or to the display where the fonts are installed.

4.2.2 Adding New Fonts for Report Output

For generating output in Oracle Reports, only the fonts that are specified in the printer
definition file are used. To use a newly added font in your output, you should first
add it to Reports Builder so that you can assign the font to layout objects when
designing the report. Refer to Section 4.2.1, "Adding Fonts to Reports Builder" for
further information.

Note: If you use fonts in Reports Builder that are not available on
your runtime platform, you should alias those fonts on the runtime
platform. Refer to Section 4.4, "Font Aliasing" for more information.

The process for adding fonts is different on Windows and UNIX:
= Adding fonts on UNIX
= Adding fonts on Windows

4.2.2.1 Adding fonts on UNIX

To add PostScript fonts:

1. Copy the AFM file for the new font to ORACLE_
HOME/guicommon/tk/admin/AFM.
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2. Add the entry for this new font to the *Font information section in the printer
definition (PPD) file:

*Font new font_name Standard '(00.1001)" Standard ROM
*Font ...

Ensure that the new_font_name given in the PPD file is the same as the AFM file,
because Oracle Reports searches for this file based on the font name in the PPD
file. Also make sure that the AFM file name does not include the . afm extension.

For example, if the AFM file name is CodedreineunBold, then the PPD file
should contain *Font CodedreineunBold: Standard " (00.1001)"
Standard ROM.

3. If necessary, make changes in the alias file for mapping to this font.

If the layout objects are associated with the same font name as the new font, then
mapping is not required. If the fonts for the layout objects are different and the
new fonts are desired in the output file instead of the original ones, then you must
map the original fonts to the new ones.

For example, if the layout objects' font is Helvetica and you want newly installed
fonts in the output, then you could add the following to the
[Printer:PostScriptl] section:

Helvetica = CodedreineunBold

Please note the section will be different if you are using a different PostScript level
in your uiprint. txt. Refer to Section 4.4, "Font Aliasing".

To add PCL fonts:

In order to use a new font in Oracle Reports, you need to have the HPD (printer
definition) and TFM files for your printer. The HPD file can be copied from an existing
one. You need to be sure that the file is suitable for your printer; fonts referenced in
this file should be available on your printer. If the TFM files (fonts) are not available on
Oracle Reports installation, you need to contact your font/printer supplier. The new
TFM files must be added to the HPD file under a unique font name.

1. Inthe HPD, you will have to add the new font entry. For example if the new font is
Codedreineun then include a new line such as:

FONT= Codedreineun
/tfm=9nb17035. tfm

2. Copy the associated TFM file into the TFM directory:
ORACLE_HOME/guicommon/tk/admin/TFM
3. Modify the alias file, if necessary, as described in Section 4.2.2.1, "Adding fonts on

UNIX" for the PostScript printers. The section in which the mapping is done
should be [PCL].

4.2.2.2 Adding fonts on Windows

For adding a new font on Windows, refer to your operating system documentation on
adding a new font. If the new font has a character set that is compatible with Reports
Builder, the new font will appear in the font picker.
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4.3 Font Configuration Files

This section describes all of the files associated with font configuration for Oracle
Reports:

=  uiprint.txt (UNIX only)

= screenprinter.ppd (UNIX only)

= uifont.ali

= PPD and AFM files (UNIX only)
=  HPD and TEM files

s Tk2Motif.rgb (UNIX only)

uiprint.txt (UNIX only)
The printer configuration file contains a list of printers installed for the application
along with the type of the printer, its version, and the printer definition file. The list of
available fonts for runtime is taken from the printer definition file. If no printer is
present, Oracle Reports chooses a PostScript printer as the default and default.ppd
file as the printer definition file.

See Also:

= Section 5.3.1, "Editing uiprint.txt File"

m  Section 5.4.6, "uiprint.txt"

Example:
Printer: Printer_driver:Driver_specifying_language_and_level:Printer_
description:Printer_definition_file:

Each line contains five fields separated by colons.

If you are using PCL printing, then this entry should contain the name of an HPD file.

screenprinter.ppd (UNIX only)

screenprinter.ppd is used when a printer is not available on UNIX.
screenprinter.ppd isin ORACLE_HOME/guicommon/tk/admin/PPD.

uifont.ali

This file contains mapping information for fonts which can be substituted for other
fonts at runtime. Refer to Section 4.4, "Font Aliasing" for more information.

Oracle Reports has added three new sections to the uifont.ali file:

[PDF] - Used for font aliasing and multibyte language support

[PDF: Subset] - Used for TrueType font subsetting and multibyte language support
[PDF : Embed] - Used for Typel font embedding

Caution: Do not alter the sections as Oracle Reports parses the
uifont.ali file looking for keywords. The sections can be in any
order.

Some general rules for the uifont.ali file are:
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= Use double quotes around any font or character set names containing two or more
words, or spaces.

s Use #in the first column for comments.
= Comment out lines instead of deleting them to be able to use them in the future.

» Font aliasing is a font name-to-font name or character set-to-CID font (from Adobe)
only.

= Font subsetting is for TrueType fonts only.
= Font subsetting uses the font name and subsets using the TrueType font file name.

= Font embedding is for Typel fonts only. These fonts have two files. One for
metrics, containing either .afm or . pfm file extension and the binary containing
the .pfb file extension.

Font embedding uses the font name and embeds using the Type 1 font file names
(both the AFM and PFB files are required in this order).

Refer to Section 4.4, "Font Aliasing" for more information.

PPD and AFM files (UNIX only)

PostScript Printer Definition (PPD) files and Adobe Font Metrics (AFM) files are
supplied by Adobe and by printer vendors. These files contain information about the
printer. Along with other parameters, these files are read for the information about the
available fonts for the printer, which Oracle Reports will use. For all the fonts listed in
the PPD file, Oracle Reports searches for the corresponding AFM file according to the
font name and loads all of the fonts for which there is an available AFM.

From the fonts perspective, you should modify these files when you add new fonts for
the printer and want these changes reflected in Oracle Reports.

Example:

*$ Font Information =====================

*DefaultFont: Error

*Font AvantGarde-Demi: Standard " (001.001)" Standard

*Font AvantGarde-DemiOblique: Standard " (001.001)" Standard
*Font Courier: Standard "(001.004)" Standard

*Font Courier-Bold: Standard "(001.004)" Standard

The AFM files contain information such as the font attributes (style, weight, width,
encoding scheme), whether the font is fixed pitch or proportional, and how large each
character is.

After looking for the font names from the PPD files, Oracle Reports searches for the
AFM files with the same name as the font according to the search criteria described in
Section 4.3.1, "File Searching". For example, if Oracle Reports finds
AvantGarde-Demi: Standard in the PPD file, it will search for an AFM file named
AvantGarde-Demi in the AFM directory.

Please note that the AFM files are not font files; they are metrics files that provide
Oracle Reports with information on how to properly format the character for the
printer. If you have an AFM file, but the font is not available on the printer, then
Oracle Reports cannot generate the font.

Since the AFM files are NOT fonts themselves, if you wish to have more PostScript
printer fonts available, you need to:

1. Purchase the fonts and have them installed on the printer.
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2, Obtain revised AFM and PPD files from the font/printer vendor.

3. Obtain matching X Server display fonts (if necessary).

HPD and TFM files

PCL uses HPD and TFM files. The HPD files contain a list of fonts available for the
printer and each font refers to a TFM file. The HPD file is an ASCII file, which can be
edited, but the TFM file is a binary file, which cannot be edited. Even though TFM files
are binary and uneditable, you can perform string operations to read some specific
keywords from these files. Oracle Reports recognizes the font name that is in the TFM
files and not the one specified in the HPD file. The font vendor should provide TFM
files and new fonts should be added to the HPD file for your printer when installed.

Tk2Motif.rgb (UNIX only)

This file contains resource settings for all Oracle Motif tools based on Oracle Toolkit.
For font specific resource settings, Tk2Motif£* fontMapCs and Tk2Motif*fontList
are used.

Tk2Motif*fontMapCs governs the base character set of fonts that the application
will use, which are on the X-window display.

If Tk2Motif*fontMapCs: 1is08859-2=EE8IS08859P2, then NLS_LANG should be
set to EEBIS08859P2 and only fonts with encoding as 1s08859-2 will be used for
the application. If the system does not find any fonts with the above encoding, it will
fail with a REP-3000 error.

Tk2Motif*fontList specifies the default system font that will be used by the
application. The following means that the Helvetica font with medium weight and
normal width of size 12 will be used:

Tk2Motif*fontList: -*-helvetica-medium-r-normal-*-120%

The syntax for the above entries can be found in Tk2Motif . rgb file as comments.

4.3.1 File Searching

The criteria for searching files is dependent upon the type of file and the various
environment variables defined.

Table 4-1 File information

Filename Type Description

uiprint.txt UNKNOWN Printer configuration file

uifont.ali FONTALIAS Font aliasing file

PPD PPD PostScript printer definition
file

AFM AFM Adobe font metrics file

HPD HPD HP glue file

TFM TFM HP glue file

Oracle Reports will first look for the variable in TK_ type, then in the ORACLE_ type,
and then in the global directory. For instance, the PPD files are searched for in the
directory specified by TK_PPD, then in ORACLE_PPD, and then in ORACLE_
HOME/guicommon/tk/admin/PPD.
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For example, looking for uiprint. txt, Oracle Reports will first look at the
environment variable TK_UNKNOWN, then look at ORACLE_UNKNOWN, and then in the
default directory.

Environment Variables:

REPORTS_NO_DUMMY_PRINTER: If this variable is defined to any value, Oracle
Reports will use screen fonts instead of the printer fonts.

4.4 Font Aliasing

Font aliasing is a mechanism in Oracle Reports that allows a font or its associated
attributes like style, weight, width, size and character set to be mapped to another
desired font or its associated attributes. Its primary use is when applications are
ported from one platform to another and the font associated with some or all of the
objects in the layout on the source platform do not exist on the target platform. In such
cases font aliasing will be helpful as the nonexistent fonts can be mapped to another
available one producing the required results. For example, when moving from
Windows to Motif one would use font aliasing to map the Windows Arial to a font
available on Motif, such as Helvetica.

This section includes the following topics:
= Specifying Aliasing Information

= Font Aliasing Mechanism

= Font Alias File Sections

= Font Aliasing File Verification

4.4.1 Specifying Aliasing Information

The file that contains mapping specifications is uifont.ali. To include any new or
changed mapping rules, you must edit this file.

The general format is:

"Original_font"="Font_to_be_aliased"

where Original_ font is the font name or its other attributes that will be mapped to
the font name or attributes of Font_to_be aliased.

The fonts along with their attributes can be described as:

Face.Size.Style.Weight.Width.CharSet=
Face.Size.Style.Weight.Width.CharSet

The Face must be the name (string/identifier) of a font face, such as Courier. The
Style, Weight, Width, and CharSet may either be a numeric value or a predefined
identifier or string. For example, both Plain and 0 are valid Sty1e values and refer
to the same style. The Size dimension must be an explicit size, in points.

These attributes take effect for font aliasing, font subsetting, and font embedding.
For example, in the case of font subsetting it is:

Fontname=filename.ttf
Face.Size.Style.Weight.Width.CharSet=filename.ttf

The following is a list of recognized names and their numeric equivalents:
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Table 4-2 Style names and their numeric equivalents

Style name Numeric equivalent
Plain 0

Italic 1

Oblique 2

Underline 4

Outline 8

Shadow 16

Inverted 32

Blink 64

Table 4-3 Weights and their numeric equivalents

Weight name Numeric equivalent

Ultralight

1
Extralight 2
Light 3
Demilight 4
Medium 5
Demibold 6

Table 4-4 Widths and their numeric equivalents

Width name Numeric equivalent

Ultradense
Extradense
Dense
Semidense
Normal
Expand

Extraexpand

O o0 N G ok W N =

Ultraexpand

Styles may be combined; you can use the plus sign (+) to delimit parts of a style. For
example:

Arial..Italic+Overstrike = Helvetica.l2.Italic.Bold

This mapping indicates that any Arial that has both Italic and Overstrike styles will be
mapped to a 12-point, bold, italic Helvetica font.

For multibyte language support, you must alias a character set with a CID font
(Section 4.6.7, "CID Fonts") from the Asian font pack from Adobe. For example, in your
Japanese report you have aliased a multibyte Shift-JIS characterset be aliased to
HeiseiKakuGo-W5-Acro CID font with the following entry: . . . .. JA16SJIS =
"HeiseiKakuGo-W5-Acro"
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All strings are case-insensitive in mapping. Font faces are likely to be case-sensitive on
lookup, depending on the platform and surface. As a result, take care with the names
used. For example, if the font name arial is used on the left-hand side (the original
font), all layout objects with fonts such as arial or Arial are mapped to the aliased
font.

4.4.2 Font Aliasing Mechanism

For font aliasing, Oracle Reports searches for entries under the related section in the
alias file that matches the original font attributes given in the report. Refer to

Section 4.4.3, "Font Alias File Sections" for more information about the sections of the
font alias file. If an exact match is found, Oracle Reports maps the original font on the
left to the target font on the right.

For example:
Arial.8.Italic.Medium.Normal.WE8IS08859P1 =
Helvetica.l2.Plain.Light.Normal .WE8IS08859P1

If an Arial font with all of the attributes listed on the left is found, it will be mapped to
a Helvetica font with all of the attributes listed on the right.

Any field can have a blank entry, which means it will be matched regardless. For
instance:

Arial..... = Helvetica.l2.Plain.Light.Normal.WE8IS08859P1

In this case, all of the Arial fonts, irrespective of size and other attributes, are mapped
to Helvetica with size 12, style Plain, weight Light, having Normal width under
character set WEBISO8859P1.

Another way to specify an aliasing rule is:

Arial = "OCR B"

This method will preserve the other attributes of the present font but will change the
font name to OCR B. You need to be certain in such cases about the availability of
mapped fonts with the attributes of other fonts. For example, in this rule the Arial font
with style Italic might be mapped to the OCR B font with Plain style because the OCR
B font does not have the Italic style present.

After a mapped font is read from the alias file (uifont.ali), Oracle Reports looks for
the font following the font lookup procedure, which is described in Section 4.1.2.1,
"Font lookup". If the mapped font is found on the system, then Oracle Reports uses
this font. Otherwise, it looks for the original font in the system.

Font attributes are searched for with the font face, size, style, weight, and width under
the specified character set.

In Oracle Reports, fonts for the Web Source view and PL/SQL editor can be mapped
by providing a mapping specification in the [rwbuilder] section. This feature is
mainly intended for supporting Unicode fonts in these editors.

4.4.3 Font Alias File Sections
The uifont.ali file can be found in the following locations for Oracle Reports:

ORACLE_HOME\tools\common (Windows)
ORACLE_HOME/guicommon/tk/admin (UNIX)
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The alias file consists of various sections which contains font mapping instructions for
a particular area, as shown in Table 4-5. Since Oracle Reports looks in specific sections
for specific purposes, it is crucial that you place your mapping entries in the
appropriate section for what you are trying to accomplish.

Table 4-5 Font mapping file sections

Section name Description

Global Applies everywhere.

Printer Only applies to printer output.

Printer:PostScri Applies to PostScript Level 1 printers.

ptl

Printer:PostScri Applies to PostScript Level 2 printers.

pt2

Printer:PCL5 Applies to PCL 5 printers.

Display Only applies to the display (the screen).

Display:Motif Applies only to the Motif display.

Display:CM Applies only to character-mode display.

PDF Used for font aliasing (from Oracle Reports 6i)
and multibyte language support (from Oracle
Reports).

PDF : Embed (Oracle Reports only) Used for Type 1 font
embedding.

PDF: Subset (Oracle Reports only)

RWBUILDER (Oracle Reports only) Fonts for the Web
source and PL/SQL editor can be mapped in
this section.

printer name A section for a specific printer, such as:

[Printer:PostScriptl:20op813al

See Also: "Repairing Fonts Not Appearing Correctly in Web
Source View" in Section 4.5, "Troubleshooting Font Issues".

Order of precedence

When aliasing a particular font, only one section is read based upon the context in
which the font is used. Hence, if three sections apply, only one is read. For example,
suppose you have three sections: [Printer], [Printer:PostScript], and
[Printer:PostScript:20op81l3al. When generating output, if the printer is
20p813a, only the mapping rules in section [Printer:PostScript:20p813a] are
read. For printers other than 2o0p813a, Oracle Reports would use the
[Printer:PostScript] section.

The more specific sections of the alias file take precedence over the more general
sections. For example, a specific printer section, such as
[Printer:PostScriptl:20op8l3a] would take precedence over the
[Printer:PostScriptl] section, which would take precedence over the
[Printer] section, which would take precedence over the [Global] section.

Theuifont.ali fileis the configuration file controlling all of the Oracle Reports
PDF font enhancements. It can be found in the ORACLE_HOME\ tools\common
(Windows) directory and in the ORACLE_HOME/guicommon/tk/admin (UNIX)
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directory. The uifont.ali file is text readable; that is, you can edit it with a standard
text editor. Exercise caution when editing the file. The uifont.ali file should be
saved as a text file with no formatting or special characters that may corrupt the file.

See Also: Chapter 6, "Using PDF in Oracle Reports" for more
information on the various sections in the ui font.ali file.

4.4.4 Font Aliasing File Verification

To verify whether the uifont . ali file is correct, you can run the font check utility,
which can be found in the ORACLE_HOME/bin directory. It is always advisable to run
this utility on the modified uifont.ali file to catch any errors:

On Windows:

fnchk.exe filename

On UNIX:

mfontchk filename

where f£ilename is the name of the uifont.ali file. If you don't specify any file
name, it will check the default file based on the environment variables.

If the alias file has errors, the utility returns an error message along with the file on
which the error was found. For example:

Parsing font alias file "/home/oracle/guicommon/tk/admin/uifont.ali"
Ms san serif

Error at line 85: Invalid font specification
Parse of font alias file failed

The above error indicates that there is a syntax error in uifont.ali in the mapping
rule for MS San Serif font on line 85.

4.5 Troubleshooting Font Issues

To help resolve font issues that may occur in your applications, this section provides
the following troubleshooting information:

s Checking Whether the Desired Font Is Used in a PostScript File
s Creating Output

= Reading the Output File

= Verifying the Output File

»  Correcting Printed Font

s Checking Environment Variables

= Repairing Fonts Not Appearing Correctly in Web Source View
= Understanding Limitations

= Resolving Common Problems

Checking Whether the Desired Font Is Used in a PostScript File

PostScript files have a list of fonts, which is created after reading the PPD file. If you
examine the PostScript file, you can check the fonts by looking for the following tags:
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s DocumentNeededResource has the list of fonts referenced in the PPD file.

s DocumentSuppliedResource has the list of fonts for which the PostScript
driver was able to find the AFM file.

= %%Page paragraph before the field's $IncludeResource: font has the font
name which will be used for the field.

For PCL output files, you can check whether a particular font was used or not.
Depending on this information the font settings in Oracle Reports or the printer can be
modified.

Example:

The test results below are based on a Lexmark Optra printer. The fonts and their
numbers as well as the control commands are examples and may vary with other
printers.

Font information The Lexmark has a small menu with the option of printing all
available fonts (PCL Emulation Fonts). This includes both resident fonts (defaults) and
Flash fonts (installed on the printer separately)

Table 4-6 Sample font information

Font nhame Style Weight Example output

RO Courier 0 0 ... <ESC>(<symset><ESC>(s0p<pitch>h0s0b4099T...
R39 Courier Bold 0 3 ... <ESC>(<symset><ESC>(s0p<pitch>h0s3b4099T...
R40 Courier Italic 1 0 ... <ESC>(<symset><ESC>(s0p<pitch>h1s0b4099T...
R55 Century 0 0 ... <ESC>(<symset><ESC>(s1p<point>v0s0b24703T ...

Schoolbook Roman

Table 4-7 Sample Flash font information

Symbol
Font name set Style Weight Example output
F2 OCR-A 00 0 0 ... <ESC>(00<ESC>(s0p<pitch>h0s0b4200T

F3 OCR-B 10 0 3 ... <ESC>(10<ESC>(s0p<pitch>h0s0b4206 T

In these examples, there are many more fonts and each font has its own code. OCRB
for example has code 4206. This number is important later on.

Creating Output

When having problems getting the correct font, simplify the report and thereby the
output. This can be done by creating a straightforward report using select
sysdate from dual as the query and limiting the number of fonts. This will avoid
long runs and create much smaller output files.

Reading the Output File

The resulting PCL-file is a binary file but is reasonably readable in the VI editor. The
first small part and the end part is binary, but the middle part is readable and contains
data that can be interpreted.
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Verifying the Output File

The only interesting information is in the readable, middle part of the file. Find the text
(this is the text displayed in the reports output) and check out the part preceding the
text.

It looks like this:

....;sp1,14,2,0,3,10.34,5,0,6,0,7,4099;LB here is your text

In the preceding example, the font is selected with code 4099. For the Lexmark printer,
this is selecting Courier.

In one example, the font OCR-B (code 4206) was needed. The font did not come out
until that specific code was generated just before the selected text. It looks like this:

....;s8D1,14,2,0,3,8.57,5,0,6,0,7,4206;LBThis is OCRB font....

Correcting Printed Font

If the output file contains the correct code, but the font does not appear on the printer,
the printer probably does not have the font available. This will also occur if the code in
the output file (deduced from TEM file) is not the same as the one the printer is
expecting. On the Lexmark printer, the font was replaced by the default font on the
printer.

If the output file does not contain the code for the font, Oracle Reports did not
generate the code to the output file. Check for the HPD and TFM files.

Checking Environment Variables

DEBUG_SLFIND can help you ascertain which of these files was used. With reference
to the fonts, you can find the list of AFM/TFM files the application looked at after
reading the printer definition file and which font files it read after the aliasing. In this
manner, you can also determine whether a font is mapped or not. Usually the order of
file reading will be as follows.

»  First read the printer definition file.
= Read all the associated font files for the font supplied by this printer definition file.
= Read in the alias file.

»  If there is a mapping of file then read in font information files for those fonts and
finally again read the AFM file for the fonts that are used in generating the output.

TK_DEBUG_POSTSCRIPT will affect PostScript output. It can be set to any
combination of these strings:

= Functions list each toolkit function called in comments in the PostScript output.
= Long produces long, slow, intelligible PostScript.
= Memory displays memory usage at the bottom of each page.

Any of the options can appear in the environment variable, abbreviated down to one
letter. You can set it to any combination of these, separated by "/". This variable is case
insensitive. For example, Func/L/Mem would give you all three options.

Note that the output that results from using this variable will not be supported by
Oracle for customer use. It exists for diagnostics purposes only.
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Repairing Fonts Not Appearing Correctly in Web Source View

Text in the user interface of Reports Builder, such as the window title, uses fonts taken
from the system resource files for the current language. These system resource files are
supplied with the Oracle Reports installation. In Oracle Reports, you can map these
fonts in the [rwbuilder] section of uifont.ali. If found, the mapped font is used
instead of the original font; if not, Oracle Reports uses the original font.

Note: The mapped font needs to be a fixed-width font.

In the Web Source view of the Report Editor, the following languages may appear
garbled: Arabic, Central European languages, Cyrillic, Greek, Hebrew, Japanese, Thai,
and Turkish. To work around this issue, you can set the font names for Reports
Builder inuifont.ali as follows:

[rwbuilder]

..... ARBMSWIN1256="Courier New"

..... CL8MSWIN1251="Courier New"

..... EE8SMSWIN1250="Courier New"

..... EL8MSWIN1253="Courier New"

..... IWBMSWIN1255="Courier New"

..... JA16SJIS="MS Gothic"

..... THBTISASCII="Andale Duospace WT"
..... TR8MSWIN1254="Courier New"

You can download a copy of the Andale Duospace WT (fixed width) font from Oracle
Metalink (http://metalink.oracle.com). The ARU number is 2766564.

Understanding Limitations

On Windows:

= For Unicode, Windows provides True Type Big Fonts. These fonts contain the
characters necessary to display or print text from more than one language. For
example, if you try to type, display, or print Western European, Central European,
and Arabic text on a field and see unexpected characters, then you are probably
not using a Big Font. Big Fonts for single-byte languages provided by Microsoft
Windows are Arial, Courier New, and Times New Roman. For more information,
go to Microsoft's Web site:
http://www.microsoft.com/typography/fonts/default.aspx.

= Wingdings fonts may not appear when NLS_LANG is set to UTF8.

The only Wingdings fonts available when using UTES8 are the characters between
ASC 32 and 127. ASC 252 would display a blank because it is not supported by
UTEFS.

Any of the following font sets would provide a reasonable work around.
s Webdings - chr(97)
m Wingdings2 - chr(80)

s Wingdings2 - chr(87)

On UNIX:

= AFM support is only for single byte PostScript file generation except for the
Japanese encoding. The encoding schemes supported for the AFM files are
AdobeStandardEncoding, ExtJIS12-88-CFEncoding, FontSpecific,
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HRoman, ISOLatinHebrew, JIS12-88-CFEncoding, and
JIS12e-88-CFEncoding.

AFM version that is supported is 2.0.

= X11 does not support the underline font attribute. Output to file should work
according to steps given below.

s In]JDK, a bug causes the bold Korean font to appear incorrectly. OracleAS Reports
Services uses the JRE and therefore all bold Korean strings in graphs within
reports show up incorrectly.

s PostScript printing will not load the fonts to the printer. So for the desired fonts to
appear in the printed output, it is necessary that those fonts should be installed on
the printer.

s For PCL output, only TEM font formats are supported.

s The display system on UNIX (for example, X11) is totally independent of any
application or printer. There is no direct connection between printing and
displaying. There can be a font displayed on your screen that is not printed.

Display and printer fonts are somewhat similar but have more differences than
similarities.

X fonts (display fonts) are bitmap display glyphs, which are displayed on an X
terminal by an X Server.

Printer fonts are PostScript fonts (mathematical descriptions of fonts, not bitmaps)
that are present in a PostScript printer and are generated by a PostScript
Interpreter on that printer.

= Font size changes after applying a template.

Creating a template with font set to Times New Roman size 10 (for all fields) and
making the report use this template, makes the Paper Design view of the Report
Editor display a different font size.

The reason for this behavior is that defaulting couldn't fit the layout into the
desired area.

First it reduced the size of text fields and then reduced the size of the fonts. This is
much better than wrapping the fields and keeping the template font size.

Also, for templates, the font chosen may be different to that in the template since it
matches first on the character set. So if the template font doesn't support the
current character set, the font will change to one that does. This is mostly visible if
you have an English template, which you use in a Hebrew / Arabic environment.

Resolving Common Problems

Problem: Letters are truncated from the right margin on printed label reports.

You have printed a mailing label report on a Windows machine and notice that the last
letter, or last few letters, on each line are being truncated. The letters are not missing
when you preview the report. You have tried changing the page formatting and font
settings, but this has failed to resolve the problem.

Solution: If the report displays correctly using a DESTYPE of Preview, this is not a

problem with the printer driver. The problem may be occurring due to the frame
properties.
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If a frame around the layout objects has a Horizontal Elasticity setting of Fixed and the
data exceeds the frame size, it can cause this truncation of data.

Try testing the results after setting the Horizontal Elasticity property to Expand or
Variable.

Problem: When generating to file as HTMLCSS, a column is dropped off in the
output.

You are generating a report to an HTMLCSS file format and it appears to be fine in the
Paper Design view of the Report Editor. When you click the newly created file it comes
up in your browser, but the last column is missing from the report output.

If you re-run the report again, it still looks fine in the Paper Design view and the
column is there as it should be. Clicking on the file again appears to have the column
dropped off and missing from the report output. PDF appears fine in Paper Design
view and the Adobe Acrobat reader.

Solution:
1. Quit Oracle Reports and any other open applications.

2. Choose Windows Control Panel > Display > Settings.

3. Set your fonts to be Small Fonts, click Apply button and then click OK to
reconfigure your Windows font settings.

4. Reboot your computer in order for the new font settings to take effect.

5. You can now go back into Windows Control Panel > Display > Settings to verify
that you have small fonts as a default for your system.

When you click the HTMLCSS file, your browser shows the report correctly with all of
the columns intact.

When viewing HTMLCSS files with your browser, it is recommended to have Small
Fonts as the default setting for your Windows system.

If you have Large Fonts as your default, your HTMLCSS file may not display correctly.
Problem: How to choose bitmap fonts sizes of less than 8 point in Reports Builder.

Solution: There are times when a font size of 6 or less is required for reporting
purposes. Keeping in mind that font mapping and sizing is actually a product of
operating system font files and driver/printer specifications, it is possible to change
many fonts to minimal sizes such as 6 or less.

Oracle Reports typically allows fonts to be downsized to a size of 8. This is
accomplished by opening a report in Reports Builder, going to the Layout Model view,
and selecting the report objects that you wish to change. Once the object is selected, go
to the font size list next to the font picker and select your font size.

Typically, your size will be limited to a range from 8 to 72 for True Type fonts, less for
other fonts.

You can enter a size smaller or larger than the sizes in the list. To do this, again select
the object, place your cursor in the font size field, press Delete to remove the current
size number, enter the font size you desire, and then press the TAB key. The change
takes effect immediately.

Once again, keep in mind that not all font sizes are possible. Also, some combinations
of fonts and attributes are not practical. Simply having the ability to choose a font size
does not mean that the font will be legible when printed. Fonts that involve small
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sizes, combined with bold, italic, or other attributes, may also present legibility
problems when printed or displayed due to the limitations of the printer driver,
printer, font metrics, language, code sets, NL.S_LANG, and, of course, human eyesight.

Problem: The report output font size is different in Windows and UNIX.

A simple report designed on Windows uses the Arial and a font size of 8. This report
was ported to Sun Solaris and was found to have a different font size in the output on
Solaris. In the UNIX environment, the report is uses the Helvetica font and a font size
of 9. The Arial font has been mapped to the equivalent font, Helvetica, on UNIX using
uifont.ali.

Solution:

1. First look for the font size available for Helvetica on the UNIX system by either
using the x1sfont command or any other UNIX font utility.

2. You should map variable sized fonts on Windows to variable sized fonts on UNIX.
For example, modify the mapping for MS Windows Arial.8 = Helvetica.8
(assuming that size 8 is available for Helvetica on the UNIX system) and ensure
that uifont.ali is in the correct directory (see font mapping).

It's probable that the Helvetica font installed on your machine is bit mapped
(rasterized) and so it doesn't automatically scale to any arbitrary size. If so, you need
to install a scalable Type 1 font, which should allow you to choose any point size.

There may always be differences between fonts on different systems even if the fonts
installed are the same because the font configuration files may be different on these
systems.

Problem: When printing, fonts are replaced by non True Type fonts. In the Paper
Design view, the fonts are fine.
Solution: Check the printer settings (advanced) and ensure that it doesn't say:

True Type Font: Substitute with Device Font

UNIX

Problem: While running Oracle Reports on X-windows emulators, fonts installed on
UNIX do not appear in the font lookup box.

Solution: On X-windows emulators, where the font path is usually a font directory
on the local machine, the fonts that were installed on will not be available and only the
fonts in the local font directory will be used by the Oracle Reports font lookup box. In
such cases, you should start a font server on a remote machine where the fonts were
installed and point the font path entry to this font server. For starting the font server
and setting the font path entry, consult the system manual and X-windows emulator
help.

For finding the font path or font server that is currently being used, use the UNIX
command xset -.

4.6 Font Types
This section discusses the fonts and character sets relevant to Oracle Reports:

s Character Sets
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= Unicode

= Typel Fonts

s TrueType Fonts

s TrueType Collection
= Barcode Fonts

s CID Fonts

4.6.1 Character Sets

The character set component of the NLS environment variables specifies the character
set in which data is represented in your environment. When data is transferred from a
system using one character set to a system using another character set, it is processed

and displayed correctly on the second system, even though some characters might be

represented by different binary values in the character sets.

If you are designing a multilingual application, or even a single-language application
that runs with multiple character sets, you need to determine the character set most
widely used at runtime and then generate with the NLS environment variable (NLS_
LANG) set to that particular character set.

If you design and generate an application in one character set and run it in another
character set, performance can suffer. Furthermore, if the runtime character set does
not contain all the characters in the generate character set, then question marks appear
in place of the unrecognized characters. Portable Document Format (PDF) supports
multibyte character sets. There might be situations where you create an application
with a specific font but find that a different font is being used when you run that
application. You would most likely encounter this when using an English font (such as
MS Sans Serif or Arial) in environments other than Western European. This occurs
because Oracle Reports checks to see if the character set associated with the font
matches the character set specified by the language environment variable (NLS_LANG).
If the two do not match, Oracle Reports automatically substitutes the font with another
font whose associated character set matches the character set specified by the language
environment variable. This automatic substitution assures that the data being returned
from the database gets displayed correctly in the application. Note: If you enter local
characters using an English font, then Windows does an implicit association with
another font. There might be cases, however, where you do not want this substitution
to take place. You can avoid this substitution by mapping all desired fonts to the
WE8IS08859P1 character set in the font alias file (uifont.ali).

4.6.2 Unicode

Unicode is a global character set that allows multilingual text to be displayed in a
single application. This enables multinational corporations to develop a single
multilingual application and deploy it worldwide. For information about using
Unicode in your multilingual applications, refer to Section 18.5, "Unicode".

4.6.3 Typel Fonts

PostScript font formats Adobe Type 1 fonts are stored in two common formats: .pfa
(PostScript Font ASCII) and . pfb (PostScript Font Binary). These contain descriptions
of the character shapes, with each character being generated by a small program that
calls on other small programs to compute common parts of the characters in the font.
In both cases, the character descriptions are encrypted. Before such a font can be used,
it must be rendered into dots in a bitmap, either by the PostScript interpreter, or by a
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specialized rendering engine, such as Adobe Type Manager, which is used to generate
low-resolution screen fonts on Apple Macintosh and on Microsoft Windows systems.

The Type 1 binary files (.pfa and . p£fb) contain character information, while the
metric files (.afm (Adobe Font Metric) and .pfm (Printer Font Metric)) contain the
metric information to form the character. These metrics files are ASCII files with a
well-defined easy-to-parse structure.

4.6.4 TrueType Fonts

The personal computer brought about a need for scalable font technology, thought to
be an important part of any future operating system. TrueType is this scalable font
technology that enables you to view the same output without the jagged aliasing
caused by scaling that is apparent when bitmapped fonts are used.

This technology involves two parts:
s The Rasterizer
s TrueType fonts

The Rasterizer is an application that is included in both Windows and Macintosh
operating systems. It acts as an interpreter and translates the font information into a
form that the video display can render.

The TrueType fonts themselves contain information that describes the outline of each
character in the typeface. Higher quality fonts also contain hinting codes. Hinting is a
process that makes a font that has been scaled down to a small size look its best.
Instead of simply relying on the vector outline, the hinting codes ensure that the
characters line up well with the pixels so that the font looks as smooth and legible as
possible.

Adobe wanted both Apple and Microsoft to license its PostScript code, which was
capable of handling this role, but both companies were concerned about having a third
party control key parts of their operating systems. Apple and Microsoft agreed to a
cross-licensing and product development deal, with Microsoft creating a
PostScript-style graphics engine and Apple creating a font system. Apple developed
what was to become TrueType, which proved superior to other competing
technologies on performance and rendering quality. Apple and Microsoft announced
their strategic alliance against Adobe, where Apple would do the font system,
Microsoft the printing engine. Apple released TrueType in March 1991 and the first
TrueType fonts:

s Times Roman
s Helvetica
s Courier

Microsoft introduced TrueType into Windows with version 3.1 in early 1992. They
created a core set of fonts:

s Times New Roman
s Arial
s Courier

Both Apple's and Microsoft's TrueType fonts showed that scalable fonts could generate
bitmaps virtually as though each size had been designed by hand.
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4.6.5 TrueType Collection

A TrueType Collection (TTC) is an efficient way of sharing common font data, such as
character information and glyphs. This data sharing results in an optmized file size as
the common glyphs are stored in a single file structure, instead of within each font.
The end result is a single file that is a combination of two or more fonts. For example,
certain Japanese fonts in a font family may share a common set of kanji characters.
They can be included in a TTC file.

For example, the TTC file, msgothic. ttc, is a collection file consisting of three fonts.
They are MS Gothic, MS PGothic, and MS UI Gothic.

4.6.6 Barcode Fonts

Barcode fonts can be quite confusing. Some industries have chosen a specific barcode
type. If this is what you need, then using the appropriate barcode font should work.
For example, if you are interested in putting barcode on retail packages or books, the
choice of a barcode is simple. Retail packages in North America use the UPC-A bar
code. European retail articles use the EAN barcode .

All book ISBN numbers use the Bookland barcode (an EAN 13 bar code with a 5 digit
supplement). Fonts are one way to obtain barcode, but not the only way. Oracle
Reports offers another solution for producing barcodes using a Java barcode bean. The
Java barcode bean is capable of creating barcodes based on the most popular barcode

types.

4.6.7 CID Fonts

Character IDentifier (CID) fonts are a format of composite (multibyte) Typel fonts
used to better address the requirements of Far East markets. Adobe developed the
CID-keyed font file format to support large character set fonts for use with PostScript.
It is the ideal format for Chinese, Japanese, or Korean fonts and can also be used for
roman fonts with very large character sets. CID-keyed refers to the character identifier
(CID) numbers used to index and access the characters in the font. A CID (character
identifier) font consists of a large font file containing all the character outlines and a
small CMap file that contains a list of characters, encodings, and character identifiers.
The combination of the font file and the CMap file yields a font that is a specific
character set and encoding information. Each CID font can support many character set
and encoding combinations.
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Printing on UNIX with Oracle Reports

Oracle Reports provides a rich set of features out of the box for printing on various
platforms. Printing on UNIX requires some setup and configuration to create the
proper printing environment. This chapter provides information about printing on
UNIX with Oracle Reports. In particular, it covers:

s UNIX Printing Overview

s Setting Up a Printer on UNIX

= Configuring the Printing Environment
= Printer-Related Files

=  Globalization Support

= Debugging Options

= Frequently Asked Questions

5.1 UNIX Printing Overview

This section explains how to print from Oracle Reports on UNIX and highlights the
key differences between the UNIX and Windows platforms. It also explains the
operating system requirements for any application to print successfully.

= General Printing Mechanism
s Oracle Reports Printing Mechanism on UNIX and Windows
= Printing Support

5.1.1 General Printing Mechanism

To understand how printing works for Oracle Reports on UNIX, it is useful to have the
Microsoft Windows printing mechanism as a reference point. Microsoft Windows
provides an application level API that supports different types of printers based on the
installed printer drivers. Applications can interact with various printer drivers
through these standard APIs. For example, to change the paper margin, an application
needs to call the appropriate Microsoft Windows API method, which conveys the
desired changes to the printer driver. On Microsoft Windows, printer drivers are
printer specific; that is, you need to install a specific printer driver for a printer. These
printer drivers know how to communicate to the printer and provide services to
applications that need to send output to the printer. Applications can access the printer
properties, change their properties, and perform printing through these standard APIs.

Motif and character-based UNIX operating systems do not have their own standard
interface to printers like Microsoft Windows. Individual applications are responsible
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for sending their output in a streamed file to the printer and adhering to the
specifications of the printer. On UNIX platforms, Oracle Reports output must be
formatted properly (for example, PostScript or PCL) before sending it as a stream to
the printers. To print on UNIX, Oracle Reports mimics the behavior of the Microsoft
Windows printer drivers internally. The next section describes more precisely how
this mechanism works on UNIX.

5.1.2 Oracle Reports Printing Mechanism on UNIX and Windows

Figure 5-1 and Figure 5-2 depict the differences between Oracle Reports printing on
UNIX and on Microsoft Windows.

Figure 5—-1 Oracle Reports printing on UNIX
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To support printing on UNIX, Oracle Reports internally creates logical printer drivers.
A logical printer driver simulates the behavior of Microsoft Windows printer drivers
and provides a printing service interface for Oracle Reports on UNIX. Through the
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logical printer driver, Oracle Reports can access the printer properties and perform
printer-related operations. These logical drivers:

= Support PostScript and PCL printing specifications, which are the most popular
printing standards.

= Read the printer description files (for example, PPD or HPD) to get the printer
descriptions.

= Embed the various printer commands in the generated PostScript or PCL output.
For example, to change paper margin, the logical printer driver needs to write the
corresponding printer commands in the generated output. These commands differ
depending on whether you use a PostScript or a PCL printer. When the generated
PostScript or PCL file is sent to the printer through the printing executable (for
example, 1pr), the printer interprets the commands in the file and processes them
accordingly.

To function correctly, the logical printer drivers require the following input:

s The printer queue name that is used to spool the print request.

s The printer description file that contains the printer properties.

s The driver type required by the specified printer queue, PostScript or PCL.

You provide this information in a file called uiprint. txt. Oracle Reports uses this
file to get a list of the printer queue names available for printing. In uiprint. txt,
you need to specify the printer queue name, the type of driver needed for the queue,
the version of the driver, and any special printer description file that the print driver
needs for that specific printer (for example, a PPD file for the PostScript driver). Once
this information is available, the internal logical printer drivers are constructed and
they use the definition files provided to access the printer properties.

5.1.3 Printing Support
Oracle Reports supports the following printing standards on UNIX:

»  PostScript Level 1 and 2
s PCLLevel 3
s ASCII (for character mode printing)

The printers you use with Oracle Reports should be compatible with the above
versions.

5.2 Setting Up a Printer on UNIX

This section describes:
» Installing a Printer on UNIX
= Verifying the Printer Setup for Oracle Reports

5.2.1 Installing a Printer on UNIX

The installation of a printer queue is slightly different depending upon your flavor of
UNIX. Some platforms may have user interface tools to help in the installation. Please
refer to your UNIX platform documentation for the steps on adding a printer queue.
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The following sample script adds a printer queue on the Solaris 2.6 platform. The
domain information expldomain and printer names printerl and printer2 are
hard coded in this example. The printer is a Xerox DCS model.

#!/bin/sh

echo "Please enter the Printer Name Either printerl or printer2\n"
read PRINTER

LOGFILE=/var/adm/config.log

PATH=/usr/bin: /usr/sbin: $PATH

export PRINTER LOGFILE PATH

lpsystem -t bsd expldomain >$LOGFILE 2>&1

lpadmin -p "SPRINTER" -s expldomain!"$PRINTER" -I any >SLOGFILE 2>&1
mkdir -p /usr/Xerox_DCS /usr/Xerox_DCS/original

chown -R 755 /usr/Xerox_DCS /usr/Xerox_DCS/original

cp /usr/bin/lp /usr/Xerox_DCS/original

mv /usr/bin/lp /usr/bin/lp.Xerox

In -s /tmp /usr/Xerox_DCS/tmp

echo "$PRINTER" > /usr/Xerox_DCS/printer.db

cp /usr/local/packages/dc99cc23.txt /usr/Xerox_DCS

In -s /usr/Xerox_DCS/dc99cc23.txt /usr/bin/lp

lpadmin -d "S$SPRINTER"

5.2.2 Verifying the Printer Setup for Oracle Reports

To verify that your printer queue installed correctly:

1. Ensure that the PPD or HPD file used with the installed printer queue is available
in the following location:

ORACLE_HOME/guicommon/tk/admin/PPD
ORACLE_HOME/guicommon/tk/admin/HPD
2. Ensure that the font metrics, AFM or TFM files, installed on the printer are

available in the following location:

ORACLE_HOME/guicommon/tk/admin/AFM
ORACLE_HOME/guicommon/tk/admin/TFM

5.3 Configuring the Printing Environment

This section explains the various configuration steps to be performed on UNIX after
printer installation.

=  Editing uiprint.txt File
s Environment Variables

= Print Property Dialog Boxes

5.3.1 Editing uiprint.txt File

As discussed in Section 5.1, "UNIX Printing Overview", Oracle Reports creates logical
printer drivers. To create these internal printer drivers, it needs information from you
like the available printer queue, the type of driver to be used with the queue, the
version of the driver, and the printer description file. uiprint.txt is the main file
for providing this information. It is located in:

ORACLE_HOME/guicommon/tk/admin
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uiprint.txt is the printer configuration file and Oracle Reports reads it when it
creates the internal printer drivers. You should modify this file for each instance of
Oracle Reports.

The format of entries in uiprint. txt is:

Printer:DriverType:DriverVersion:PrinterDescription:PrinterDescriptionFile:

This one line entry, in prescribed format, in uiprint. txt defines a printer to be used
by Oracle Reports. Each line contains five fields separated by colons. Table 5-1
describes each element of the uiprint. txt entry.

Table 5-1 uiprint.txt entry elements

Element Description

Printer Specifies the name of the printer (or printer queue), as used
with the 1pr or 1p command.

To get a list of all available printers, use the following
command:

Ipstat -a

To check the status of the printer, use the lpstat command:
Solaris

Ipstat -p printername
Linux

Ipstat -p printername
HP-UX

Ipstat -d printername
HP Tru64

Ipstat -p printername
IBM AIX

Ipstat -pprintername

No space is allowed after -p on IBM AIX.

DriverType Specifies the type of printer driver used for the printer. The
driver can be PostScript, PCL, or ASCIL

DriverVersion Specifies the version of the driver type that should be used.
This can be 1 or 2 for PostScript printers, and PCL Version 5 for
PCL.

PrinterDescription Specifies the description of the printer, for example, the speed

and the location of the printer. This information is used for
display in the printer-related dialog box.
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Table 5-1 (Cont.) uiprint.txt entry elements

Element Description

PrinterDescriptionFile Specifies the printer description file to be used with the printer.
It can be one of the following types:

= When using a PostScript printer, this entry contains the
name of a PPD file. PPD stands for PostScript Printer
Description. If Oracle Reports cannot find the specified
PPD file, it uses default . ppd. Oracle Reports searches
for PPD files in:

ORACLE_HOME/guicommon/tk/admin/PPD

= When using a PCL printer, this entry contains the name of
an HPD file. If Oracle Reports cannot find the specified
HPD file, it uses ui4 . hpd. Oracle Reports searches for
HPD files in:

ORACLE_HOME/guicommon/tk/admin/HPD

= When using an ASCII printer, this entry would be set to
none. This field is ignored for all ASCII printers.

Usage Note:

»  All the fields in the uiprint. txt entry must be filled and every line must end
with a colon.

= Atleast one entry must be defined in uiprint. txt. Alternatively, you can set the
related printer variables (TK_PRINTER and PRINTER). Without these, Oracle
Reports is unable to perform any printer-related task.

See Also: Section 5.3.2, "Environment Variables" for more
information on printer-related environment variables.

The internal printer drivers provide a drawing surface for Oracle Reports. In
addition to using this surface for printing, Oracle Reports uses it internally
whenever output is generated to a file. Hence, you need to have a valid entry in
uiprint.txt or to set one of the printer-related environment variables. To
simplify the selection of printers for your users, we recommended that you list all
printers accessible to users in uiprint. txt.

Example:
Following are two example entries for uiprint . txt:

colprtld:PostScript:2:RMSC Atrium HPLaserJetb:default.ppd:
colprtl5PCL:5:RMSC 1st Floor HPLaser4:uid.hpd:

5.3.2 Environment Variables

This section lists the environment variables related to printing:

See Also: Appendix B, "Environment Variables" for more
information on the environment variables that can be set in Oracle
Reports.

s TK PRINTER / PRINTER

s TK PRINTER

s TK_PRINT_STATUS
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= REPORTS_NO_DUMMY_PRINTER
» TK _HPD and ORACLE _HPD

» TK PPD and ORACLE_PPD

» TK TFM and ORACLE TFM

» TK_AFM and ORACLE_AFM

5.3.3 Print Property Dialog Boxes

On UNIX, Reports Builder provides several dialog boxes for printer-related
operations.

5.3.3.1 Page Setup dialog box

The Page Setup dialog box enables you to specify how the printed page appears. The
available options depend on the type of printer driver being used. The internal printer
drivers use this dialog box to get all the information necessary, (for example, scale,
rotation, width, and height) for formatting a page on a printer.

5.3.3.2 Print Job dialog box

Each print job has unique characteristics depending on the printer driver being used.
The Print Job dialog box displays just prior to print job execution and prompts you for
the print job information required to send the job to the printer.

5.4 Printer-Related Files

This section explains the different printing related files. It gives an overview of these
files and also provides information for editing these files for common printing needs.

= Overview of Files
= PPD Files

= HPD Files

= Font Metrics Files
= uifont.ali

= uiprint.txt

» Editing the Printer-Related Files

5.4.1 Overview of Files
Table 5-2 lists files used by Oracle Reports for printing on UNIX.

Table 5-2 Printer-related files overview

File name/extension Description

.ppd PostScript Printer Definition file
.hpd HP glue file

.afm Adobe font metrics file

.tfm PCL font metrics file
uifont.ali font aliasing file
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Table 5-2 (Cont.) Printer-related files overview

File name/extension Description
uiprint.txt printer configuration file
5.4.2 PPD Files

PostScript is Adobe's page description programming language. PPD files define what
capabilities a printer has for applications like Oracle Reports. For example, a PPD file
might define which paper tray to use, what paper sizes are available, what is the
physical dimension of the paper, and what font is available. Currently, Oracle Reports
reads the paper sizes and fonts available on the printer as well as its default resolution
from this file. In the future, more information may be used, such as memory for proper
image partitioning.

The only reason to modify the PPD file is to allow Oracle Reports to recognize newly
added fonts or memory. You can also change the DefaultPageSize to your
preferred page size.

Note: Page sizes, like all PPD entries, are case sensitive. Other
entries in the PPD file should generally be left undisturbed.

When you select a printer that is not listed in uiprint. txt or change the type of
printer to a PostScript type in the Choose Printer dialog box, you are prompted for the
PPD file for the printer. You must choose the PPD file for a printer that most closely
resembles the printer being used. PPD file names typically bear some resemblance to
the printer model name.

Inuiprint. txt, a PPD file must be specified for each printer. If an invalid PPD file is
specified for the current printer (for example, no PPD file is found or the PPD file
format is wrong), Oracle Reports will use default.ppd for that printer. You should
make default.ppd a copy of another PPD file that better reflects the most likely
default, local printer.

Oracle Reports includes a common set of PPD files, but sometimes you may need to
get specific PPD files for your printers from the vendor. Table 5-3 shows some
examples of PPD files that are shipped with Oracle Reports:

Table 5-3 Common PPD files shipped with Oracle Reports

PPD file name Corresponding Printer
appl230.ppd Apple LaserWriter v23.0
datap462.ppd Dataproducts LZR-2665
declps32.ppd Digital PrintServer 40
default.ppd Default Level 1 PostScript Printer
hpljet4dl.ppd HP LaserJet 4/4M PostScript 600DPI
lwntx470.ppd Apple LaserWriter Il NTX
nccps801.ppd NEC Colormate PS/80
tkphzr33.ppd Tektronix Phaser III PXi v2011.108
1530_523.ppd Linotronic 530
screenprinter.ppd Ble\ﬁl)l(llt PPD file to be used when a printer is not available on
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If you need a PPD file that is not among those shipped with Oracle Reports, you must
do one of the following (in order of preference):

= Ask the printer vendor for the PPD file.

= Download the PPD file from Adobe's Web site.

= Copy an existing PPD file and edit it.

= Ask Adobe for the PPD specs and write the PPD file.

The PostScript file only has the font information not the font metrics. Oracle Reports
refers to the AFM file installed for the font metrics information. The font vendors
provide these AFM files. Oracle Reports ships AFM files for some of the most
commonly used fonts. The printer must have the required font installed in order to
correctly print the PostScript file generated by Oracle Reports.

5.4.2.1 Local customization of PPD files

A PPD file is a static representation of the features of a printer. It contains default
factory settings. Once a printer is installed, features such as additional memory, paper
trays, and fonts may be added to the device. The task of managing a device is a
dynamic issue that requires keeping track of fonts downloaded to disk, error handlers,
RAM-based fonts and procedure sets, default device setup, and so forth. This kind of
device management is beyond the scope of PPD files. However, there are some
provisions for customizing the information contained in PPD files to adapt them to
local instances of printers or to specific applications when necessary.

Instead of modifying the original PPD file, another approach would be having a new
file having the local customization of certain parameters and refer to the primary file
for the remaining information. The local customization file must contain a reference to
the primary PPD file in this format:

*Include: "filename"

where filename is the name of the primary PPD file. This referencing allows a
system administrator to later replace the primary PPD file without forcing users to edit
their local customization files. A file referenced by the *Include keyword is treated
as though it were in the including (local customization) file.

For example, suppose that the default.ppd file is defined as:

*PPD-Adobe: "4.0"
*Include: "datap462.ppd"

*% Page definitions
*DefaultPageSize: Letter

*DefaultPageRegion: Letter

The primary PPD file is datap462 . ppd.

Administrators should change the name of the included file to conform to their site's
default printer type.

When a local customization file includes a primary PPD file, there might be several
instances of the same keyword in the composite file. Hence, the location of the primary
file in the customization file (beginning or end) is important and effects the changes
made by the customization file.
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5.4.3 HPD Files

HPD files provide functionality for PCL printers that is similar to what PPD files
provide for PostScript printers. HPD or HP glue files provide information on what
fonts are available for a PCL printer. The HPD file format can be found in the HP PCL5
Developer’s Guide.

Just as PostScript has AFM files, every HP font must have an associated TFM file. The
font vendor should provide TFM files and new fonts should be added to the HPD file
for your printer when installed. For a new font, you should specify the following fields
in the HPD file:

FONT={fontname}
/tfm={tfm-filename}

where
fontname is a descriptive name for the font.
tfm-filename is the base file name for the TFM file.

If the TFM file isn't specific enough, you can also specify the following after the FONT
field:

/ptsize={size {size ...}}

If the specified font is a bit mapped font but is listed in the TFM file as a scalable font,
you can limit the point sizes used by listing the acceptable sizes as follows:
/symset={symset {symset ...}}

This field limits the supported symbol sets to those listed. See the HP PCL
documentation for a list of recognized symbol sets.

Oracle Reports also supports the defaultpaper field for printing to PCL format.
This field can be used to set the defaultpaper to be used by the Toolkit. The format
of this field is:

<defaultpaper={papername}>

For example, the following sets the paper name to A4:

<defaultpaper=A4>

The paper name is case insensitive. If you specify defaultpaper in more than one
place, then the last instance of defaultpaper is used. If you specify a paper name
that is not supported by the printer, defaultpaper is ignored and LETTER is used as
the paper name instead. Similarly, if the paper name is incorrect, then LETTER is used.

5.4.4 Font Metrics Files

Oracle Reports supports two kinds of font metrics files:
= AFMfiles
= TFM files

5.4.4.1 AFM files

Each AFM files contains the font-related metrics for a single font. The metrics include
various font attributes such as style, weight, width, and character set. AFM files and a
description of the AFM file format are typically available from the font or printer
vendors.
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To install the AFM file, just copy it to the AFM file location, which is listed in
Section 5.2.2, "Verifying the Printer Setup for Oracle Reports". The name of the file
must match name of the font without the . afm extension. For example, if the font
name is CodedreineunBold, the file name must be CodedreineunBold.

To verify the font name, you can look for the fontname string in the AFM file. Please
note that the AFM files are not font files, they are metrics files, which give information
on how to properly format the characters for the printer. If you have an AFM file for a
font, but the font is not present on the printer, Oracle Reports cannot generate the
correct output on the printer because of the font metrics mismatch. You must ensure
that the font used to design the report is also available on the printer.

5.4.4.2 TFM files

PCL uses HPD and TFM files. The HPD file contains the list of available fonts for the
printer and each font refers to a TFM file. TFM files serve the same purpose as Adobe's
AFM files, with each file listing information about a single font. The HPD file is an
ASCII file, which can be edited, but the TFM file is a binary file, which cannot be
edited.

To use a new font in Oracle Reports and have it appear correctly in PCL output, you
need the HPD and TFM files for the printer. You can copy an HPD file from an
existing one, after you ensure it is suitable for your printer. The fonts specified in the
HPD file must be available on the printer.

Oracle Reports includes a common set of TFM files. If you need other font metrics files
for your printer, you should obtain them from your font or printer vendor. To install
the TFM file, just copy it to the TFM file location, which is listed in Section 5.2.2,
"Verifying the Printer Setup for Oracle Reports".

5.4.5 uifont.ali

The uifont.ali file defines the font aliases used by Oracle Reports. It is an
extremely useful tool for cross-platform development because it enables you to define
which fonts to substitute when a particular font is unavailable. ui font .ali is located
in:

ORACLE_HOME/guicommon/tk/admin

To alias a font, use the following syntax:

source_font = destination_font

For each font, you may also specify the following attributes:

face.size.style.weight.width.character_set

Styles may also be combined using a plus sign + to delimit the styles. For example:

Arial.Italic+Overstrike = Helvetica.l2.Italic.Bold

This entry maps any Arial font that has both Italic and Overstrike styles to a 12-point,
bold, and italic Helvetica font. Font faces can be case sensitive depending on the
platform and the surface; that is, printer or system.

See Also: Chapter 4, "Managing Fonts in Oracle Reports" for
more font-related information.
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5.4.6 uiprint.txt

uiprint.txt provides a convenient way for you to provide details about the printer
queue, such as the type of printer driver and the printer description. You should edit
uiprint. txt for each instance of Oracle Reports.

See Also: Section 5.3.1, "Editing uiprint.txt File" for more
information about uiprint. txt.

5.4.7 Editing the Printer-Related Files
This section describes how to edit the various print-related files:
» Editing PPD files
= Editing HPD files for PCL printing

5.4.7.1 Editing PPD files

In some cases, you may need to change certain attributes in your PPD file. The sections
that follow describe some of the attributes that you would commonly need to change:

s Changing the default paper size

s Changing the printer margin settings
= Adding a new font entry to PPD files
s Overriding the printer tray setting

5.4.7.1.1 Changing the default paper size Suppose that you need the page size to be A4
for some of your reports. On UNIX platforms, the printer driver is specified in
uiprint.txt and the default page size is not necessarily set to A4. For example,
hpljet4l.ppdhas LETTER as the default page size. Note that the default page size
setting for each printer queue is taken from the corresponding PPD file.

To set A4 as the default page size, you would do the following:

1. Edituiprint.txt to include a PostScript Printer Description file (extension is
.ppd) that supports the A4 page size. For example, you might include
hpljetdl.ppd.

2. Asabackup, make a copy of hpljet4l.ppd.
3. Addanentry touiprint.txt:

Printer_name: PostScript:1: the printer on floorl:hpljet4l.ppd

4. Edithpljet4l.ppd and change these settings as follows:

DefaultPageSize: A4
DefaultPageRegion: A4
DefaultImageableArea: A4
DefaultPaperDimension: A4

5.4.7.1.2 Changing the printer margin settings To change the margins, you need to modify
the ImageableArea section in the PPD file. ImageableArea provides the bounding box
of the area in which the printer may print for the page size named mediaOption. There
will be one statement for each named page size supported by the device.
*DefaultimageableArea provides the mediaOption name of the default imageable area.
Since there can be only one default page size, this value should be the same as the
value of *DefaultPageSize, *DefaultPageRegion, and *DefaultPaperDimension.
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The syntax for defining imageable area is as follows:

*ImageableArea mediaOption: "llx 1lly urx ury "
*DefaultImageableArea: mediaOption | Unknown

11 stands for lower left corner and ur for upper right corner. The bounding box value
of *ImageableArea is given as four real numbers, representing the x and y coordinates
of the lower left and upper right corners of the region, respectively, in the PostScript
language default user space coordinate system. The x and y axes of a given page size
correspond to the x and y axes of that page size in the *PaperDimension entry.

The imageable area is defined as the part of the page where the printer may actually
make marks. On some printers, the imageable area of a given page size varies as a
result of the current resolution, amount of memory, the direction of paper feed, and
other factors. In PPD files where the imageable area of a given page size can vary, the
imageable area recorded for that page size will be the intersection of all possible
imageable areas for that page size. This formula ensures that the available imageable
area is never smaller than that shown in the PPD file and all marks made within the
imageable area will be visible. It does, however, also mean that the imageable area in
the current configuration might actually be larger than the imageable area shown in
the PPD file.

The following table contains the option keywords currently registered for
mediaOption, which designates a given page size on a device:

Table 5-4 mediaOption keywords

mediaOption

(paper size) size (pts) size (mm) size (inches)
Letter 612 *792 2159*279.4 8511
Legal 612 * 1008 215.9 * 355.6 8.5%*14
Ledger 1224 * 792 431.8*279.4 17*11
Tabloid 792 * 1224 279.4 * 431.8 11*17

A3 842 * 1191 297 * 420 11.69 * 16.54
A4 595 * 842 210 * 297 8.27 * 11.69
A5 420 * 595 148 * 210 5.83 * 8.27
B4 729 * 1032 257 * 364 10.12 * 14.33
B5 516 * 729 182 * 257 7.17*10.12
Example

To change the margins of an A4 page in the default . ppd, you would perform the
following steps:

1. Modify the default page from Letter to A4 in the following sections:

*% Page definitions
*DefaultPageSize: A4
*PageSize Ad: " "

*$ These entries set up the frame buffer. Usually used with manual feed.
*DefaultPageRegion: A4
*PageRegion Ad: "A4"

*% These provide the physical dimensions of the paper (by keyword)
*Defaul tPaperDimension: A4

Printing on UNIX with Oracle Reports  5-13



Printer-Related Files

*PaperDimension A4d: "595 842"

2. Add the margin definition in the following sections:

*$ Imageable (writable) areas for each page size, in pixels
*DefaultImageableArea: A4
*ImageableArea Ad: "2 2 593 840 "

Note: All PPD entries are case sensitive.

5.4.7.1.3 Adding a new font entry to PPD files On PostScript printers, Oracle Reports only
enables you to use fonts known to be available on the printer. Since printers are rarely
available for personal requests on multiprocess operating systems, Oracle Reports gets
a complete list of fonts from the PPD file.

When a new font is installed on the printer, a corresponding font entry needs to be
added to the printer's PPD file. The format for a font entry is:

*Font {fontname}: {encoding} " ({version})" {charset}

where

{fontname} is the Adobe font face name as specified in PostScript.
{encoding} is the PostScript encoding name.

{version} is the FontInfo version number.

{charset} is the Adobe character set.

The encoding value has slightly different meanings depending on the font type. If
the encoding cannot be determined, the value of encoding may be set to unknown.
Fonts are usually re-encoded by applications to provide other encodings; the charset
value for each font indicates which encodings are possible for that font. For more
information, please refer to the PPD specification from Adobe.

When new fonts are added to the printer, the matching AFM files must also be added
to the font metrics directory. Oracle Reports requires the AFM files to get the actual
font attributes and properly place text on the printed page.

Example

Suppose you add a new font, CodedreineunBold, and need to edit the PPD file to
include the new font.

1. In the PPD file, search for:

*$ Font Information

2. For the new font, append the following at the end of the paragraph:

*Font CodedreineunBold: Standard "(00.1001)" Standard ROM
5.4.7.1.4 Overriding the printer tray setting The PostScript output generated by Oracle
Reports has the tray information embedded into it. The PPD file defines the default

tray to be used and is followed by the definitions of valid trays for the printer. To print
to a different tray, the DefaultInputSlot entry in the PPD file must be updated.

In the PPD file, you should find a section that lists the default tray and the valid input
slots. The section typically starts with a line like this one:

*OpenUI *InputSlot: <PickOne>
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The default tray entry looks like the following:

*DefaultInputSlot: Lower

The defined slots typically follow the default entry and look like the following:

*InputSlot Upper/Multipurpose Tray: "
*InputSlot Lower/Paper Cassette: "

The section ends with a line like the following:

*CloseUI: *InputSlot

You can set DefaultInputSlot to be any of the values in the list of defined slots.

5.4.7.2 Editing HPD files for PCL printing

In some cases, you may need to change certain attributes in you HPD file. The sections
that follow describe some of the attributes that you would commonly need to change:

= Changing the paper size
= Adding a new font entry
5.4.7.2.1 Changing the paper size For example, to change the papersize to A4, add the
following to the HPD file used:
<defaultpaper=A4>
5.4.7.2.2 Adding a new font entry As with PostScript's AFM files, every HP font must

have a TFM file in order for Oracle Reports to use it. The font vendor should provide
TFM files. You should add new fonts to the HPD file when you install them.

You must specify the following settings in the HPD file for any new font:

FONT={fontname} # {fontname} is a descriptive name for the font
/tfm={tfm-filename} # {tfm-filename} is the base filename for TFM file

Note: The font name entries in HPD files must be unique.

5.5 Globalization Support

This section explains multibyte character set printing support in Oracle Reports. It also
explains the IX and PASTA utilities, which are supported only for Oracle Reports
when installed and used in conjunction with Oracle Applications.

= Multibyte Character Set Printing
s Overview of IX and PASTA

5.5.1 Multibyte Character Set Printing

Oracle Reports does not currently support Unicode character sets in PostScript output.
As an alternative, you can use Oracle Reports PDF output (desformat=pdf), which
supports multibyte character sets, and print it.

Oracle Reports supports a set of encoding schemes for the AFM files for the multibyte
character sets.
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See Also: Chapter 4, "Managing Fonts in Oracle Reports" and
Chapter 6, "Using PDF in Oracle Reports" for more font-related
information.

The fonts must be installed on the printer that prints the PostScript report output.

Example

Suppose you build a report and its generated PostScript output contains a Chinese
character set. First, you need AFM and PPD files that adhere to the encoding scheme
for multibyte character sets. The destination printer must also have the required
Chinese fonts installed because the PostScript file generated by Oracle Reports on
UNIX does not have fonts embedded in it. The PostScript file contains only the font
name and the font metrics taken from the AFM files. If you try to send the report to a
printer that does not have the Chinese fonts installed, it will not print the Chinese
characters properly.

5.5.2 Overview of IX and PASTA

When installed and used with Oracle Applications, Oracle Reports includes utilities
for font embedding in PostScript output.

For character-mode reports, the utility is called PASTA. For bit-mapped reports, the
utility IX enables you to embed the fonts in the PostScript output, thereby allowing
you to print even if the font is not installed on the printer. Both PASTA and IX are
supported only for Oracle Reports used with Oracle Applications.

When used for character-mode reports, PASTA takes tagged character mode output
(generated through an appropriate prt file) and generates a PostScript rendition of it.
IX enables Oracle Reports to print PostScript bit-mapped reports for all character sets,
including UTF8, on a PostScript printer. With this functionality, PostScript printing in
Unicode as well as all native languages on UNIX is supported. The IX library is turned
off by default with the Oracle Reports patch.

Please refer to your Oracle Applications System Administrator’s Guide for the setup and
usage information for IX and PASTA with Oracle Reports. If you are a member of
Oracle Metalink (http://metalink.oracle.com), you can also get this
information from MetaLink notes 189708.1 and 159225.

If you have problems with PASTA, you can use the following technique to isolate the
problem:

1. Unset the PASTA environment variable.
2. Try to perform the steps that caused the problem again.

3. If the problem reproduces without the environment variable set, then it should be
treated as a normal Oracle Reports printing problem and the diagnostic steps
provided in this document should be applied.

If the problem reproduces only with the PASTA environment variable set, then
follow the diagnostic process given in the Oracle Applications documentation.

5.6 Debugging Options

This section explains the different environment variables and techniques available in
Oracle Reports for the debugging of UNIX printing problems.

» DEBUG_SLFIND
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s TK_DEBUG_POSTSCRIPT

5.6.1 DEBUG_SLFIND

If this environment variable is set, the file-finding routine lists what was searched for
and where Oracle Reports searched for it. This information is a tremendous help if
your current configuration does not work. You can send the output to a file, stdout
(for standard output), or to stderr (for output to standard error). If you try to send
the output to a file and it cannot be written to, Oracle Reports uses stderr instead.

We recommend sending the output to a file because it is faster and the output can be
quite large. Sample output from DEBUG_SLFIND is shown below. Notice how the
debug information generated helps you identify the various setup issues, such as
which PPD and AFM files are being referred to and their location.

You can see all of the following in this output:

s The various environment variables, such as TK_PPD and TK_AFM, and their
values.

s The resource files, such as the PPD and AFM, and their locations, which helps you
to determine if any are the missing.

s The default location of various resource files under ORACLE_HOME.

slsfindfile(): checking environment variable TK_PPD(8).
slsfindfile(): environment variable not set

slsfindfile(): checking environment variable ORACLE_PPD(10).
slsfindfile(): environment variable not set

slfpath(): looking up path

/oraclehome/guicommon/tk/admin/PPD/

slfexist(): testing /oraclehome/guicommon/tk/admin/PPD

slfexist(): testing /oraclehome/guicommon/tk/admin/PPD/default.ppd
slsfindfile() :returned
/oraclehome/guicommon/tk/admin/PPD/default.ppd

slfindfile(): type = 39 (AFM)slfindfile(): name = Courier-Bold

slsfindfile(): checking environment variable TK_AFM(8).
slsfindfile(): environment variable not set

slsfindfile(): checking environment variable ORACLE_AFM(10).
slsfindfile(): checking ORACLE_HOME environment variable.
slsfindfile(): environment variable set to /oraclehome (len=18)
slfpath(): looking up path/oraclehome/guicommon/tk/admin/AFM/
slfexist(): testing /oraclehome/guicommon/tk/admin/AFM

slfexist(): testing /oraclehome/guicommon/tk/admin/AFM/Courier-Bold

slsfindfile() :returned /oraclehome/guicommon/tk/admin/AFM/Courier-Bold

(
slfindfile(): name = uiprint.txt
slsfindfile(): checking ORACLE_HOME environment variable.
slfpath(): looking up path/oraclehome/guicommon/tk/admin/
slfexist(): testing /oraclehome/guicommon/tk/admin
slfexist(): testing /oraclehome/guicommon/tk/admin/uiprint.txt
slsfindfile(): returned /oraclehome/guicommon/tk/admin/uiprint.txt

5.6.2 TK_DEBUG_POSTSCRIPT

This variable effects the PostScript output generated by Oracle Reports. Table 5-5
shows the settings for this variable.
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Table 5-5 Settings for TK_DEBUG_POSTSCRIPT

Setting Description

Functions (Func) Function lists each toolkit function called in comments in the
PostScript output.

Long (L) Long produces more intelligible PostScript output but runs

much more slowly than normal PostScript generation.

Memory (Mem) Memory displays memory usage at the bottom of each page.

Any of the options can appear in the environment variable, abbreviated down to one
letter. You can set it to any combination of these, separated by "/". This variable is case
insensitive. For example, Func/L/Mem would give you all three options.

Note: The PostScript output from this variable is for your own
debugging purposes. You do not need to provide this output to
Oracle Support for investigation.

5.7 Frequently Asked Questions

This section addresses some commonly encountered problems with UNIX printing.

Common Printing Error Messages
PCL Printing Issues

PostScript Printing Issues
Font-Related Printing Issues

Printed Output Issues

Note: Reports Server uses the rwlpr executable for submitting a
print job. For rwlpr logging for Windows, when you enable
tracing for Reports Server using either traceModule=all or
traceModule=server, a printing diagnostic log (server._
name-rwlpr-jobid.log)is created in the log directory
(ORACLE_HOME\reports\logs\server_name\) for
destype=printer. This log file will contain information
regarding the messages that can be used to diagnose any printing
issues, such as spooler problem. For more information, refer to
Section 3.2.1.13, "trace".
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5.7.1 Common Printing Error Messages
REP-00177 - Error while running in remote server
REP-1800 - Formatter error
REP-3300 - Fatal error in ‘component hame
UI-9 - This function call is out of context.
REP-3002: Internal error initializing printer information

Cause:
These errors generally indicate a printer configuration issue.

Action:

Check the printer queues that have been defined at the operating system level in your
setup. You can use:

s 1lpc status

m lpstat -a

If a valid printer queue is installed, check for the following;:

= uiprint.txt musthave a valid entry for the printer.

s Oracle Reports must be able to open and read the uiprint. txt file:

The person running the report must have operating system level read permissions
onuiprint. txt. Oracle Reports must be able to open the uiprint. txt. UNIX
operating systems do have an open file limit. If you are over that limit, Oracle
Reports might not be able to open uiprint. txt.

s The printer description files specified in uiprint . txt must exist in your
installation in:

ORACLE_HOME/guicommon/tk/admin
»  The printer specified in uiprint. txt must be enabled at the operating system
level. A quick test is to try printing any file from the command line using 1p or

lpr. If you can print using one of these commands and get the output on the
printer, then the printer is enabled.

s The printer queue and uiprint . txt entry syntax must be valid.

If the printer validation fails, refer to the environment variables TK_PRINT_
STATUS and REPORTS_NO_DUMMY_PRINTER in Appendix B, "Environment
Variables".

REP-00826 - Invalid printer driver xxx specified by parameter desformat.
REP-00177 - Error while running in remote server (When run through CGl)
Cause:

An invalid value was specified for DESFORMAT for the specified report execution
mode.
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Solution:
The DESFORMAT parameter specifies which output format is needed. Valid formats are:

s For bit-mapped reports, any of the output formats supported by Oracle Reports
(PostScript, PCL, PDF, HTML, XML, HTMLCSS) is valid for DESFORMAT. You
should not give the PRT file names here. While running to a file, the DESFORMAT
parameter needs to be set to a valid printer queue. Oracle Reports uses the printer
definition file associated with the printer to format the output.

=  For character mode reports, DESFORMAT sets up the output for ASCII printers and
passes escape characters. For running character mode reports, ensure that you
change the MODE parameter to Character and use any valid .PRT file.

Table 5-6 maps the command line options (DESTYPE, DESNAME, and DESFORMAT) to
the printer by what you are trying to achieve.

Table 5-6 DESTYPE, DESNAME, and DESFORMAT settings by case

Case DESTYPE DESNAME DESFORMAT
Generating to a file FILE file name.ps printer name
Printing PRINTER printer name

DISTRIBUTE=YES printer_name
MODE=CHARACTER file name.prt

REP-01800 - Formatter error.

REP-00177 - Error while running in remote server
(When run through CGI)

Cause:

The error indicates that a printer configuration issue has occurred on a UNIX server.
Even if there is not a physical printer available on the system, you have to set it up as if
there was one.

Solution:

1. Verify that there is a valid entry in uiprint. txt.

2. If you have multiple printer queue entries in uiprint. txt and you need to set
the default printer, verify that the environment variable is set to a printer that is
listed in uiprint. txt. If the related environment variable is not set, then the first

entry in uiprint. txt is used. For more information on printer-related
environment variables, refer to Appendix B, "Environment Variables".

If there is no printer available for your system, refer to Section 5.3, "Configuring the
Printing Environment" for alternatives.

Error while printing to a printer with spaces in its name
Cause
If you are on Solaris 2.8 and have printers that have spaces in the names, you may

encounter a bug that causes an error resulting from the 1pr/lp command including
quotes around the printer name.
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Solution
To resolve this issue, you must do either one of the following:

Remove the spaces in the printer's name.

Install the Solaris 2.8 patch from Sun Microsystems that fixes the 1pr/1p
command so that quotes can be used in printers names.

and

Modify the section of rwlpr. sh that provides the workaround for including
quotes, in order to make accessible any printer that has a space in the name. The
rwlpr.sh file is located in the ORACLE_HOME/bin directory.

Specifically, make the following changes:

#either LPR or LP Command was found
if [ -x $PRNCMDPATH ]

then
if [ ‘basename $PRNCMDPATH' = "lpr" ]
then
#if [ " /usr/bin/uname -r' = "5.8" ]
#then
#SPRNCMDPATH ‘echo $@ | tr -d "\""°
#else
$PRNCMDPATH "$@"
#f1
else
# parse and Fix the command Line as Required by lp
#if [ " /usr/bin/uname -r' = "5.8" ]
#then
#getlpCommandLine ‘echo $@ | tr -4 "\""°
#else
getLpCommandLine "$@"
#f1
$PRNCMDPATH
fi

# exit with the command's exit code , This will tell the
# server Print module if the command completed successfully
# or not.
exit $°?
fi
done

Printing on Solaris 2.9

If you print a report using the DESTYPE=PRINTER and the DESNAME=printer_name
command line options on Solaris 2.9, you will encounter the following errors:

REP-0069: Internal error
REP-57054: Inprocess job terminated with error
REP-50157: Error while sending file to printer 20p837a.Exit with error code 1

To resolve this issue, you must do the following:

Note: Create a backup of the rwlpr. sh file before proceeding. On
Solaris, rwlpr . shis the printing script file located in the ORACLE_
HOME/bin/ directory. This script file supports 1p and 1pr commands
by default.
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1. Navigate to the following line at the end of the file:

#either LPR or LP Command was found

2. Add an OR operator to the existing if. . . else condition.

if [ ‘uname -r' = "5.8" ] || [ ‘uname -r' = "5.9" ] # If Solaris Release 5.8 /
5.9

else
# parse and Fix the command Line as Required by lp

if [ ‘uname -r' = "5.8" ] || [ ‘uname -r' = "5.9" ]# If Solaris Release
5.8/ 5.9

3. Theif...else if condition checks for the Solaris Release version. Based on
the version number, it strips the quotes from the printer name and passes it to the
print command.

5.7.2 PCL Printing Issues

Why do fields that appear as gray on my PC print as white on a UNIX PCL
printer?

PCL color printing is not supported. When the pattern is set to transparent, PCL
printing uses the white pen (in PCL language) to draw. When the pattern is set to a
solid pattern, it uses the black pen. This behavior occurs irrespective of what color is
set for the foreground or background. PostScript printing logic is different. It uses the
foreground color set when the pattern is solid and the background color set when the
pattern is transparent.

What PCL level is supported in Oracle Reports?

The Oracle Reports PCL driver currently supports the features of PCL Level 3. It does
support HPD files for later PCL versions, but it will not honor the additional features
introduced since PCL Level 3.

5.7.3 PostScript Printing Issues

What is the work around for duplex printing on PostScript printers?

You should have a printer with a duplex option and an appropriate PPD file. The
example that follows was tested with a PPD file for the Kyocera FS-9000 printer. You
also need the UNIX sed tool named to filter the output file.

The problem with duplexing is that it is enabled at the job level, but it gets reset in the
page setup because the paper size and printer tray information are generated for every
page. To work around this problem, you need a script that removes the page level
setup information to avoid resetting the duplex setting. A side effect of this work
around is that you cannot switch the printer tray between pages.

1. Write a sed script with the following three lines:

/~%%BeginPageSetup/,$ {
/~%%BeginFeature/, /"%%EndFeature/d

}

2, Save the script to a file named duplexsed.

3. Copy duplexsed to an appropriate directory, such as ORACLE_HOME/bin.
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4. Set the environment variable TK_PRINT as follows:

TK_PRINT="sed -f $ORACLE_HOME/bin/duplexsed | lpr -1 -s -P'%n' -#'%c'"
export TK_PRINT

Note: Print commands differ for various kinds of UNIX. Check
your installation guide and man pages for your platform. Refer to
Appendix B, "Environment Variables" for a description of TK_
PRINT.

The command stored in TK_PRINT is only executed if
DESTYPE=PRINTER. If DESTYPE=FILE, you still get a PostScript
file with page level setup information. You can run the duplexsed
script against the PostScript file to correct it.

What PostScript level is supported in Oracle Reports?
Oracle Reports supports PostScript Level 1 and 2.

How do you dynamically change the printer tray setting in the midst of a
print job?

In some cases, you may want to switch printer trays in the middle of a report. For
example, you might want the first page of a report printed on letterhead stationary
and subsequent pages printed on plain white paper. For character mode reports, you
can achieve this result through a combination of editing the .prt file and changing the
report's properties. For bit-mapped reports, you use the SRW. SET_PRINTER_TRAY
built-in procedure. On UNIX, this functionality is supported for PostScript output but
not PCL output. For PCL, Oracle Reports ignores the commands for changing
orientation and paper tray. Although dynamically changing the orientation and
printer tray for PCL is not supported on UNIX, you can change them at runtime
through the print dialog box for PCL.

By using the Before Report, Between Pages, or format triggers you can switch to
different printer trays as your report formats. This enables you to easily print pages of
the same report on different sheets of paper.

Note: For a description of the SRW built-in package, including the
SRW.SET_PRINTER_TRAY built-in procedure, see the Oracle
Reports online Help.

Example
From the BEFORE REPORT trigger, you can set the printer tray for the very first page:

function BeforeReport return boolean is
begin
srw.set_printer_tray('UPPER PAPER TRAY');
return (TRUE);
end;

To set the printer tray dynamically for subsequent pages, add a format Trigger to an
item that prints on each page of the report. The following code checks for even pages
and sets the page number accordingly:

function B_tbpFormatTrigger return boolean is
page_num number;
begin
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srw.get_page_num(page_num) ;

begin
if mod(page_num, 2) = 0 then
srw.set_printer_tray('UPPER PAPER TRAY');
else
srw.set_printer_tray('LOWER PAPER TRAY');
end if;
return (true);
end;
end;

Why does the external print command ignore the tray select option while
trying to print the PostScript output generated by Oracle Reports?

Suppose that you enter the following print command:

- lp -dprinter -oupper S$report_print_filel

In this case, the -~oupper option in the 1p command is ignored. The reason for this
behavior is that Oracle Reports generates tray information in its PostScript output. The
tray selection in the PostScript overrides the specification on the command line. If you
want the tray information on the command line to be respected, you need to remove

the tray information from the PostScript file. You can do this by searching for and
removing the following from your PostScript file:

%%BeginFeature: *InputSlot name of printer tray
%$%EndFeature

For more information on switching printer trays, refer to How do you dynamically
change the printer tray setting in the midst of a print job?

5.7.4 Font-Related Printing Issues

See Also:

s Chapter 4, "Managing Fonts in Oracle Reports" for more
font-related information.

s Chapter 7, "Resolving Cross-Platform Porting Issues" for
resolving cross-platform font issues.

How do you check whether a font is used in Oracle Reports printing?

PostScript files have a list of fonts, which is created after reading the PPD file. If you
examine the PostScript file, you can check the fonts by looking for the following tags:

s DocumentNeededResource has the list of fonts referenced in the PPD file.

s DocumentSuppliedResource has the list of fonts for which the PostScript
driver was able to find corresponding AFM files.

m  %%Page before the field's $IncludeResource: font has the font name that will
be used for the field.

For PCL output files, you can check whether a particular font was used. Depending on
this information, the font settings in Oracle Reports or the printer can be modified.
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What is the real difference between running reports to Screen and
Preview?

Formatting a report to Screen, for screen fonts, guarantees that the report will look
good in the Paper Design view of the Report Editor. If an attempt is made to print a
report formatted with screen fonts, though, it is likely to come out with some
differences because screen fonts typically map very poorly to printer fonts. If Preview
is selected instead of Screen, the report is formatted with printer fonts and the output
on the screen is almost certain to match the printed output.

Will there be any font issues if | do not have a valid printer installed?

Prior to Oracle Reports 10g on UNIX, you had to set the DISPLAY environment
variable in order for Reports Server to use the windowing system display surface for
creating images and getting pixel resolution. This dependency is removed with Oracle
Reports 10g.

Additionally, earlier releases required a valid printer on UNIX for fonts. When no
valid printer was available, OracleAS Reports Services used the screen fonts, which
again required setting the DISPLAY environment variable. Now, OracleAS Reports
Services includes a default screen printer surface, ScreenPrinter, that emulates a screen
or printer for fonts in the absence of an available printer. As a result, OracleAS Reports
Services no longer requires a printer on UNIX.

See Also: Chapter 3.10, "Removing DISPLAY and Printer
Dependencies on UNIX".

5.7.5 Printed Output Issues

Why does my report look okay on the screen but have truncated data when
printed?
Any one of a number of possible causes may account for the truncation of fields.

»  Check the field and determine if it is allowed to expand.

1. In Reports Builder, double-click the field in the Paper Design or Paper Layout
view to display the Property Inspector.

Find the Horizontal Elasticity property.

If it is set to Fixed, you should change it to Variable or Expand.

Run the report to the printer.

If it still truncates, it could be that the field requires multiple lines.

Return to the Property Inspector for the field and check its Vertical Elasticity.
If it is set to Fixed, you should change it to Variable or Expand.

©® N o a » 0 b

Run the report to the printer again.

»  If the right most fields on the page are always the ones truncating, it could be an
issue with the printable area of the printer. If you are using a PCL printer, then you
will have to estimate the size of the printable area and resize your margins
accordingly:

1. Open the report in Reports Builder.
2. Go to the Paper Layout view.

3. Click the Margin tool on the top tool bar. A thick black line appears indicating
where the body of your report ends and the margin begins.
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Click and drag the black line to the left approximately 0.5 inches.
Save and run the report to the printer again.

If necessary, repeat steps 4 and 5 to determine approximately where the
printable area boundary is located and then ensure that your report body fits
within that area.

s If you are using a PostScript printer, you can get the printable area boundary to
appear in the Paper Layout view as follows:

1.

o g & 0 b

8.
9.

Open the report in Reports Builder.

Choose File > Page Setup.

Verify that the margins are small and that the orientation is correct.

Click OK. The Paper Layout view should now be able to read the boundary.
Go to the Paper Layout view.

Click the Margin tool on the top tool bar. A thick black line appears indicating
where the body of your report ends and the margin begins. A black hashed
line also appears indicating the boundary of the printable area.

Ensure that the thick black line is inside of the black hashed line. If it is not,
click and drag the black line inside the printable area.

Click the Margin tool to leave margin mode.

If necessary, reposition your fields to fit within the new body boundaries.

10. Save and run the report to the printer.

s For PCL, if it is still truncating, try using a fixed space font instead of a
proportional font. Sometimes PCL printers have problems interpreting
proportional space fonts and it leads to truncation. You should try using a fixed
space font, such as Courier, and possibly font aliasing.

See Also: Chapter 4, "Managing Fonts in Oracle Reports" for
more font-related information.

Note: Default layouts are built against a generic printer. Each
printer has its own printable area. As a result, you may have to
reset the report to fit the printer. Ideally, if you know the various
printers you will be using, you can design the report from the start
to fit the printer with the smallest printable area.
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Using PDF in Oracle Reports

Adobe Portable Document Format (PDF) is a universal file format that preserves all
the fonts, formatting, graphics, and color, of any source document regardless of the

application and platform used to create it. Oracle Reports was one of the first report
generation tools to embrace this technology and generate quality PDF documents.

This chapter contains the following main sections:

PDF Features Included in Oracle Reports

This section contains information on the various PDF features supported by
Oracle Reports. This includes compression, font aliasing, font subsetting, font
embedding, accessibility, and taxonomy.

Resolving PDF Font Issues During Cross-Platform Deployment

This section contains information on resolving PDF font issues that occur when
you design a report on a Windows platform and deploy it on a UNIX platform.

Generating a Unicode PDF File

This section contains information on how to generate a PDF file using Unicode
character sets.

Generating a Bidirectional (BiDi) PDF File

This section contains information on how to generate a PDF file using bidirectional
(BiDi) languages such as Hebrew and Arabic.

Generating a Multibyte PDF File

This section contains information on how to generate a PDF file using multibyte
fonts.

Generating a Barcode PDF File

This section contains information on how to generate a PDF file that includes a
barcode.

6.1 PDF Features Included in Oracle Reports

Oracle Reports supports PDF 1.4 and is capable of generating high fidelity PDF reports
on all platforms. The PDF features supported by Oracle Reports include:

Compression
Font-Related Features
Precedence of Execution

Accessibility
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s Taxonomy

s Graph Support

6.1.1 Compression
PDF compression decreases the PDF file size, thereby reducing the time spent in
downloading the PDF file.

The amount of space saved using compression varies based on the contents of the
report, for example, the number of images versus the size of the content.

= Images: PDF compression does not significantly affect the size of files containing
images in it, as image files are typically already compressed.

= Formatted data: Highly formatted data can achieve higher compression rates.
However, actual compression rates will vary for each report.

Compressed files are about one fifth the size of the original file. Testing has shown that
the best case compression ratio of one-eigth to the worst case compression ratio of
one-half was achieved based on the contents in the original file.

6.1.1.1 Setup

By default, PDF output generated by Oracle Reports is compressed. To specify the
level of compression, use PDFCOMP on the command line. For more information, see
Section A.3.83, "PDFCOMP".

Although compressed files download quickly, the time taken to generate a compressed
file is much more when compared to a non-compressed file.

Figure 6—-1 Compressed Output Versus Non-Compressed Output

MName | Size | Tupe | Modified |
'@ pdf_no_comp.pdf T25KE  Adobe &crobat Doc... 3431/2003 5:02 P
'@ pdf_yes_comp.pdf 119KB  Adobe Acrobat Doc... 44342003 3:06 PM

Note: Compression rate depends on the report's content; thus, the
time taken to generate the PDF file as well as the PDF file size will
vary from report to report.

6.1.2 Font-Related Features
This section outlines the PDF font-related features supported by Oracle Reports:

= Font Aliasing
= Font Subsetting
= Font Embedding

s Font Feature Summary

6.1.2.1 Font Aliasing

Font aliasing enables you to substitute one font for another; that is, font-to-font
substitution. This font-to-font substitution is usually used when porting applications
(in this case, your PDF file) across platforms. You can alias multibyte fonts as well as
character sets. For font aliasing considerations when designing multilingual
applications, see Section 18.2.1.2.2, "Font Aliasing Considerations".
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Font aliasing occurs at the time of generating the PDF file. The PDF file will contain
only the necessary font information required to display the output. The fonts used will
not be embedded in the PDF file.

Note: The fonts must be available on the machine displaying the
PDF output. The fonts need not be available on the machine
generating the PDF file.

At the time of viewing the report, Adobe Acrobat replaces the aliased fonts based on
the following:

1. If the fonts do not exist on the machine displaying the output, Adobe Acrobat
substitutes it with the Adobe Sans MM font.

2. If the Adobe Sans MM font does not match, the output may display dots for the
data.

Font aliasing will work with any or all of the following;:

= Single byte fonts, including Eastern European fonts for both ASCII and IS0-Latin
character sets.

= Adobe multibyte Character ID (CID) fonts listed in Table 6-1, which are available
as a free download from Adobe.

s Typel PostScript fonts.
s TrueType fonts.

Table 6-1 outlines the mapping table between Oracle NLS_CHARACTERSET, CMap
name, and its CID font name used in PDF font aliasing for multibyte fonts.

Table 6—1 CID Font Mapping for PDF Font Aliasing
Oracle NLS
CHARACTERSET
Language name CMap name CIDFont name
JA16S]IS 90ms-RKSJ-H "KozMinPro-Regular-Acro" (*)
Japanese JA16EUC EUC-H "HeiseiKakuGo-W5-Acro” (**)
"HeiseiMin-W3-Acro" (**)
KO16KSC5601 KSC-EUC-H "HYSMyeongJoStd-Medium-Acro" (*)
Korean K016MSWIN949 KSCms-UHC-H "HYGothic-Medium-Acro" (**)
"HYSMyeong]Jo-Medium-Acro" (**)
ZHT32EUC CNS-EUC-H "MSungStd-Light-Acro” (*)
Traditional Chinese ZHT16BIG5, ETen-B5-H "MHei-Medium-Acro" (**)
ZHT16MSWIN950 "MSung-Light-Acro" (**)
ZHT16HKSCS HKscs-B5-H "MSungStd-Light-Acro” (*)
Simplified Chinese ZHS16CGB231280 GB-EUC-H "STSongStd-Light-Acro" (*)
ZHS16GBK GBK-EUC-H "STSong:-Light-Acro” (*)

(*) These fonts are available in Adobe Acrobat Reader 5.0 and later
(**) These fonts are available in Adobe Acrobat Reader 4.0 and later

It is recommended that you use Version 5.0 CID fonts (*) in order to avoid unexpected
font mapping, which results in multibyte characters overlapping. Version 5.0 fonts are
compatible with Adobe Acrobat Reader 5.0 and later.
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6.1.2.1.1 Setup
There are no command line keywords for font aliasing.

Include the font aliasing entries in the uifont.ali file. Oracle Reports aliases the
font only when the entries in the uifont .ali file match the font information
included in the generated PDF file.

Note: Theuifont.ali fileislocated in:
s ORACLE_HOME\tools\common (Windows)
s ORACLE_HOME/guicommon/tk/admin (UNIX)

The uifont.ali file is the configuration file controlling all the
Oracle Reports PDF font enhancements. See Chapter 4, "Managing
Fonts in Oracle Reports" for more information.

The section for font aliasing in the uifont.ali fileis [PDF].
The entry in the uifont.ali file for
= Single byte fonts

[PDF]
"font_name"="font_name"

Note: The font name entries should be enclosed within double
quotes for font names containing more than one word. For
example, "Brush Script MT".

= Multibyte fonts

[PDF]

character_set = "font_name"

or
"font_name"....character_set="font_name"

Note: The font name entries should be enclosed in double quotes
for font names containing more than one word. For example,
"HeiseiKakuGo-W5-Acro".

Here is an example of a font aliasing entry in the uifont.ali file:

[ PDF ]

/*Alias TrueType to available Typel font */
"Kino MT" = UtopiaBold

/*Alias multibyte to available CID font */
..... SJIS = "HeiseiKakuGo-W5-Acro"

where:

= "Kino MT" = UtopiaBoldsubstitutes every Kino MT character found with the
UtopiaBold equivalent.
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= ... SJIS = "HeiseiKakuGo-W5-Acro" substitutes every multibyte
character set found with the HeiseiKakuGo-W5-Acro (CID) equivalent.

6.1.2.1.2 Troubleshooting
If font aliasing does not work, verify that:

= In Acrobat Reader 6.0 and later, choose File > Document Properties > Fonts. (In
prior releases, beginning with Acrobat Reader 3.0, choose File > Document Info >
Fonts). Verify that the aliased font has been added to the list. If it is not included,
then font aliasing did not occur. The fonts were not found or the entry in the
uifont.ali file is incorrect.

= The fonts specified for the report are available on the machine where the report
will be viewed.

s The [PDF] section name in the uifont.ali file has not been modified as Oracle
Reports parses the file for the section name.

s The version of the Adobe Acrobat Reader used for viewing is 3.0 or higher, as
required for multibyte character reports to display properly.

6.1.2.2 Font Subsetting

With font subsetting, the PDF file includes the font information needed to render the
PDF, regardless of the availability of that font on the machine used to view the report.
PDF font subsetting works for single byte, multibyte, and Unicode fonts and is the
preferred method of creating multibyte reports.

When you subset a font in a PDF file, it becomes a custom font because it contains only
those characters needed for the report output.

PDF font subsetting enhancements in Oracle Reports 10g Release 2 (10.1.2) generate
PDF documents with improved readability.

Note: You can modify the PDF file if you have:

1. The fonts used in the report installed on your machine.
2. A PDF writer.

6.1.2.2.1 Setup
Before using font subsetting, you must:

s Include the font file paths in the REPORTS_PATH environment variable. Oracle
Reports looks for fonts in the path specified in the REPORTS_PATH environment
variable when generating a PDF file.

s Include the font subsetting entries in the uifont.ali file. Oracle Reports subsets
the fonts only when the font entries listed in the uifont.ali file exist in the PDF
file being generated.

Note: Theuifont.ali fileis located in:
m ORACLE_HOME\tools\common (Windows)

s ORACLE_HOME/guicommon/tk/admin (UNIX)

The section for font subset in the uifont.ali fileis [PDF:Subset] and the entry is:
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[PDF: Subset]
font_name = "font_file name"

where

font_name is the font name, which must be enclosed in quotes if it contains more
than one word.

font_file name is the font file name, which must always be enclosed in quotes, and
is case_sensitive. If it does not exactly match the existing font file name, Oracle
Reports generates a REP-1924 error.

The path for the font files should be ORACLE_HOME/reports/ font_folder. Add
the font file's path to the REPORTS_PATH environment variable.

Note: The font_file_name isnot the font name displayed in
Reports Builder.

Example 1

[PDF: Subset]
Arial = "Arial.ttf"

To use TrueType fonts in a TrueType Collection (. ttc) file, the syntax for the entry in
the [PDF: Subset] sectioninuifont.ali is:

[PDF: Subset]
font_name = "ttc_file name|, table_directory_number]"

where

font_name is the font name, which must be enclosed in quotes if it contains more
than one word.

ttc_file_nameis a TrueType Collection file name.

table_directory_number is the Table Directory number for the TrueType font in a
TrueType Collection file, using a zero-based index (for example, "MS PGothic" =
"msgothic. ttc, 1" indicates that Oracle Reports should use the second font in the
TrueType Collection file). If the table directory_number is omitted or if you
supply an invalid value, Oracle Reports will always subset the first font program in
the TrueType Collection file.

Example 2

[PDF: Subset]

"MS PGothic" = "msgothic.ttc,1"
"MS UI Gothic" = "msgothic.ttc,2"

Table 6-2 shows the font name and Table Directory number values for common East
Asian TrueType Collection files on the Windows platform.
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Table 6-2 Common East Asian TrueType Collection Files on the Windows Platform

Table Directory

TTC file name Font Name Number
batang.ttc Batang 0
BatangChe 1
Gungsuh 2
GungsuhChe 3
gulim.ttc Gulim 0
GulimChe 1
Dotum 2
DotumChe 3
mingliu.ttc MingLiU 0
PMingLiU 1
msgothic.ttc MS Gothic 0
MS PGothic 1
MS UI Gothic 2
msmincho. ttc MS Mincho 0
MS PMincho 1
simsun.ttc SimSun 0
NSimSun 1

You can view the fonts used in your reports as follows:

= In Acrobat Reader 6.0 and later, choose File > Document Properties > Fonts. (In
prior releases, beginning with Acrobat Reader 3.0, choose File > Document Info >
Fonts.)

s The Document Font dialog box displays Original Font, Type, Encoding, Actual
Font (or the font used), and Type.

Figure 6—2 Font Subsetting

x|
Fonts in: - pdffilename=eula.pdf
Original Fonk Type Encoding Actual Font Type
MSPGothic TrueType (CID) Idenkity-H Embedded Subset TrueType ;I

List all Fonts.., |
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Note: In the case of font subsetting:

s The Encoding column will display Identity-H.

»  The Actual Font column will display Embedded Subset.
s The Type column will display TrueType.

6.1.2.2.2 Backward Compatibility You can set environment variable REPORTS_
ENHANCED_ SUBSET=NO to revert to the implementation of font subsetting used in
releases prior to Oracle Reports 10g Release 2 (10.1.2); that is, Type3 fonts.

Note: For more information, refer to Section B.1.42, "REPORTS_
ENHANCED_SUBSET".

If you set REPORTS_ENHANCED_SUBSET=NO, to ensure optimum viewing, use Adobe
Acrobat Reader and perform the following steps:

1. Choose Edit > Preferences > Page Display.

2. Select Smooth Text, Smooth Line Art, and Smooth Images.
3. (Laptop/LCD Screens) Select the Use CoolType check box.
4. Click OK.

Note: These steps are valid for Adobe Acrobat Reader 7.0.

Refer to Section 6.2.2, "Designing and Deploying a Report on Different Platforms" for
more information on running a report on UNIX machines.

6.1.2.2.3 Troubleshooting If font subsetting does not work, verify the following:

= The fonts you use in the report have bold, italic, and bold italic versions. If you
have used italic or bold styles in the report, with PDF font subsetting, and you do
not see italic or bold styles in the output, check the Windows TTF files. On
Windows, there are some fonts that have bold, italic, and bold italic versions. For
example, Arial has arialbd. ttf (Arial bold), ariali. ttf (Arialitalic), and
arialbi.ttf (Arial bold italic), while some other fonts, such as Arial Unicode
MS (arialuni. ttf), do not have any bold or italic versions. For fonts that do not
have bold or italic versions, Windows synthesizes bold or italic styles from the
main font file while displaying, as does Oracle Reports on Windows. These styles
are preserved in HTML/HTMLCSS, RTE, and PDF (without PDF subsetting or
embedding) outputs. However, while doing the PDF subsetting or embedding,
since actual font glyphs are included in the report, Oracle Reports needs the TTF
files that contain styles; that is, to include the bold style for Arial in the report, it
would need arialbd. tt£. But for fonts such as Arial Unicode MS that do not
have such TTF files, PDF subsetted output will not have bold or italic styles.

s The Actual Font value is Embedded Subset and Type is TrueType (in Acrobat
Reader 6.0 and later, choose File > Document Properties > Fonts; in prior releases,
beginning with Acrobat Reader 3.0, choose File > Document Info > Fonts). If this
is not specified, then font subsetting is not implemented. The problem could be
either that the fonts were not found or the entry in the ui font .ali file is
incorrect
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s The font file names are valid.

= The case of the font file name matches the case defined in the file.

s The font types are TrueType; that is, filename.ttf or filename.ttc.

s The font name is enclosed in double quotes if it consists of two or more words.
= The font name does not contain embedded parenthesis.

s The font files are located in the path specified by the REPORTS_PATH environment
variable. When generating a PDF file, Oracle Reports looks for fonts in the path
specified in the REPORTS_PATH environment variable.

s The font names are correct and are available on the machine where the PDF file is
generated.

s The [PDF:Subset]section name in the uifont.ali file has not been modified.
Oracle Reports parses the file looking for the section name.

s The version of the Adobe Acrobat Reader used for viewing is 3.0 or higher, as
required for multibyte character reports to display correctly.

s The value of the REPORTS_ENHANCED_SUBSET environment variable is set to
YES. If REPORTS_ENHANCED_SUBSET=NO, Oracle Reports reverts to the earlier
implementation of font subsetting, using Type3 fonts to create a PDF document.
Type3 fonts are imaged characters that look slightly bolder than they would if
expressed as a Typel font. See Section 6.1.2.2.2, "Backward Compatibility" for more
information on improving the viewing quality.

s Thereis a limitation on UNIX platforms when working with TrueType fonts. Refer
to Section 6.2.2, "Designing and Deploying a Report on Different Platforms" for
more information on running a report on UNIX machines.

6.1.2.3 Font Embedding

PDF font embedding is the process of including the entire font set along with the data
in the PDF file. PDF font subsetting and font embedding are mutually exclusive.

Note: Font embedding will work only if the fonts are included in
the PDF file. Font embedding increases your PDF file size.

PDF font embedding in Oracle Reports is for Typel fonts only (single byte fonts) and
not for TrueType fonts. Convert TrueType fonts to Typel fonts using available 3rd
party tools in order to include specific Typel fonts in your report.

PDF font embedding with Oracle Reports occurs between a font and a set of font file
names.

Note: You must ensure that you have the necessary font licenses
before embedding any fonts in your output.

6.1.2.3.1 Setup
The setup for PDF embedding includes:
= A command line keyword: PDFEMBED

= A uifont.ali File Entry: [ PDF : Embed]
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PDFEMBED

The command line keyword PDFEMBED is used to specify whether Oracle Reports will
embed the Typel PostScript fonts specified in the uifont.ali file into the PDF
output. For more information, see Section A.3.84, "PDFEMBED".

uifont.ali File Entry
The section for font aliasing in the uifont.ali fileis [PDF : Embed].

(Windows only) The entry in the uifont.ali file should be:

font_name = "font_name.pfm font_name.pfb"

(UNIX only) The entry in the uifont.ali file should be:

font_name = "font_name.afm font_name.pfa"

Example 6-1 Font Embedding

[PDF : Embed]
Symbol = "Symbol.pfm Symbol.pfb"

In Example 6-1, the Symbol font is embedded into the PDF file. This ensures
portability by:

1. Creating the report with the Symbol font.

2. Embedding the Symbol font in the PDF file (Figure 6-3).

Figure 6-3 Font Embedding

Document Fonts

Fontsin:  embedded. pdf

Original Fonk Type Encoding Ackual Font Type

Symbal Type 1 Builk-in Embedded Type 1 J

List all Fonts. ..

6.1.2.3.2 Troubleshooting
If PDF font embedding does not work, verify the following:

= In Acrobat Reader 6.0 and later, choose File > Document Properties > Fonts. (In
prior releases, beginning with Acrobat Reader 3.0, choose File > Document Info >
Fonts). Verify that the embedded font has been added to the list. If the font has not
been added, then font embedding did not occur. The problem could be either that
the fonts were not found or the entry in the uifont . ali file is incorrect.

s The correct font file name is used.

= The font path specified in the REPORTS_PATH environment variable is correct.
When generating the PDF file, Oracle Reports looks for fonts in the paths specified
in the REPORTS_PATH environment variable.

s The font type is a Typel font.

s The font name is enclosed within double quotes if it consists of 2 or more words.
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s The [PDF:Embed] section name in the uifont.ali file has not been modified.
Oracle Reports parses the file looking for the section name.

s The format to specify the embedded font is valid:

font_name="fontfilename.pfm/.afm file fontfilename.pfb/.pfa file".

For example (Windows):

UtopiaMediumItalic = "UtopiaMediumItalic.pfm UtopiaMediumItalic.pfb"

m The font name is correct and available on the machine where the PDF file is
generated.

6.1.2.4 Font Feature Summary

Table 6-3 summarizes the advantages and disadvantages of font aliasing, font
embedding, and font subsetting.

Table 6-3 Comparison of PDF Font Features

PDF Type Advantage Disadvantage

Font Aliasing Multibyte support Unicode character set

Good display not supported

Asian Font Packs are

Small file size (Japanese required on the client

example; 23kb for font L o
N machine, if the client's
aliasing when compared . d
to 130kb for font operating system an
. Acrobat Reader are not
subsetting) th . .
e native version.
Limited fonts support .
For example, there is no
support for font
emphasis.
Font Embedding  Guaranteed display Only single byte support
provided.
Large file size.
Font Subsetting Unicode support No styles (Italic and
Guaranteed display Bold) support

Generated file is
searchable and editable
using Adobe Acrobat.

6.1.3 Precedence of Execution

The precedence order for the same font in multiple places within the uifont.ali file
is as follows:

1. Font aliasing takes precedence over font embedding (highest).
2. Font subsetting takes over font embedding (intermediate).
3. Font embedding takes no precendence (lowest).

For example, if you have included the same font entries for both font embedding and
font subsetting, then font subsetting will override font embedding. This is assuming
you have not set the command line option PDFEMBED=NO.

For all font features —font aliasing, font subsetting, and font embedding—include the
specific entries first followed by the generic entries. For example, if you want to subset
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Arial Plain, Arial Bold, Arial Italic, and Arial Bold-Italic fonts, your entries should be
in the following order:

[ PDF:Subset ]

Arial..Italic.Bold.. = "Arialbi.ttf"

Arial...Bold.. = "Arialb.ttf"

Arial..Italic... = "Ariali.ttf"

Arial..... = "Arial.ttf"

If the plain Arial..... = "Arial.ttf" entry appears first, then all the styles of

the Arial font in the layout will be subset as Arial Plain font. Here is a sample of a
portion of the uifont.ali file for all the PDF entries containing all three PDF
sections:

Sample 1

[ PDF ]

Palatino = "Kino MT.ttf"
[ PDF:Subset ]

Garmond. .Italic.Bold.. =
"Garmacbi.ttf"

Garmond. ..Bold.. = "Garmacb.ttf"
Garmond..Italic... = "Garmaci.ttf"
Garmond..... = "Garamac.ttf"

[ PDF:Embed ]

Arial = "Arial.pfm Arial.pfb"

Sample 2

[PDF]

Arial.10.Italic = "Times New Roman".12.Italic.Bold
"Courier New" = Symbol

[ PDF : Embed]

"Times New Roman".14..Bold = "TimesBold.pfm TimesBold.pfb"
[PDF: Subset]

Verdana..Italic.Bold = "Verdanaz.ttf"

Verdana..Bold = "Verdanab.ttf"

6.1.4 Accessibility

Oracle Reports provides several ways for you to include accessibility features in your
PDF file. The PDF format file follows the tagged-PDF standard defined in PDF 1.4.
This standard along with Acrobat Reader 5 (or higher) provides you with features for
inclusion in the paper layout.

For information on enabling accessibility-related features offered through Oracle
Reports from the command line, see Section A.3.1, "ACCESSIBLE". For information
about using the Oracle Reports accessibility properties designed to make PDF report
output accessible to the disabled community (Alternative Text, Headers, ID, Report
Language, and Table Caption properties), see the Oracle Reports online Help.

Additionally, refer to Chapter 43, "Building an Accessible JSP-based Web Report" in
the Oracle Reports Building Reports manual, and to the Oracle accessiblity site on OTN
(http://www.oracle.com/accessibility/index.html), where you can learn
more about accessibility and find the Creating Accessible Enterprise Reports Using Oracle
Reports white paper.
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6.1.5 Taxonomy

A PDF document can include global information about itself such as the document's
title, author, creation and modification dates. This global information proves useful at
the time of cataloging or searching for documents in external databases.

Oracle Reports provides report-level properties to enable such a classification, known
as taxonomy. They are:

n Title
s Author
= Subject

= Keywords

Table 6-4 Taxonomy Properties

Property

Name Type Description Default Value

Title String Document title ~ PDF document

name

Author String Document's Oracle Reports
author

Subject String Document's None
subject

Keywords  String Specifies None
keywords that

can be used to
categorize the
document

Refer to the Oracle Reports online Help for more information on the taxonomy
properties.

6.1.6 Graph Support

Oracle Reports provides the capability to specify the dots per inch (DPI) value for the
image resolution of the graph in PDF output. This enables you to scale the graph
without compromising on the image quality.

For more information, see Section B.1.43, "REPORTS_GRAPH_IMAGE_DPI" and
Section B.1.45, "REPORTS_JPEG_QUALITY_FACTOR".

6.2 Resolving PDF Font Issues During Cross-Platform Deployment

There are font and text alignment issues when you design a report (single byte or
multibyte) on the Windows platform and deploy it on a UNIX platform. The reason is
that the font handling and windowing system are completely different across the two
platforms.

6.2.1 Designing and Deploying a Report on the Same Platform

If your report is designed and deployed on the same platform (for example,
Windows):

»  There should be no font or text alignment issues in the PDF file.
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s If the PDF file is generated with font subsetting enabled, then the PDF file can be
viewed in the same manner across platforms.

6.2.2 Designing and Deploying a Report on Different Platforms

If your report is designed on the Windows platform and deployed on the UNIX
platform:

(Windows) You use the TrueType fonts located on the Windows machine (usually in
$windir%/fonts). Oracle Reports queries the font information from the Windows
system for formatting the report.

(UNIX) When the report is sent to PDF on a UNIX platform, there are two stages:

1. Oracle Reports renders the font metrics information for the fonts and uses this
information to format various objects in the report.

Note: Oracle Reports renders the font metrics information from
the AFM files specified in the printer's PPD file.

2. Oracle Reports then looks for the entries in the [PDF] section of the uifont.ali
file. For font subsetting, Oracle Reports refers to the [PDF: Subset]section and
subsets the TrueType fonts from the given location. The subsetted fonts are then
embedded in the PDF file.

Note: The corresponding AFM files for all the TrueType fonts used
in your report should be available on the UNIX machine to ensure
adequate formatting is enforced.

6.2.2.1 Generating a PDF Report Using Single Byte Fonts

This section outlines the steps involved in generating a PDF report (using single byte
fonts) designed on the Windows or UNIX platform. These steps are required only if
you see font alignment issues in your PDF output. Before using the font features
covered in this section, refer to Table 6-3 to determine which feature best suits your
application needs.

This example uses PDF font subsettting:

1. Create a report on the Windows platform with TrueType fonts. For this procedure,
the fonts referred to are arial.ttf and tahoma.ttf.

2. Copy the fonts (arial.ttf and tahoma. ttf)and your report's . rdf file to the
UNIX platform. The path for the font files should be ORACLE_
HOME/reports/font_folder. Add the font file's path to the REPORTS_PATH
environment variable.

3. Create the AFM files for the font files (arial.ttf and tahoma.ttf) usinga
freely available utility, such as tt £2pt1. Do not attempt to convert to a TFM file,
as this may not produce reliable results.

4. Copy the AFM files (arial.afmand tahoma.afm) generated to ORACLE_
HOME/guicommon/tk/admin/AFM.
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Note: The AFM files should be copied to the AFM directory
without the . afm extension. Additionally, ensure that the name of
AFM file, the name of the font in the PPD file, and the name of the
font the uifont.ali file are an exact match.

5. Edit the screenprinter.ppd file with any text editor.

Note: If you have defined a default printer by including an entry in
ORACLE_HOME/guicommon/tk/admin/uiprint. txt, then you
will have to make the appropriate entries in the printer's PPD file for a
PostScript printer or in the HPD file for a PCL printer.

Beginning with Oracle Reports 10g Release 1 (9.0.4), a default printer
surface that mimics the screen (screenprinter.ppd) is used for
formatting if you have not set up a default printer. You will also need
to make the necessary font and resolution entries in the
screenprinter.ppd file, if you have not set up a default printer.

The PPD files are located at:

ORACLE_HOME/guicommon/tk/admin/PPD
The HPD files are located at:

ORACLE_HOME/guicommon/tk/admin/HPD

Refer to Section 3.10.1, "ScreenPrinter" for more information on the
screenprinter.ppd file.

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report. PPD/HPD files are configuration files containing
printer driver settings and the list of all the fonts supported by the printer.

Navigate to the to the Font Information section in the PPD file and add the
necessary entries for the font files in the following format:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard " (Version 2.76)" Standard ROM

Ensure that the AFM file name exactly matches the font name specified in the PPD
file as Oracle Reports searches for this file based on the font name in the PPD file.

6. Ensure that the uiprint. txt file has the following entry:

printer name:PostScript:2:test:default.ppd:

For example:

hrprinter:PostScript:2:test:default.ppd:

7. Add the AFM entries to the PPD file.

Note: This PPD file is the first entry in the uiprint. txt file and
contains your font information. The default PPD file is
datap462.ppd.
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10.

11.

*Font arial: Standard "(001.001)" Standard ROM
*Font tahoma: Standard " (001.001)" Standard ROM

Ensure that there are no entries in the [PDF : Subset] section at this time in the
uifont.ali file.

Run the report to generate the PDF file. In Acrobat Reader 6.0 and later, choose
File > Document Properties > Fonts. (In prior releases, beginning with Acrobat
Reader 3.0, choose File > Document Info > Fonts):

a. The Original Font column displays the Arial and Tahoma fonts.
b. There will be some font alignment issues.

Add the following entry in the uifont.ali file:

[ PDF:Subset ]
"arial" = "arial.ttf"
"tahoma" = "tahoma.ttf"

Run the report again to generate the PDF file. The PDF file should not contain any
font alignment issues.

To confirm that the fonts are subset in the PDF file:

a. In Acrobat Reader 6.0 and later, choose File > Document Properties > Fonts.
(In prior releases, beginning with Acrobat Reader 3.0, choose File > Document
Info > Fonts).

b. The Original Font column should display the font name, the Encoding
column should display Identity-H, and the Type column should display
TrueType.

6.2.2.2 Generating a PDF Report Using Multibyte and Unicode Fonts

There are additional steps for generating reports with multibyte and Unicode fonts.
Before using the font features covered in this section, refer to Table 6-3 to determine
which feature best suits your application needs.

The steps involved in resolving font issues with PDF font subsetting when deploying
multibyte and Unicode reports on UNIX platforms are as follows:

1.

Create a report on the Windows platform using TrueType multibyte fonts with the
appropriate character set. For this procedure the font and the character sets
referred to are the Korean font h2mjsm. ttf and the KO16KSC5601 character set.

Copy the Korean font h2mjsm. tt £ and your report's . rdf file to the UNIX
platform. The font file path should be $SORACLE_HOME/reports/font_folder.
Add the font file's path to the REPORTS_PATH environment variable.

Create the AFM files for the Korean font h2mjsm. ttf.
Copy the AFM file to the following location:

$SORACLE_HOME/guicommon/tk/admin/AFM/ .
% cp h2mjsm.afm ORACLE_HOME/guicommon/tk/admin/AFM/h2mjsm

Edit the screenprinter.ppd file with any text editor.
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Note: If you have defined a default printer by including an entry in
ORACLE_HOME/guicommon/tk/admin/uiprint. txt, then you
will have to make the appropriate entries in the printer's PPD file for a
PostScript printer or in the HPD file for a PCL printer.

Beginning with Oracle Reports 10g Release 1 (9.0.4), a default printer
surface that mimics the screen (screenprinter.ppd) is used for
formatting if you have not set up a default printer. You will also need
to make the necessary font and resolution entries in the
screenprinter.ppd file, if you have not set up a default printer.

The PPD files are located at:

ORACLE_HOME/guicommon/tk/admin/PPD
The HPD files are located at:

ORACLE_HOME/guicommon/tk/admin/HPD

Refer to Section 3.10.1, "ScreenPrinter" for more information on the
screenprinter.ppd file.

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report. PPD/HPD files are configuration files containing
printer driver settings and the list of all the fonts supported by the printer.

Navigate to the to the Font Information section in the PPD file and add the
necessary entries for the font files in the following format:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard " (Version 2.76)" Standard ROM

Ensure that the AFM file name exactly matches the font name specified in the PPD
file as Oracle Reports searches for this file based on the font name in the PPD file.

Ensure the uiprint . txt file has the following entry:

printer name:PostScript:2:test:default.ppd:

For example:

hrprinter:PostScript:2:test:default.ppd:

Add the following lines in the PPD file:

Note: This PPD file is the first entry in the uiprint. txt file and
contains your font information. The default PPD file is
datap462.ppd.

*DefaultFont: h2mjsm
*Font h2mjsm: Special "(001.001)" Special ROM

Comment the Symbol line in the file:

*$Font Symbol: Special "(001.001)" Special ROM
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9.

10.

11.

12.

13.

Edit the following section in the uifont .ali file to mention the font used for the
character set:

Note: Theuifont.ali fileislocated in:
s ORACLE_HOME\tools\common (Windows)
s ORACLE_HOME/guicommon/tk/admin (UNIX)

The uifont.ali file is the configuration file controlling all the
Oracle Reports PDF font enhancements. Refer to Chapter 4,
"Managing Fonts in Oracle Reports" for more information.

[ Global ]

..... kol6ksc5601 ="h2mjsm"
[ Printer:PostScript2 ]
..... kol6ksc5601 ="h2mjsm"

Ensure that there are no entries in any of the [PDF] or [PDF:Subset] sections at
this time in the uifont.ali file.

Run the report to generate the PDF file. In Acrobat Reader 6.0 and later, choose
File > Document Properties > Fonts. (In prior releases, beginning with Acrobat
Reader 3.0, choose File > Document Info > Fonts):

a. The Original Font column displays the h2mjsm font.
b. There will be some font alignment issues.
Add the following entries in the uifont.ali file to enable PDF subsetting:

[ PDF:Subset ]
"h2mjsm"="h2mjsm.ttf"

Run the report again to generate the PDF file. The PDF file should not contain any
font alignment issues.

To confirm that the fonts are subset in the PDF file:

a. In Acrobat Reader 6.0 and later, choose File > Document Properties > Fonts.
(In prior releases, beginning with Acrobat Reader 3.0, choose File > Document
Info > Fonts).

b. The Original Font column should display the font name, the Encoding
column should display Identity-H, and the Type column should display
TrueType.

Note: There might be some variations in the alignment, as the font
metrics handling is different in UNIX and Windows. An alternative
is to purchase the proper AFM file from a font vendor. The AFM
file generated by a third party utility may not have exactly similar
font metrics as the font used on the design platform.

A PDF file generated with the font subsetting enabled should not
have any font style issues. However, if you have set REPORTS_
ENHANCED_ SUBSET=NO, then you might see some font style issues
(for example, some content may be displayed as bold) when
viewed in Acrobat Reader. See Section 6.1.2.2.2, "Backward
Compatibility" for more information on how to smoothen the
display for Type3 fonts.
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6.3 Generating a Unicode PDF File

This section outlines the steps involved in generating a PDF file with a Unicode
character set. Before using the font features covered in this section, refer to Table 6-3 to
determine which feature best suits your application needs.

6.3.1 Font Subsetting

The steps involved in generating a Unicode PDF file using the font subsetting feature
are as follows:

1.
2.

Set NLS_LANG=AMERICAN_AMERICA.UTFS.

Set REPORTS_PATH to the font directory in which the TrueType font exists. For
example, C: \WINNT\ fonts.

Open the uifont.ali file and edit the [PDF: Subset] section to specify the
TrueType font name.

Note: Theuifont.ali fileis located in:
s ORACLE_HOME\tools\common (Windows)

s ORACLE_HOME/guicommon/tk/admin (UNIX)

Example

[ PDF:Subset ]
"Andale Duospace WT J" = "Aduoj.ttf"
"Albany WT J"="AlbanWTJ.ttf"

The specified font should cover the Unicode range that your report uses.
Create a report having MLS data and set its font to the Unicode font.

Run a report having MLS data with DESTYPE=FILE DESFORMAT=PDF.

6.4 Generating a Bidirectional (BiDi) PDF File

This section outlines the steps involved in generating a PDF file for bidirectional (BiDi)
languages. Before using the font features covered in this section, refer to Table 6-3 to
determine which feature best suits your application needs.

Oracle Reports provides two environment variables that resolve font re-shaping and
numeric options with bidirectional (BiDi) languages, such as Hebrew and Arabic.
They are:

1.

REPORTS_BIDI_ALGORITHM

This environment variable switches the layout algorithm for bidirectional (BiDi)
languages (for example, Arabic or Hebrew). The valid values for this environment
variable are ORACLE or UNICODE.

See Also: Section B.1.29, "REPORTS_BIDI_ALGORITHM"

REPORTS_ARABIC_NUMERAL

This environment variable specifies the numeric format for Arabic PDF output.

See Also: Section B.1.28, "REPORTS_ARABIC_NUMERAL"

Using PDF in Oracle Reports  6-19



Generating a Multibyte PDF File

6.4.1 Font Subsetting

The following example assumes you are using Arabic environment. The steps
involved in generating a PDF file for bidirectional (BiDi) languages using the font
subsetting feature are as follows:

1. Set NLS_LANG=ARABIC_EGYPT.AR8MSWIN1256 (or AR8IS08859P6 on UNIX).

2. Set REPORTS_PATH to the font directory in which the TrueType font exists. For
example, C: \WINNT\ fonts.

3. Opentheuifont.ali file and edit the [PDF: Subset] section to specify the
TrueType font name.

Note: Theuifont.ali fileislocated in:
s ORACLE_HOME\tools\common (Windows)

s ORACLE_HOME/guicommon/tk/admin (UNIX)

Example

[PDF: Subset]
"Andale Duospace WT J" = "Aduoj.ttf"
"Albany WT J"="AlbanWTJ.ttf"
4. Create a report having Arabic data and set it to the font specified in the example.

5. Run a report with DESTYPE=FILE DESFORMAT=PDF.

6.5 Generating a Multibyte PDF File

This section outlines the steps involved in generating a PDF file with multibyte fonts.
Before using the font features covered in this section, refer to Table 6-3 to determine
which feature best suits your application needs.

In PDF font subsetting output, you may see a Wave Dash (U+301C) instead of a
Fullwidth Tilde (U+FF5E). This is due to incompatibility in character mapping
between Microsoft and other vendors. To avoid this issue, you can use either
JA16SJISTILDE or JA16EUCTILDE character set for PDF font subsetting. This issue,
however, is not observed with the PDF font aliasing feature.

6.5.1 Font Aliasing

Refer to Table 6-1 for a summary of mapping between Oracle NLS_CHARACTERSET,
CMap name, and its CID font name used in PDF font aliasing for multibyte fonts.

The steps involved in generating a PDF file for multibyte fonts using font aliasing are
as follows:

1. SetNLS_LANG=JAPANESE_JAPAN.JA16SJIS (or JA16EUC on UNIX).

2. Opentheuifont.ali file located and set the font alias under the [ PDF]section.

Note: Theuifont.ali fileis located in:
s ORACLE_HOME\tools\common (Windows)

s ORACLE_HOME/guicommon/tk/admin (UNIX)

6-20 Oracle Application Server Reports Services Publishing Reports to the Web



Generating a Barcode PDF File

Example

[ PDF ]

..... JA16SJIS = "KozMinPro-Regular-Acro"

"MS UI Gothic"..... JA16SJIS = "KozMinPro-Regular-Acro"

3. Create a report having Japanese data with the Japanese font (MS UI Gothic).
4. Run areport with DESTYPE=FILE DESFORMAT=PDF.

5. If your Acrobat Reader is a non-Japanese version installed on a non-Japanese
operating system, you need to install the Japanese font pack from Adobe's site.

If you view the PDF file with the Japanese version of Acrobat Reader 4.0/5.0 on
the Japanese version of Windows, you do not need to install the Japanese font
pack.

6.5.2 Font Subsetting

The steps involved in generating a PDF file for multibyte fonts using the font
subsetting feature are as follows:

1. SetNLS_LANG=JAPANESE JAPAN.JA16SJIS (or JA16EUC on UNIX)

2. Set the REPORTS_PATH environment to the font directory in which the TrueType
font exists. For example, C: \WINNT\Fonts.

3. Opentheuifont.ali file and edit the [PDF: Subset] section to specify the
TrueType font name.

Note: Theuifont.ali fileislocated in:
m ORACLE_HOME\tools\common (Windows)

s ORACLE_HOME/guicommon/tk/admin (UNIX)

Example

[ PDF:Subset ]
"Andale Duospace WT J" = "Aduoj.ttf"
"Albany WT J"="AlbanWTJ.ttf"
"MS UI Gothic" = "msgothic.ttc"
4. Create a report having Japanese data and set it to the font specified in the example.

5. Run areport with DESTYPE=FILE DESFORMAT=PDF.

6.6 Generating a Barcode PDF File

This section outlines the steps involved in generating a PDF file with barcode
information. Before using the font features covered in this section, refer to Table 6-3 to
determine which feature best suits your application needs.

6.6.1 Font Embedding

The steps involved in generating a barcode PDF file using the font embedding feature
are as follows:

1. Set the REPORTS_PATH environment variable to the font directory containing the
Typel font.
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2.

Open the uifont.ali file and include the following under the font embed

[ PDF : Embed] section.

Note: Theuifont.ali fileislocated in:
s ORACLE_HOME\tools\common (Windows)

s ORACLE_HOME/guicommon/tk/admin (UNIX)

Example

[ PDF:Embed ]

SAdHC39a = "SAdHC39a.pfm SAdHC39a.pfb"

Create a report having Barcode data and set its font to the one specified in the
example.

Run a report with DESTYPE=FILE DESFORMAT=PDF.

6.6.2 Font Subsetting

The steps involved in generating a barcode PDF file using the font subsetting feature
are as follows:

1.

Set the REPORT'S_PATH environment variable to the directory containing the
TrueType font. For example, C: \WINNT\Fonts.

Open the uifont.ali file and edit the [PDF: Subset] section to specify the
TrueType font name.

Note: Theuifont.ali fileislocated in:
s ORACLE_HOME\tools\common (Windows)

s ORACLE_HOME/guicommon/tk/admin (UNIX)

Example

[ PDF:Subset ]
SAJHC39a = "SAdHC39a.ttf"

Create a report having barcode data and set it to the font specified in the example.

Run a report with DESTYPE=FILE DESFORMAT=PDF.
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7

Resolving Cross-Platform Porting Issues

Modern business needs warrant a seamless integration and interaction across any
platform and infrastructure. Oracle Reports enables businesses to develop and deploy
information to all levels within and outside of the organization. However, since any
enterprise reporting tool is bound to use some platform-specific functionality like the
system fonts or printer fonts, there exists a possibility that the look-and-feel of the
report changes when the report is ported from one platform to another; for example,
from the development platform (commonly Windows) to the deployment platform
(commonly a UNIX-based platform).

This chapter covers those scenarios where the choice of platform may affect the
look-and-feel of the report output. Each report output format (for example, PDE,
HTMLCSS, and RTF) that is open to cross-platform issues is covered in a separate
section. These sections provide step-by-step instructions that will ensure that your
report output looks the same on all platforms. These guidelines are followed by
troubleshooting information and FAQs. Since multibyte and Unicode reports involve
some additional steps, separate sections are devoted to those topics. This chapter is
applicable to Oracle9i Reports, Oracle Reports 10g Release 1 (9.0.4), and 10g Release 2
(10.1.2), except as specifically noted.

Before you proceed, it is strongly recommended that you are familiar with the
concepts and terminology outlined in the following chapters:

s Chapter 3, "Configuring OracleAS Reports Services"
s Chapter 5, "Printing on UNIX with Oracle Reports"
= Appendix B, "Environment Variables"
This chapter includes the following sections:
= Overview of Cross-Platform Issues
- Font Availability On Different Platforms
- Fixing Font-Related Issues
s Generating HTMLCSS, RTF, or Web Output
= Generating Single-Byte PDF Output
= Generating Multibyte PDF Output
= Generating Unicode PDF Output
s Generating PostScript Output

Note: This chapter lists only those scenarios and guidelines that
need additional work to ensure similar outputs across platforms.
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7.1 Overview of Cross-Platform Issues

Oracle Reports is available on many platforms, including Windows, Linux, Sun
Solaris, HP-UX, and IBM AIX. You can use Oracle Reports to develop and deploy
reports on any of these platforms interchangeably. The most common scenario is that
the report is developed on Windows, and is deployed on a UNIX-based environment,
such as Linux (see Figure 7-1). This may result in a slight change in the look-and-feel
of the deployed report. For example, when you are developing the report on Windows,
you allocate enough space to each text object or field in your report. However, when
you deploy and run the report on Linux, you may see that the text does not fit within
the allocated space in the output. Such issues that are the direct result of change in
platform are referred to as cross-platform issues. A possible cause of such issues is that
the fonts available on the development platform are not available on the deployment
platform. As a result, when the report is executed on the deployment platform, a
substitute font needs to be used for formatting the report output. Since any two fonts
are likely to have certain differences, the report output on the development and
deployment platforms looks different.

Another likely scenario in which you may encounter cross-platform issues is when the
platform on which the report is finally viewed (see Figure 7-1) does not have the
proper fonts installed. Thus, even if the development and deployment platforms
display the report output correctly, the platform on which the end-user views the
report will not display the proper look-and-feel of the report.

Figure 7-1 Sample Cross-Platform Deployment Scenario

W
»

bﬁj
—

Develop Deploy
(Windows) (Linux) «-
View
(Any Platform)

7.1.1 Font Availability On Different Platforms

A font is a set of printable or displayable text characters in a specific style and size.
Fonts are needed for displaying the report on the screen as well as for printing it. The
metrics for these fonts are picked up by Oracle Reports while formatting the report;
that is, while executing the report command. Based on the font metrics, the report is
formatted and the output is produced.

The font metrics are provided by specific files that must be available on the system
where you are running OracleAS Reports Services. On Windows, these font metrics
are provided by True Type Font (TTF) files or True Type Collection (TTC) files. On
UNIX platforms, the font metrics are taken from Adobe Font Metrics (AFM) files or
TeX Font Metrics (TFM) files. The font availability and the metrics can vary based on
the operating system used. This difference in fonts used and the rendering can affect
the visual appearance of the generated outptut.

Example 1: Tahoma, a commonly used font in single-byte regions, is available on
Windows but not on UNIX. For example, a reports developer has used Tahoma font
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while designing the report. The output of the report looks good on the development
platform; that is, Windows. The report is then ported to the deployment platform (say
Linux). When you submit a request to the Reports Server to execute this report, the
Reports Server looks for Tahoma font metrics. It will be unable to find the metric file,
since Tahoma is a Windows-specific font. Another font that closely resembles Tahoma
will be used instead. This will affect the report output since a different font has been
used.

Example 2: The development as well as deployment platform is Windows. So Reports
Servers on both the development and deployment platforms are able to access Tahoma
font since both run on Windows. However, suppose an end-user views the output on
Linux. All reports output formats (HTML, HTMLCSS, RTF, and PDF) merely refer to
the fonts and do not embed the fonts in the output unless you specifically use the font
embedding feature in PDF. As a result, the client system will look for the Tahoma font
to display the report output on client machine. Since Tahoma is not available on Linux,
the user will encounter cross-platform issues while viewing the output.

7.1.2 Fixing Font-Related Issues

As we have seen, many cross-platform issues are caused by the non-availability of
fonts either on the production environment (where the Reports Server is running) or
on the client system. These font availability issues must be resolved by a 3-step
approach:

1. Development platform: Ensure that you develop the report keeping in mind the
font availability on the deployment platform. All font files that are available on
Windows (TTF files) may not be available on UNIX (AFM or TEM files). If you
have the correct AFM or TFM font file available on the UNIX platform, you can
continue to use it (AFM for PostScript printing and TEM for PCL). For fonts with
AFM files not readily available on UNIX, or if you encounter any font issues in the
report output such as text misalignment, you can convert and generate an AFM
file from the Windows TTF file using freely available third party utilities, such as
ttf2ptl. Do not attempt to convert to a TEM file, as this may not produce reliable
results.

2. Deployment platform: Ensure that the fonts used in the report are available. For
PDF output, use font aliasing to substitute the unavailable font with the closest
available font. Global font aliasing can be used for all output formats.

3. Same comment holds for all the subsequent sections where you have asked to
provide examples.

4. Client platform: Ensure that you account for font unavailability on the client
system. For example, in the case of PDF output, you can use Font Subsetting or
Font Embedding, as decribed in Chapter 6, "Using PDF in Oracle Reports". In the
case of HTML, HTMLCSS or RTF output formats it is not possible to embed the
fonts, so it is best to design the report using fonts that are known to be available on
all platforms.

7.2 Generating HTMLCSS, RTF, or Web Output

Table 7-1 shows the cross platform deployment scenario where the destination format
is HTMLCSS, RTF, or the Web.
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Table 7-1 Cross Platform deployment - Scenario 1

Development Deployment
Platform Platform Destination Format
Windows UNIX HTMLCSS, RTF, or Web

This section discusses designing and deploying a report for HTMLCSS, RTE, or Web
output in the following subsections:

s Designing Your Report
= Deploying Your Report
= Frequently Asked Questions

7.2.1 Designing Your Report
To prepare your report before you deploy it on a UNIX platform:

1. Create a new report. While creating your report ensure that you leave additional
padding space for boilerplate and field objects. This is to ensure that the box's size
accounts for any possible increase in the text width when the report is run on the
deployment platform.

2. Use only those fonts in your report that:

s Are available on UNIX. All font files that are available on Windows (TTF files)
may not be available on UNIX (AFM or TEM files). If you have the correct
AFM or TFM font file available on the UNIX platform, you can continue to use
it (AFM for PostScript and TFM for PCL).

Note: AFM support is extended only to single-byte PostScript file
generation, with the exception of Japanese encoding.

The encoding schemes supported for the AFM files are:

AdobeStandardEncoding
ExtJIS12-88-CFEncoding
FontSpecific

HRoman

ISOLatinHebrew
JIS12-88-CFEncoding
JIS12e-88-CFEncoding

= Can scale well. For example, MS Sans Serif does not scale well to a different
size, whereas Tahoma does. The reason is that the MS Sans Serif font is a raster
font that does not scale well to any size and usually has rounding issues. On
the other hand, Tahoma font is a TrueType font that is very similar in visual
appearance to the MS Sans Serif font. Additionally, Tahoma is a vector font
that can be scaled to any size and rotated to any angle.

7.2.2 Deploying Your Report

For fonts with AFM files not readily available on UNIX, or if you encounter any font
issues in the report output such as text misalignment, you can convert and generate an
AFM file from the Windows TTF file using freely available third party utilities, such as
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ttf2ptl. Do not attempt to convert to a TEM file, as this may not produce reliable
results.

To deploy your report on a UNIX platform when AFM font files are not available:

1.

2.

Locate the TTF files corresponding to the fonts used in your report. Convert these
TTF files to AFM to ensure that you will have the AFM files for the fonts used in
your report.

Use a True Type to Type 1 font converter utility to convert the TTF files to AFM
files. For example, ttf2pt1.

Post-conversion, remove the . afm extension in the AFM file name. For example:

Table 7-2 Post Conversion Font File Names

Before Converting After Converting After Renaming
arial.ttf arial.afm Arial
cour.ttf cour.afm CourierNew

3. Copy the converted AFM files to the SORACLE_

4,

HOME/guicommon/tk/admin/AFM directory.

Edit the screenprinter. ppd file with any text editor.

Note: If you have defined a default printer by including an entry in
ORACLE_HOME/guicommon/tk/admin/uiprint. txt, then you
will have to make the appropriate entries in the printer's PPD file for a
PostScript printer or in the HPD file for a PCL printer.

Beginning with Oracle Reports 10g Release 1 (9.0.4), a default printer
surface that mimics the screen (screenprinter.ppd) is used for
formatting if you have not set up a default printer. You will also need
to make the necessary font and resolution entries in the
screenprinter.ppd file, if you have not set up a default printer.

The PPD files are located at:

ORACLE_HOME/guicommon/tk/admin/PPD
The HPD files are located at:

ORACLE_HOME/guicommon/tk/admin/HPD

Refer to Section 3.10.1, "ScreenPrinter" for more information on the
screenprinter.ppd file.

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report. PPD/HPD files are configuration files containing
printer driver settings and the list of all the fonts supported by the printer.

Navigate to the to the Font Information section in the PPD file and add the
necessary entries for the font files in the following format:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard " (Version 2.76)" Standard ROM
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Ensure that the AFM file name exactly matches the font name specified in the PPD
file as Oracle Reports searches for this file based on the font name in the PPD file.

5. Ensure that the fonts used in your report are not aliased.

For example, edit the uifont.ali file and comment the entries in the [Global]
section, where Arial and Courier New are aliased to Helvetica and Courier,
respectively.

[ Global ] # Put mappings for all surfaces here.
# Mapping from MS Windows

#Arial = helvetica

#"Courier New" = courier

This ensures that Arial and Courier New are not aliased to any other font.

Note: Theuifont.ali islocated in the SORACLE_HOME
/guicommon/tk/admin directory.

Use font aliasing only if you are unable to generate the AFM file for a
particular font. You can then alias the missing font to the closest
match. The fonts must be made available on the machine displaying
the report output and not necessarily on the machine generating the
report output.

6. Run the report.

http://mywebserver.com:reports/rwservlet?server=myserver+report="c:\test.rdf"+a
uthid=hr/hr@mydb+desformat=htmlcss+destype=cache

The HTMLCSS output of your report will look exactly the same as the one
generated on Windows.

7.2.2.1 Troubleshooting Information

If you encounter deployment issues, review the following troubleshooting
information:

= If you do not get the correct fonts in the HTMLCSS output, set the environment
variable DEBUG_SLFIND to a log file name, for example, debug. txt, and run the
report. The font files that are looked up while parsing the PPD file as well as the
fonts used will be written to the log file debug . txt. Specifically, check for the
following:

1. The PPD file that you modified should be picked up. If it is not picked up it is
a configuration issue. Refer to Chapter 4, "Managing Fonts in Oracle Reports".

2. The AFM files that you have copied to AFM directory should be picked up
next.

See Chapter 5, "Printing on UNIX with Oracle Reports" for more information on
DEBUG_SLFIND.

7.2.3 Frequently Asked Questions

This section covers frequently asked questions (FAQs) pertaining to deploying a report
to HTMLCSS, RTF or the Web.
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Question

When I design a report on Windows with font styles such as italic and bold, then run
the report on UNIX, I do not see the output as it appeared on Windows. Why?

Answer

On UNIX, report formatting is done using fonts' corresponding AFM files. By default,
these AFM files are picked from the $ORACLE_HOME/guicommon/tk/admin/AFM
directory, provided as part of the installation. If the font style used in report does not
have a corresponding AFM file on UNIX, the closest matching AFM file is used. For
example, if you design a report on Windows with Courier Italic font, then run the
report on UNIX, you may see only plain Courier font in the output. This happens
because there is no AFM file available for Courier Italic font in the SORACLE_
HOME/guicommon/tk/admin/AFM directory, so instead Courier is picked. To work
around this issue, you can alias your font's style to the same style for some other font
that has AFM available. For example, you could alias Courier Italic to Times Italic in
the global section of uifont.ali. Moreover, on Windows, there are some fonts that
have bold, italic, and bold italic versions; for example, Arial has arialbd. ttf (Arial
bold), ariali.ttf (Arialitalic), and arialbi. ttf (Arial bold italic). Therefore, if
you are using any font that has bold, italic, and bold italic TTF files available, you can
generate AFM files from these files using t t£2pt1 and use these AFM files on UNIX.

Question

My report was created in Windows and is deployed on HP-UX 11. Although the font
style on HP-UX 11 is correct, the spacing between the lines is inconsistent and some
text is unable to fit in the allocated space. How can I fix the spacing so that my text fits
correctly?

Answer

Ensure that you have set up the corresponding AFM files for all the fonts used in your
document. Refer to Section 7.2.1, "Designing Your Report" for more information.

Question

My report is designed on Windows. When it is deployed on a different platform, it
displays garbled output. For example, some fields display, ** * * * instead of the actual
content. Is this a spacing issue?

Answer

Oracle Reports cannot find the AFM files of the font that you have used in your report.
You can verify this by opening the report's HTML source and searching for the font
that you have used.

Oracle Reports then uses the closest matching font whose metrics are bigger than the
original font. Therefore, when the characters cannot fit in the box, a **** is displayed
in the field, instead of the actual output.

Ensure that:

= You have set up the AFM files for all the fonts used in your report. Refer to
Section 7.2.1, "Designing Your Report" for more information.

= You have left approximately 10% extra padding space for fields and text
boilerplates.
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Question

When my report is run on UNIX, the HTML or the HTMLCSS output looks shrunk.
However, the same report run on Windows looks fine. What can I do to ensure that my
report looks the same on UNIX as it did on Windows?

Answer

If you see shrinkage or expansion in your HTMLCSS output and you are on Oracle9i
Reports, then set the environment variable REPORTS_DEFAULT_PIXEL_SIZE to any
value ranging from 72 through 200 in reports. sh and restart the Reports Server.

For example:

REPORTS_DEFAULT_PIXEL_SIZE =72
export REPORTS_DEFAULT_PIXEL_SIZE

There will not be any HTMLCSS output shrinkage/expansion in Oracle Reports 10g as
a fixed resolution is picked up from screenprinter.ppd. This resolution is editable.

*DefaultResolution: 96dpi (recommended)

Question
Can I use the overstrike property when I deploy a report in Solaris?

Answer
A limitation of AFM files is that it does not support the overstrike property.

Question

My report contains right-aligned fields that displays both positive and negative
numbers. For example, 12345.67, -12345. 67. However, when the report is
generated to HTMLCSS output, the alignment is not correct. How can I fix the
alignment? Is this a platform-specific issue?

Answer

This is not exactly a platform-specific issue. When the spaces in the HTMLCSS output
are replaced by &nbsp; this problem will be resolved. This is fixed in Oracle9i Reports
Patch Release 1 and later releases. To ensure that you do not face this issue, you must
upgrade to the latest release of Oracle Reports.

7.3 Generating Single-Byte PDF Output

Table 7-3 shows the cross-platform deployment scenario where the destination format
is single-byte PDF created using PDF font subsetting. For more information on PDF
font features, refer to Chapter 6, "Using PDF in Oracle Reports".

Table 7-3 Cross Platform deployment - Scenario 2

Development
Platform Deployment Platform Destination Format

Windows UNIX PDF (single byte)

This section discusses designing and deploying a report for single-byte PDF output in
the following subsections:

s Designing Your Report
= Deploying Your Report
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Frequently Asked Questions

7.3.1 Designing Your Report
To prepare your report before you deploy it on a UNIX platform:

1.
2.

Create a new report.

Use only those fonts in your report that:

Are available on UNIX. All font files that are available on Windows (TTF files)
may not be available on UNIX (AFM or TEM files). If you have the correct
AFM or TFM font file available on the UNIX platform, you can continue to use
it (AFM for PostScript and TFM for PCL).

Note: AFM support is extended only to single-byte PostScript file
generation, with the exception of Japanese encoding.

The encoding schemes supported for the AFM files are:

AdobeStandardEncoding
ExtJIS12-88-CFEncoding
FontSpecific

HRoman

ISOLatinHebrew
JIS12-88-CFEncoding
JIS12e-88-CFEncoding

Can scale well. For example, MS Sans Serif does not scale well to a different
size, whereas Tahoma does. The reason is that the MS Sans Serif font is a raster
font that does not scale well to any size and usually has rounding issues. On
the other hand, Tahoma font is a TrueType font that is very similar in visual
appearance to the MS Sans Serif font. Additionally, Tahoma is a vector font
that can be scaled to any size and rotated to any angle.

7.3.2 Deploying Your Report

For fonts with AFM files not readily available on UNIX, or if you encounter any font
issues in the report output such as text misalignment, you can convert and generate an
AFM file from the Windows TTF file using freely available third party utilities, such as
ttf2ptl. Do not attempt to convert to a TEM file, as this may not produce reliable

results.

To deploy your report on a UNIX platform using PDF font subsetting:

1.

2.

Locate the TTF files corresponding to the fonts used in your report. Convert these
TTF files to AFM to ensure that you will have the AFM files for the fonts used in
your report.

Use a True Type to Type 1 font converter utility to convert the TTF files to AFM
files. For example, ttf2pt1.

Post-conversion, remove the . afm extension in the AFM file name. For example:
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Table 7-4 Post Conversion Font File Names

Before Converting After Converting After Renaming
arial.ttf arial.afm Arial
cour.ttf cour.afm CourierNew

3. Copy the Windows TTF files that you have used in your report to the fonts
directory on your UNIX machine. For example, SORACLE_
HOME/reports/fonts.

4. Add the path to the TTF files in the REPORTS_PATH environment variable. This
ensures that the font files can be referenced by Reports Runtime.

5. Edit the screenprinter.ppd file with any text editor.

Note: If you have defined a default printer by including an entry in
ORACLE_HOME/guicommon/tk/admin/uiprint. txt, then you
will have to make the appropriate entries in the printer's PPD file for a
PostScript printer or in the HPD file for a PCL printer.

Beginning with Oracle Reports 10g Release 1 (9.0.4), a default printer
surface that mimics the screen (screenprinter . ppd) is used for
formatting if you have not set up a default printer. You will also need
to make the necessary font and resolution entries in the
screenprinter.ppd file, if you have not set up a default printer.

The PPD files are located at:
ORACLE_HOME/guicommon/tk/admin/PPD
The HPD files are located at:

ORACLE_HOME/guicommon/tk/admin/HPD

Refer to Section 3.10.1, "ScreenPrinter" for more information on the
screenprinter.ppd file.

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report. PPD/HPD files are configuration files containing
printer driver settings and the list of all the fonts supported by the printer.

Navigate to the to the Font Information section in the PPD file and add the
necessary entries for the font files in the following format:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard "(Version 2.76)" Standard ROM

Ensure that the AFM file name exactly matches the font name specified in the PPD
file as Oracle Reports searches for this file based on the font name in the PPD file.

6. Copy the converted AFM files to the SORACLE_
HOME/guicommon/tk/admin/AFM directory.

7. Ensure that the uiprint. txt has the entry for the appropriate PPD file:

printer name:PostScript:2:test:ppd file
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10.

11.

For example:

printerl:PostScript:2:test:hpljetd2.ppd

Edit the hpljet42.ppd file with any text editor.

Note: Create a backup of the hpljet42.ppd file before you proceed
to edit it. This file is located in:

SORACLE_HOME/guicommon/tk/admin/PPD

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report.

Navigate to the Font Information section and add the necessary entries for the
new AFM files in the following format:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard " (Version 2.76)" Standard ROM

Ensure that the AFM file name is the same as the font name given in the PPD file.
Oracle Reports searches for this file based on the font name in the PPD file.

Ensure that the fonts used in your report are not aliased.

For example, edit the uifont.ali and comment the entries in the [Global]
section where Arial and Courier New are aliased, by default, to Helvetica and
Courier respectively.

[ Global ] # Put mappings for all surfaces here.
# Mapping from MS Windows

#Arial = helvetica

#"Courier New" = courier

Note: Theuifont.ali islocated in the SORACLE_HOME
/guicommon/tk/admin directory.

Use font aliasing only if you are unable to generate the AFM file for a
particular font. You can then alias the missing font to the closest
match. The fonts must be made available on the machine displaying
the PDF output and not necessarily on the machine generating the
PDF file.

Add the appropriate entries in the [PDF: Subset] section to subset the fonts
used in your report.

For example:

[ PDF:Subset ]
"arial" = "arial.ttf"
"courier new" = "cour.ttf"

For PDF file portability, you can use either font subsetting or font embedding. File
portability ensures that the PDF report does not depend on the machine where it is
viewed to have the fonts installed.
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12. Run the report to PDF and view it. The PDF should contain the fonts used in your
report. For example, Arial and Courier New fonts.

To verify the fonts used, do the following;:
s In Acrobat Reader 6.0, click File >Document Properties > Fonts.
s In Acrobat Reader 3.0 and above, click File >Document Info > Fonts.

The Original Font column displays the Arial and Tahoma fonts. The PDF
document should not contain any font alignment issues.

7.3.2.1 Troubleshooting Information

If you encounter deployment issues, review the following troubleshooting
information:

= If you do not get the correct fonts in the PDF output, set the environment variable
DEBUG_SLFIND to a log file name (for example, debug. txt) and run the report.
The font files that are looked up while parsing the PPD file as well as the fonts
used will be written to the specified file. Specifically, check for the following:

1. The PPD file that you modified should be picked up. If it is not picked up it is
a configuration issue. Refer to Chapter 4, "Managing Fonts in Oracle Reports".

2. The AFM files that you have copied to AFM directory should be picked up
next.

See Chapter 5, "Printing on UNIX with Oracle Reports" for more information on
DEBUG_SLFIND.

7.3.3 Frequently Asked Questions

This section contains frequently asked questions (FAQs) pertaining to deploying a
report to single-byte PDF output.

Question

My PDF report page count varies when it is deployed in Windows and UNIX
platforms. What must I do to fix it?

Answer

Your report uses the default printer for formatting. Ensure that the same resolution
and the same fonts used are made available to both the printers. One way of achieving
this would be to generate AFM files from Windows TTF font files and then copy the
Windows TTF files and AFM files to UNIX in the appropriate folders. Also set the
same resolution as Windows in PPD/HPD files. Follow the process specified in the
prior steps.

Question

The page count of my report varies when run on different installations of UNIX. How
can I ensure that the page count of my report is the same regardless of the installation?

Answer

In UNIX, Oracle Reports uses the PPD/HPD file of the default printer in the
installation for formatting. The resolution and list of fonts will be picked up from this
PPD/HPD files. Beginning with Oracle Reports 10g Release 1 (9.0.4), if there is no
default printer setup in the installation, then screenprinter.ppd will be used. This
PPD file emulates the screen. Earlier versions of Oracle Reports used the DISPLAY
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environment variable instead. Ensure that the two installations use the same
AFM/TFM files and font files, so that the number of pages of PDF output will be the
same.

7.4 Generating Multibyte PDF Output

Table 7-5 shows the cross platform deployment scenario where the destination format
is multibyte PDF created using PDF font subsetting. For more information on PDF font
features, refer to Chapter 6, "Using PDF in Oracle Reports".

Table 7-5 Cross Platform Deployment - Scenario 4

Development Platform Deployment Platform Destination Format

Windows UNIX PDF (multibyte)

This section discusses designing and deploying a report for multibyte PDF output in
the following subsections:

s Designing Your Report
= Deploying Your Report
= Frequently Asked Questions

7.4.1 Designing Your Report
To prepare your report before you deploy it on a UNIX platform:

1. Create a new report with a TrueType multibyte font. For example, Simplified
Arabic font with the AR8TS08859P6 character set.

2. Use only those fonts in your report that:

= Are available on UNIX. All font files that are available on Windows (TTF files)
may not be available on UNIX (AFM or TFM files). If you have the correct
AFM or TFM font file available on the UNIX platform, you can continue to use
it (AFM for PostScript and TEM for PCL).

Note: AFM support is extended only to single-byte PostScript file
generation, with the exception of Japanese encoding.

The encoding schemes supported for the AFM files are:

AdobeStandardEncoding
ExtJIS12-88-CFEncoding
FontSpecific

HRoman

ISOLatinHebrew
JIS12-88-CFEncoding
JIS12e-88-CFEncoding

= Can scale well. For example, MS Sans Serif does not scale well to a different
size, whereas Tahoma does. The reason is that the MS Sans Serif font is a raster
font that does not scale well to any size and usually has rounding issues. On
the other hand, Tahoma font is a TrueType font that is very similar in visual
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appearance to the MS Sans Serif font. Additionally, Tahoma is a vector font
that can be scaled to any size and rotated to any angle.

7.4.2 Deploying Your Report

For fonts with AFM files not readily available on UNIX, or if you encounter any font
issues in the report output such as text misalignment, you can convert and generate an
AFM file from the Windows TTF file using freely available third party utilities, such as
ttf2ptl. Do not attempt to convert to a TFM file, as this may not produce reliable
results.

To deploy your report on a UNIX platform:

1. Locate the TTF files corresponding to the fonts used in your report. Convert these
TTF files to AFM to ensure that you will have the AFM files for the fonts used in
your report.

Use a True Type to Type 1 font converter utility to convert the TTF files to AFM
files. For example, ttf2pt1.

2. Post-conversion, remove the . afm extension in the AFM file name. For example:

Table 7-6 Post Conversion Font File Names

Before Converting After Converting After Renaming

simpo.ttf simpo.afm SimplifiedArabic

3. Copy the Windows TTF file used in your report to the fonts directory on your
UNIX machine. For example, SORACLE_HOME/ fonts.

4. Add the path to the TTF file in the REPORTS_PATH environment variable.

5. Copy the AFM file to the $ORACLE_HOME/guicommon/tk/admin/AFM
directory.

6. Edit the screenprinter.ppd file with any text editor.

Note: If you have defined a default printer by including an entry in
ORACLE_HOME/guicommon/tk/admin/uiprint. txt, then you
will have to make the appropriate entries in the printer's PPD file for a
PostScript printer or in the HPD file for a PCL printer.

Beginning with Oracle Reports 10g Release 1 (9.0.4), a default
printer surface that mimics the screen (screenprinter . ppd) is used
for formatting if you have not set up a default printer. You will also
need to make the necessary font and resolution entries in the
screenprinter.ppd file, if you have not set up a default printer.

The PPD files are located at:

ORACLE_HOME/guicommon/tk/admin/PPD
The HPD files are located at:

ORACLE_HOME/guicommon/tk/admin/HPD

Refer to Section 3.10.1, "ScreenPrinter" for more information on the
screenprinter.ppd file.
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10.

11.

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report. PPD/HPD files are configuration files containing
printer driver settings and the list of all the fonts supported by the printer.

Navigate to the to the Font Information section in the PPD file and add the
necessary entries for the font files in the following format:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard " (Version 2.76)" Standard ROM

Ensure that the AFM file name exactly matches the font name specified in the PPD
file as Oracle Reports searches for this file based on the font name in the PPD file.

Ensure that the uiprint . txt has the entry for the appropriate PPD file:
printername: PostScript:2:test:ppd_file.

For example:

printerl:PostScript:2:test:hpljetd2.ppd

Edit the hpljet42.ppd file with any text editor.

Note: Create a backup of the hpljet42.ppd before you proceed to
edit it. This file is located in:

SORACLE_HOME/guicommon/tk/admin/PPD

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report.

Navigate to the Font Information section and add the necessary entries for the
new AFM files in the following order:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font SimplifiedArabic: Standard "(001.01)" Standard ROM

Ensure that the fonts used in your report are not aliased.

Edituifont.ali and comment the entries, if any, where Simplified Arabic font is
aliased to some other font. For example: "SimplifiedArabic"="Arial".

Note: Theuifont.ali islocated in the SORACLE_HOME
/guicommon/tk/admin directory.

Use font aliasing only if you are unable to generate the AFM file for a
particular font. You can then alias the missing font to the closest
match. The fonts must be made available on the machine displaying
the PDF output and not necessarily on the machine generating the
PDF file.

In the [PDF: Subset] section, add the appropriate entries to subset the fonts.

For example:
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[ PDF:Subset ]
"SimplifiedArabic" = "simpo.ttf"

For PDF file portability, you can use either font subsetting or font embedding. File
portability ensures that the PDF report does not depend on the machine where it is
viewed to have the fonts installed.

12. Run the report to PDF and view it.
http://mywebserver.com:reports/rwservlet?server=myserver+report="c:\test.rdf"+a

uthid=hr/hreémydb+desformat=PDF+destype=cache

The PDF should contain the font that you have used in your report. For example,
the David font.

To verify the fonts used, do the following;:
= In Acrobat Reader 6.0, choose File >Document Properties > Fonts.
s In Acrobat Reader 3.0 and above, choose File >Document Info > Fonts.

The Original Font column should display the David font.

7.4.2.1 Troubleshooting Information

If you encounter deployment issues, review the following troubleshooting
information:

= If you do not get the correct fonts in the PDF output, set the environment variable
DEBUG_SLFIND to a log file name, for example, debug. txt, and run the report.
The font files that are looked up while parsing the PPD file as well as the fonts
used will be written to the log file debug . txt. Specifically, check for the
following:

1. The PPD file that you modified should be picked up. If it is not picked up it is
a configuration issue. Refer to Chapter 4, "Managing Fonts in Oracle Reports".

2. The AFM files that you have copied to AFM directory should be picked up
next.

See Chapter 5, "Printing on UNIX with Oracle Reports" for more information on
DEBUG_SLFIND.

7.4.3 Frequently Asked Questions

This section contains frequently asked questions (FAQs) pertaining to deploying a
report to multibyte PDF output.

Question

What are the cross-platform issues for the PDF output when using CID multibyte
fonts?

Answer
To enable multibyte language support in PDF reports with CID multibyte fonts, you
need to make sure that the Asian font package is installed for your Acrobat Reader on

the machine where you are going to view these PDF files. The Asian font package is
available at the Adobe Web site.
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Question

Why is the formatting of my report not correct when using multibyte fonts on UNIX,
or why do I see misaligned text in the report?

Answer

If you have used tt£2pt1 to create the AFM file, tt£2pt1 has a limitation in that it
creates AFM files with metrics information for only the first 256 characters of the font.
The first 256 characters are for Latin-1 characters. So, if your font contains more than
256 characters, metrics information will not be available for the additional characters.
Oracle Reports uses default metrics information contained in the AFM file when it
encounters characters in the report that are not in the AFM file. These default metrics
may not match the exact metrics of the characters used in the report. For this reason,
formatting will not be correct. To avoid this situation when you are using characters
beyond the first 256 characters of the font, you can use fixed width fonts where all the
characters have the same width. For example, Miriam Fixed is a fixed width font for
Hebrew and can be used to avoid formatting issues.

7.5 Generating Unicode PDF Output

Table 7-7 shows the cross-platform deployment scenario where the destination format
is Unicode PDF created using PDF font subsetting. For more information on PDF font
features, refer to Chapter 6, "Using PDF in Oracle Reports".

Table 7-7 Cross Platform Deployment - Scenario 5

Development Platform Deployment Platform Destination Format

Windows UNIX PDF (Unicode)

This section discusses designing and deploying a report for Unicode PDF output in the
following subsections:

= Designing Your Report
= Deploying Your Report
= Frequently Asked Questions

7.5.1 Designing Your Report
To prepare your report before you deploy it on a UNIX platform:

1. Create a new report using a Unicode font. For example, Arial Unicode MS font.
2. Use only those fonts in your report that:
= Cover the entire Unicode range that your report uses.

»  Are available on UNIX. All font files that are available on Windows (TTF files)
may not be available on UNIX (AFM or TFM files). If you have the correct
AFM or TFM font file available on the UNIX platform, you can continue to use
it (AFM for PostScript and TFM for PCL).
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Note: AFM support is extended only to single-byte PostScript file
generation, with the exception of Japanese encoding.

The encoding schemes supported for the AFM files are:

AdobeStandardEncoding
ExtJIS12-88-CFEncoding
FontSpecific

HRoman

ISOLatinHebrew
JIS12-88-CFEncoding
JIS12e-88-CFEncoding

= Can scale well. For example, MS Sans Serif does not scale well to a different
size, whereas Tahoma does. The reason is that the MS Sans Serif font is a raster
font that does not scale well to any size and usually has rounding issues. On
the other hand, Tahoma font is a TrueType font that is very similar in visual
appearance to the MS Sans Serif font. Additionally, Tahoma is a vector font
that can be scaled to any size and rotated to any angle.

7.5.2 Deploying Your Report

For fonts with AFM files not readily available on UNIX, or if you encounter any font
issues in the report output such as text misalignment, you can convert and generate an
AFM file from the Windows TTF file using freely available third party utilities, such as
ttf2ptl. Do not attempt to convert to a TFM file, as this may not produce reliable
results.

To deploy your report on a UNIX platform:

1. Locate the TTF files corresponding to the fonts used in your report. Convert these
TTF files to AFM to ensure that you will have the AFM files for the fonts used in
your report.

Use a True Type to Type 1 font converter utility to convert the TTF files to AFM
files. For example, tt f2pt1.

2. Post-conversion, remove the . afm extension in the AFM file name. For example:

Table 7-8 Post Conversion Font File Names

Before Converting After Converting After Renaming

arialuni.ttf arialuni.afm ArialUnicodeMS

3. Copy the Windows TTF file used in your report to the fonts directory on your
UNIX machine. For example, SORACLE_HOME/ fonts.

4. Add the path to the TTF file in the REPORTS_PATH environment variable. For
example, arialuni.ttf.

5. Copy the AFM file to the SORACLE_HOME/guicommon/tk/admin/AFM
directory. For example, ArialUnicodeMS.

6. Edit the screenprinter.ppd file with any text editor.
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Note: If you have defined a default printer by including an entry in
ORACLE_HOME/guicommon/tk/admin/uiprint. txt, then you
will have to make the appropriate entries in the printer's PPD file for a
PostScript printer or in the HPD file for a PCL printer.

Beginning with Oracle Reports 10g Release 1 (9.0.4), a default printer
surface that mimics the screen (screenprinter.ppd) is used for
formatting if you have not set up a default printer. You will also need
to make the necessary font and resolution entries in the
screenprinter.ppd file, if you have not set up a default printer.

The PPD files are located at:

ORACLE_HOME/guicommon/tk/admin/PPD
The HPD files are located at:

ORACLE_HOME/guicommon/tk/admin/HPD

Refer to Section 3.10.1, "ScreenPrinter" for more information on the
screenprinter.ppd file.

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report. PPD/HPD files are configuration files containing
printer driver settings and the list of all the fonts supported by the printer.

Navigate to the to the Font Information section in the PPD file and add the
necessary entries for the font files in the following format:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard " (Version 2.76)" Standard ROM

Ensure that the AFM file name exactly matches the font name specified in the PPD
file as Oracle Reports searches for this file based on the font name in the PPD file.

Ensure that the uiprint. txt has the entry for the appropriate PPD file.

printer name:PostScript:2:test:ppd file

In this example:

printerl:PostScript:2:test:hpljetd2.ppd

Edit the hpljet42.ppd file with any text editor.

Note: Create a backup of the hpljet42.ppd before you proceed to
edit it. This file is located in:

SORACLE_HOME/guicommon/tk/admin/PPD

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report.

Navigate to the Font Information section and add the necessary entries for the
new AFM files in the following order:

*FONTNAME : ENCODING : VERSION: LOCATION
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For example:

*Font ArialUnicodeMS: Standard " (Version 2.76)" Standard ROM

10. In the [PDF: Subset] section, add the following entries to subset the fonts used
in your report.

For example:

[ PDF:Subset ]
"ArialUnicodeMS" = "arialuni.ttf"

Use the PDF subsetting feature to generate multibyte PDF output from your
reports and to ensure your PDF report is portable. Thus, there is not dependency
on the machine deploying the report to have the fonts installed.

11. Run the report to PDF and view it.

http://mywebserver.com:reports/rwservlet?server=myserver+report="c:\test.rdf"+a
uthid=hr/hreémydb+desformat=PDF+destype=cache

The PDF should contain the unicode font used in your report. For example, Arial.

7.5.2.1 Troubleshooting Information

If you encounter deployment issues, review the following troubleshooting
information:

= If you do not get the correct fonts in the PDF output, set the environment variable
DEBUG_SLFIND to a log file name (for example, debug. txt) and run the report.
The font files that are looked up while parsing the PPD file as well as the fonts
used will be written to the log file debug . txt. Specifically, check for the
following:

1. The PPD file that you modified should be picked up. If it is not picked up it is
a configuration issue. Refer to Chapter 4, "Managing Fonts in Oracle Reports".

2. The AFM files that you have copied to AFM directory should be picked up
next.

See Chapter 5, "Printing on UNIX with Oracle Reports” for more information on
DEBUG_SLFIND.

7.5.3 Frequently Asked Questions

This section contains frequently asked questions (FAQs) pertaining to deploying a
report to Unicode PDF output.

Question

Why is the formatting of my report not correct when using Unicode on UNIX, or why
do I see misaligned text in the report?

Answer

If you have used tt£2pt1 to create the AFM file, tt£2pt1 has a limitation in that it
creates AFM files with metrics information for only the first 256 characters of the font.
So, if you are using multiple languages in the report with a Unicode font like Arial
Unicode MS, when you create the AFM file for UNIX, there will not be metrics
information for the characters beyond the first 256 characters. Oracle Reports uses
default metrics information contained in the AFM file when it encounters characters in
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the report that are not in the AFM file. These default metrics may not match the exact
metrics of the characters used in the report. For this reason, formatting will not be
correct. To avoid formatting issues when you are using characters beyond the first 256
characters of the font, you can use fixed width fonts where all the characters have the
same width.

7.6 Generating PostScript Output

Table 7-9 shows the cross-platform deployment scenario where the destination format
is PostScript.

Table 7-9 Cross Platform Deployment - Scenario 3

Development Platform Deployment Platform Destination Format

Windows UNIX PostScript

This section discusses designing and deploying a report for PostScript output in the
following subsections:

= Designing Your Report
= Deploying Your Report
= Frequently Asked Questions

7.6.1 Designing Your Report
To prepare your report before you deploy it on a UNIX platform:
1. Create a new report.
2. Use only those fonts in your report that:

= Are available on UNIX. All font files that are available on Windows (TTF files)
may not be available on UNIX (AFM or TFM files). If you have the correct
AFM or TFM font file available on the UNIX platform, you can continue to use
it (AFM for PostScript and TEM for PCL).

Note: AFM support is extended only to single-byte PostScript file
generation, with the exception of Japanese encoding.

The encoding schemes supported for the AFM files are:

AdobeStandardEncoding
ExtJIS12-88-CFEncoding
FontSpecific

HRoman

ISOLatinHebrew
JIS12-88-CFEncoding
JIS12e-88-CFEncoding

= Can scale well. For example, MS Sans Serif does not scale well to a different
size, whereas Tahoma does. This is because MS Sans Serif is a raster font that
does not scale well to any size and usually has rounding issues. On the other
hand, Tahoma is a TrueType font that is very similar in visual appearance to
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MS Sans Serif. Additionally, Tahoma is a vector font that can be scaled to any
size and rotated to any angle.

= Do not include Unicode characters. Oracle Reports does not support Unicode
character sets in Post Script output on the UNIX platform. As an alternative,
you can use either of the following:

- Oracle Reports PDF output (des format=pdf), which supports multibyte
character sets, as discussed in Section 5.5.1, "Multibyte Character Set
Printing".

- Oracle Reports utilities IX and PASTA for font embedding in PostScript

output when Oracle Reports is installed and used with Oracle
Applications, as discussed in Section 5.5.2, "Overview of IX and PASTA".

To have the PostScript output look same on the design platform (Windows) and
deployment platform (Unix), the paper size should be same on both the platforms.
On Windows, if you want to change the default paper size from Letter to any other
size (for example, A4), perform the following steps:

a. Choose Settings > Control Panel > Printers.
b. Right-click the default printer and select Properties.

Click Printing Preferences in the General tab.

a o

Click Advanced in the Paper/Quality tab.
e. Select the Paper Size and click OK.

=h

Click OK until the main dialog box displays to set the default paper size.

7.6.2 Deploying Your Report

For fonts with AFM files not readily available on UNIX, or if you encounter any font
issues in the report output such as text misalignment, you can convert and generate an
AFM file from the Windows TTF file using freely available third party utilities, such as
ttf2ptl. Do not attempt to convert to a TFM file, as this may not produce reliable
results.

To deploy your report on a UNIX platform:

1.

2.

Locate the TTF files corresponding to the fonts used in your report. Convert these
TTF files to AFM to ensure that you will have the AFM files for the fonts used in
your report.

Use a True Type to Type 1 font converter utility to convert the TTF files to AFM
files. For example, ttf2pt1.

Post-conversion, remove the . afm extension in the AFM file name. For example:

Table 7-10 Post Conversion Font File Names

Before Converting After Converting After Renaming
arial.ttf arial.afm Arial
3. Copy the Windows TTF file used in your report to the fonts directory on your

UNIX machine. For example, SORACLE_HOME/reports/fonts.

Add the path to the TTF file in the REPORTS_PATH environment variable. For
example, arial.ttf.
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5. Copy the AFM file to the SORACLE_HOME/guicommon/tk/admin/AFM
directory.

6. Ensure that the TK_PRINTER environment variable or the PRINTER environment
variable is set to the default printer name. For example, printerl.

7. Ensure that uiprint. txt has the entry for the appropriate PPD file in the
format, printer name: PostScript:2:test:ppd file.In this example:

printerl:PostScript:2:test:hpljetd2.ppd

8. Edit the file hpljet42.ppd using any text editor. Specifically, edit the
DefaultPageSize, DefaultPageRegion, and Defaul tPaperDimension to
change the default paper from Letter to A4, in the following way:

*DefaultPageSize: A4
*DefaultPageRegion: A4

*Defaul tPaperDimension: A4

Note: Create a backup of the hpljet42.ppd before you edit it. This
file is located in:

SORACLE_HOME/guicommon/tk/admin/PPD

9. Ensure that the PPD file used contains an entry for each AFM file that you use in
your report.

Navigate to the Font Information section and add the necessary entries for the
new AFM files in the following order:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM

10. Run the report to printer and verify that it is printed to A4 Paper.

http://mywebserver.com:reports/rwservlet?server=myserver+report="c:\test.rdf"+a
uthid=hr/hr@mydb+desformat=postscript+destype=cache

7.6.3 Frequently Asked Questions

This section contains frequently asked questions (FAQs) pertaining to deploying a
report to PostScript output.

Question
Does Oracle Reports support Unicode PostScript file generation?

Answer

Currently, Oracle Reports supports Unicode character sets in PostScript output only
on the Windows platform. On UNIX platforms, you can use either of the following:
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» Oracle Reports PDF output (desformat=pdf), which supports multibyte
character sets, as discussed in Section 5.5.1, "Multibyte Character Set Printing".

» Oracle Reports utilities IX and PASTA for font embedding in PostScript output
when Oracle Reports is installed and used with Oracle Applications, as discussed
in Section 5.5.2, "Overview of IX and PASTA".

Question
Does Oracle Reports embed the font in the PostScript output file?

Answer

Oracle Reports does not embed the font in the PostScript output file. It writes the font
name and the metrics that were calculated using AFM files. Therefore, for the report to
appear without any font alignment issues, ensure that the necessary fonts are installed
on the printer.

Question

The page count of my report varies when run on different installations of UNIX. How
can I ensure that the page count of my report is the same regardless of the installation?

Answer

In UNIX, Oracle Reports uses the PPD/HPD file of the default printer in the
installation for formatting. The resolution and list of fonts will be picked up from this
PPD/HPD files. Beginning with Oracle Reports 10g Release 1 (9.0.4), if there is no
default printer setup in the installation, then screenprinter.ppd will be used. This
PPD file emulates the screen. Earlier versions of Oracle Reports used the DISPLAY
environment variable instead. Ensure that the two installations use the same AFM/TFM
files and font files, so that the number of pages of PDF output will be the same.
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Configuring Destinations for OracleAS
Reports Services

Two things to consider when you run a report are how the report should be output
(destination) and who should receive it (distribution). Distribution is discussed in
Chapter 15, "Creating Advanced Distributions". This chapter explores how OracleAS
Reports Services handles output processing to default and custom destinations. It
provides an overview of output processing and information on registering destination
types with the OracleAS Reports Services.

It includes the following sections:
s Overview of Output Processing

= Registering Destination Types with the Server

8.1 Overview of Output Processing

Report output is controlled by the DESTYPE value that you specify at runtime, which,
in turn, is determined by the destination output types you have registered in your
server configuration file (server_name.conf) using the destination element. For
more information, see Section A.3.29, "DESTYPE" and Section 3.2.1.7, "destination".

You do not need to register the following default destinations:
s Cache

s E-mail

»  Printer

= File

You may need to register the following default destinations:

= OracleAS Portal: The entry for this destination is created by default in the server
configuration file, but it is commented out. To start using this destination, you
must uncomment the destination entry, and also provide appropriate property
values (for example, the value for the portalUserid property).

= FIP and WebDAV: The entries for these destinations are created by default in the
server configuration file, and are not commented out. Thus, they are registered
and available by default. If you need to send the output to an FIP or WebDAV
server that requires a proxy, you will need to edit the proxyinfo.xml file available
in the default location (ORACLE_HOMEN\reports\conf), then uncomment the
proxy property in the destination element and specify the complete path to the
proxyinfo.xml file as the value. For example:
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<destination destype="ftp"
class="oracle.reports.plugin.destination.ftp.DesFTP">
<property name="proxy"
value="D:\\oracle\\reports\\conf\\proxyinfo.xml" />
</destination>

You can also define custom output types, such as fax, Oracle's Internet File System
(iFS), or any new destination type you define using the OracleAS Reports Services
Destinations APIL This API enables you to define new destination types and build
handlers to usher your reports to custom destinations.

Note: For more information on the available APIs for Oracle
Reports, refer to the Reports Software Development Kit (RSDK) on
the Oracle Technology Network (OTN): on the Oracle Reports 10g
page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

The OracleAS Reports Services architecture standardizes the way output is generated
and delivered. It takes responsibility for delivering report output to the appropriate
destination (through the Reports Server), yet generates output independent of its
destination (through the Oracle Reports engine). This provides a significant
improvement in efficiency by allowing one run of a report to be used in a number of
different ways. It also opens up the output processing architecture to allow for any
number of destination types.

In the past, the Reports Runtime engine was totally responsible for delivering the
output. Consequently, it had to know how to communicate with output destinations.
This resulted in a tight coupling between the engine and the supported destinations.

OracleAS Reports Services eliminates this tight coupling and its attendant restrictions.
The runtime engine now treats all destinations alike. It doesn't need to know the
destination type for which the output is being produced. The server hands output off
to destination handlers that prepare the material for delivery to their associated
destination types. You can use predefined destination types (with predefined
handlers) or create a handler for a custom destination type you intend to support.
Almost any type of destination can be plugged into Oracle Reports.

Figure 8-1 illustrates the main components of the OracleAS Reports Services output
processing architecture.
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Figure 8—-1 Main components of destination/distribution architecture
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Requests flow through the output processing architecture in the following sequence:

1.
2
3.

The user submits a request from a client or browser to the Reports Server.
The server passes it along to the runtime engine.

The runtime engine creates/processes the destination objects (which include file
lists for specific destinations as well as any properties related to those
destinations) and the report output; the runtime engine sends the destination
objects to the Reports Server and the report output to cache.

The Reports Server sends the destination objects to the Reports Server's
destination component.

The destination component of the Reports Server fetches the report output from
cache.

The Reports Server destination component sends the report and the destination
objects (which specify how the destination device should handle the output) to the
appropriate destination handler.

8.2 Registering Destination Types with the Server

Before OracleAS Reports Services can send a report to a particular destination type,
the type must be a default type (printer, e-mail, cache, or file) or a type registered in
the server's configuration file, server_name.conf. The configuration file contains a
destination element for registering destination types that are valid for your reports.
You can register anywhere from zero to any number of destination types.
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Registering a destination type with the server involves:
s Setting Up a Destination Section in the Server Configuration File
= Entering Valid Values for a Destination

These tasks are described in the following sections.

8.2.1 Setting Up a Destination Section in the Server Configuration File

To set up a destination section in the server._name.conf file:
1. Open the server configuration file with your preferred text editor.

You'll find the server configuration file in the following directory (Windows and
UNIX use the same path):

ORACLE_HOME\reports\conf\server_name.conf
2. If the configuration file does not have a destination section, create one

underneath the element that precedes it in the configuration file's data type
definition file (rwserverconf . dtd) section.

Note: The server configuration file follows the order of elements
defined in the file's related document type definition file (ORACLE_
HOME\reports\dtd\rwserverconf.dtd). Place destination
after the elements that precede it, whichever are present in your
server configuration file.

3. Use the following syntax to register all the destination types you will use for
outputting reports:

<destination destype="output_type 1" class="java_class_1">
<property name="valid destype property" value="valid value"/>
<property name="valid_destype_property" value="valid value"/>
</destination>

<destination destype="output_type 2" class="java_class_ 2">
<property name="valid destype property" value="valid value"/>
</destination>

The valid values for these tags are discussed in the following sections.

8.2.2 Entering Valid Values for a Destination

This section outlines the destinations supported by Oracle Reports.

8.2.2.1 Destination destypes and classes

The destype and class attributes are require